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Mmmmmotion 12/10/2005  
I received a couple of requests for a tutorial on making a Mmmmmotion pic so I figured I'd take a stab at 
it. 
 
Read more 

How I puppetized Charlize! 11/23/2005  
A guide to turning a human into a puppet. 
 
Read more 

Out Of Bounds Shadows-Mini Tut 11/18/2005  
This is an update of an old mini tut, inspired by the beginning of the then new Out Of Bounds contest 
format. There were quite a few images using an incorrect or impossible shadow treatment. While there 
are considerably fewer entries containing this mistake I felt it might be of some help, to beginners 
particularly, to update it. Essentially this is intended to be of some help to those who are either 
beginners to graphics programs or new to the OOB concept and would appreciate some very, very 
basic advice. 
 
Read more 

How to create rain 11/18/2005  
A few people wanted to know how I created the rain effect in the "Turrets" contest, so I tried my best to 
write a tutorial, and here it is! 
 
Read more 

Linking Worth1000 Tutorials Directly From Photoshop 11/3/2005  
Photoshop has a customizable help function where you can write your own help function, or link to web 
pages for help. In this tutorial, we will be linking directly to other tutorials on Worth 1000. 
 
Read more 

WormHole 11/1/2005  
Here's how I created the Wormhole effect for Future Glimpse 6. 
 
Read more 
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Fur 10/13/2005  
In response to a request on methods of getting a soft fur edge I'm posting two examples. While the 
approach is similar in both examples, it depends on what type of fur/hair you need to deal with. 
 
Read more 

Motion Tweens and Motion Guides In Flash 9/28/2005  
This guide will help familiarize beginner animators with the use of Motion Tweens and Motion Guides in 
Flash. A very basic knowledge of the panels and tools in the Flash interface is required, and the very 
fundamentals of how to create tweens in the timeline and the creation of Symbols will be helpful.  
 
Read more 

How to Build a Panoramic Tripod Head for $10 9/28/2005  
Stitching software and digital cameras make panoramic photos far easier than ever before. However, to 
get the best results, you need a special tripod head. These can cost hundreds of dollars, but making your 
own isn't that hard. Even better, it's dirt cheap. 
 
Read more 

Make Grafitti with adobe photoshop 9/28/2005  
This is a pretty simple tutorial that shows how to make a wall image overlay. 
 
Read more 

Zombifying Mandy Moore 9/28/2005  
I've made a mini-tutorial to show you how I chopped Mandy Moore into a Zombie a while ago. 
 
Read more 

Perspective 9/28/2005  
I've been saying I'd get around to posting something about perspective for awhile cuz I dunno how often I 
see pictures where things are matched up very nicely but the perspective is off, which makes object look 
tilted.  
 
Read more 
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Gender Bending 9/28/2005  
A few people had asked me how I did some of the work on Reese Witherspoon in Gender Bending 3. For 
those of you who are interested, I've put together a little step by step to show some of my nasty little 
secrets.  
 
Read more 

Faceswapping 9/28/2005  
Find out how to face swap! 
 
Read more 

Saving Photographs for Contests 9/28/2005  
This tutorial describes one of many methods for saving photographs in compressed format for the highest 
quality browser display within the file-size limits requested by webmasters. Simply put, we’re going to take 
a 100-pound photograph and place it into a 20-pound bag. Or, maybe you could consider this “freeze-
drying” a photograph, with only small quality loss. 
 
Read more 

Tattoos 9/28/2005  
Having had a bit of success applying tattoos to celebrities I'll explain the tricks and tweaks I used to create 
realistic tattoos. This tutorial uses a few basic photoshop techniques, masking, colour adjustment, liquify 
and the resize and transformation tools. 
 
Read more 

Displacement Maps and Textures 9/27/2005  
Through general information and practical application, this tutorial will give you a better idea of how to 
apply a texture to an object through the use of displacement maps. 
 
Read more 

 
Zebraceros 9/27/2005  
Using the transform, liquify filter and some shading, were going to effectively dress up a rhino in 
zebra fur. 
 
Read more 
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How I turned Ayumi into a Pinocchio 9/27/2005  
How to adjust a real person's features into a cartoonesque caricature. 
 
Read more 

The Aging Process 6/24/2005  
Here’s a little tutorial showing you how I basically go about aging a woman’s face in Photoshop. 
 
Read more 

Unwrapping Hatteras 6/20/2005  
A real beginner's guide to Unwrapping Cape Hatteras Lighthouse for Invisible World 16. Written 
from the perspective of a 'chopper with just a little artistic ability but a huge addiction. Trust me, if I 
could make it... so can you. Go look at my first entry if you don't believe me. 
 
Read more 

Photo Edit 101 6/11/2005  
These are the basic steps in image enhancement. Almost every image you’ll see in print will have 
had these basic steps performed. Granted, some images have had many, many more modifications 
done, yet these steps will be paramount in the mix. And these steps are early in the batting-order. 
This is the ways the pros do it. 
 
Read more 

Turning people into statues 6/3/2005  
A few people wanted me to share how I created my Anthony Hopkins Bust for Future Memorials 7. 
The technique I used is different from the methods presented in the other two statue tutorials 
posted here, and I hope some of you can find my technique useful. 
 
Read more 

Fattening Folks 5/2/2005  
My attempt to help beginners get familiarized with various approaches to fattening people. 
 
Read more 
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Doing an Invisible 3/13/2005  
As in all image manipulations there are usually several ways to do the job. When doing an invisible 
this is particularly true. It depends on the original image and what needs to be replaced. In most 
cases using various areas of the original can create the missing background and either by cloning 
or duplicating, most of the needed area can be created.  
 
Read more 

A Simple Layer Mask 2/17/2005  
This is a very basic tutorial on layer masks 
 
Read more 

Fire in the Night 2/13/2005  
This tutorial is geared toward the intermediate Photoshop artist who already has a basic grasp of 
the program's interface and tools. You will learn more advanced masking and lighting techniques, 
plus some hand-drawn illustration techniques to make your images come alive. 
 
Read more 

How I cubed a cherry 6/16/2004  
How to combine illustration and photoshopping to achieve a cool result. 
 
Read more 

Modern Ruins 4/11/2004  
How to turn a modern day city into decaying ruins. 
 
Read more 

How to make your own 3D Images 4/9/2004  
Learn how to make one of those cool 3D images that you can look at with those 3D glasses. 
 
Read more 
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Masks in illustration 4/8/2004  
One way of going from sketch to finished picture, without the chaos that usually brings. 
 
Read more 

Colorizing Line Art 3/20/2004  
Using layer blending modes to simplify the process and get dynamic results. 
 
Read more 

The Slime Factory 3/8/2004  
Follow along with the steps the author took to create a navigation bar for the "Slime Factory" website. 
This shows how to mix metallic textures with gelatinous substances.  
 
Read more 

Out-of-Bounds 2/9/2004  
Here is a simple tutorial to explain the process behind a typical OOB entry.  
 
Read more 

How to Build a Complete Photo Studio for Less Than $100 1/16/2004  
Shopping list, prices, and step-by-step instructions to build a durable and versitile home studio...for less 
then $100! 
 
Read more 

Hand Drawn Stitches in Photoshop 1/12/2004  
So you want to be a stitcher? Well get your needle, thread and embroidery hoop ready... or just fire up 
your photoshop, google image search and pour yourself a fresh drink.  
 
Read more 

Sketch / Painting Effect 11/19/2003  
Create a sketched or painted effect in Photoshop from a photograph. 
 
Read more 

Photo Color Cast Correction 10/26/2003  
A quick way to get rid of unwanted color casts in your photographs. 
 
Read more 
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The Making of Secret Pond 10/15/2003  
This tutorial will explain how I created the lighting effects I used in the making of Secret Pond. 
 
Read more 

Using Vector Designs & Customizing Text in Photoshop 8/13/2003  
This tutorial will help demystify the lesser known vector side of Adobe Photoshop. We will learn how to 
produce and alter a vector shape plus we'll get you started on the basics of altering text so no longer will 
the look of your images containing text have to be defined by somebody else's font. 
 
Read more 

Shaping Up 8/9/2003  
In this tutorial, I'm going to show you how to edit the shape of an object using Photoshop! 
 
Read more 

Smoking with Photoshop 8/5/2003  
How to create realistic smoke effects. 
 
Read more 

Making a Web Photo Gallery 7/8/2003  
So you're ready to display your images online? In this tutorial, I'll show you how to make a html photo 
gallery using Photoshop 7, for display on the web. 
 
Read more 

How I draw anime 6/30/2003  
This tutorial will show you how I draw anime-style hair eyes and basic head structure. 
 
Read more 
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Yet Another Colorization Tutorial 5/5/2003  
Variety is the spice of life, and with that in mind, I offer you yet another colorization tutorial. This one uses 
a different method than either of the previous tutorials (CMYK curves adjustment layers), one that I feel is 
slightly easier than either of the other two methods while still acheiving good results. This tutorial is for 
PS7, as I have no working knowledge of PSP (sorry). I also use PC, but it is nearly the same on a Mac. 
 
Read more 

Blend Mode, Layers, and you... 4/29/2003  
In this tutorial, IronKite reviews the usefulness of 'Blend Mode' for individual layers in an effort to allow a 
figure blend into its new environment. 
 
Read more 

How to model a wineglass in 3D 4/28/2003  
This tutorial shows how to use Control Vertices to model a flowing wineglass shape. 
 
Read more 

Primary Colorizing 3/25/2003  
Because I have been promising to do it for months, and I finally got around to taking some screenshots 
while explaining it to someone, here it is. It works in either PaintShopPro or Photoshop, and I can't 
imagine why you couldn't do it in any image editor that supports layer masks, because that's pretty much 
all you need. It's very easy, once you get the hang of it, and imo, produces more lifelike, realistic results 
than colouring each object separately does.  
 
Read more 

Creating Glass 3/16/2003  
In this tutorial you will learn how to turn an opaque object into glass using Photoshop or Paint Shop Pro. 
 
Read more 

The making of Bayou Nights 2/22/2003  
Turning day into night. How I created Bayou Nights. 
 
Read more 

The Making of the Springfield Frog 2/6/2003  
A handy exercise in masking, cloning and adjustment layers. 
 
Read more 
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Building a better Zeta-Jones 1/8/2003  
Well, this is my first tutorial, so I hope it works out alright. :) The Zeta-Cyborg image was created in 
Adobe Photoshop 7. I am assuming that the basics are understood. 
 
Read more 

Let It Snow, Let It Snow, Let It Snow! 12/9/2002  
I'm going to attempt to explain how to create a realistic snowstorm effect like in my entry (Heading for 
Shelter) for the TG B2B:Movie Scene. 
 
Read more 

How to spiff up yours avatars 11/29/2002  
This tutorial, my first one, is how to animate an avatar. I use PSP(3.1) and GIF Construction Set Pro, by 
Alchemy Mindworks. I can't help with other programs.  
 
Read more 

Airbrushing an Image in Photoshop or PaintShopPro 11/7/2002  
Ok, you asked, you got it, but I have to warn you, this is my first tutorial, so it could very well suck. The 
purpose of this tutorial is to give you the basics of airbrushing a drawing from start to finish in Photoshop 
or PaintShopPro.  
 
Read more 

Let's Rock 11/1/2002  
How I turned Kate Moss into a statue. 
 
Read more 

Short Statue Tutorial - How I made the Arsi Statue Image 10/29/2002  
Hopefully it helps more of you than it confuses. Tutorial for PS7.0; some steps included in this tutorial 
cannot be reproduced exacly with previous versions. 
 
Read more 
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Water Reflections 10/22/2002  
This tutorial goes over a 'simple' way to make good reflections. I hope it is explanatory enough - it's my 
first tutorial. 
 
Read more 

How I Made ''Ghostly Sight'' 10/21/2002  
How I created a smokey ghost effect in a candle. 
 
Read more 

The Making of JemimaPhobia 9/19/2002  
How I turned a stack of pancakes into something you probably wouldn't want to find on your plate. ;) 
 
Read more 

Laser and Shiny Thing 9/12/2002  
Lasers, Lightsabres, Neon signs, anything goes with this technique!  
 
Read more 

Using Photoshop to Make Jack-O'Lantern Patterns 9/9/2002  
So Halloween is coming and you don't have any idea what to put on your pumpkin. Triangle eyes and 
square teeth? I don't think so. How about putting Aunt Martha's frightful face on it instead? You can, 
using Photoshop! Here's how! 
 
Read more 

How to do Spider-Doo 9/2/2002  
Some masking, some coloring, some copy-and-paste, and a little luck. 
 
Read more 

Organization 7/30/2002  
This guide shows you how to organize your photoshop file and environment. It's quick and dirty, but well 
worth reading. 
 
Read more 
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Creating 'Spin Cycle' 7/28/2002  
Step-by-step guide to turning a picture of a run-down shack into a raging storm about to obliterate a 
prairie home. 
 
Read more 

Archaeological Dig 7/27/2002  
That Famous Ferrous Flying Object, IronKite, revisits how to make a centaur skeleton. 
 
Read more 

How to write a tutorial 7/25/2002  
This is a must-read if you plan on submitting a tutorial here. 
 
Read more 

Down and Dirty Colorization 7/25/2002  
Gradient Maps give a broader scope of colors, making your images sharper and more life-like than the 
"painted" look of Fill Layers.  
 
Read more 

Chiseled Images & Crop Circles 7/24/2002  
This is a good tutorial to teach you how to create a chiseled look rock and a general depth in objects. 
 
Read more 

Merging Drew and Bouguereau 7/24/2002  
A start to finish guide to merging 2 images. 
 
Read more 
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Mmmmmotion  
 

By BrownTrout  Paginated View 

I received a couple of requests for a tutorial on making a Mmmmmotion pic so I figured I'd take a stab at it.

Page 1 : Making it mmmmmmove

After seeing several of the Mmmmotion contests, I think most of the mistakes have to do with incorrect subject focus or just plain "overdoing it." I tried to address both issues here. Hope some of you find this useful... 
 
For starters, there are several perspectives you can take when setting a picture to motion. Take the following race car pic in its original form... 
 

 

Page 2

You can choose to set yourself in motion but the result is usually not appropriate for what we are trying to do. 
 

 
 
While realistic... this would be the view if your head was traveling at 100 mph. 
 
Instead, consider how things would look if you were actually taking a picture. You would set either the car (foreground) or the road and trees (background) as the focal point of the image. 

Page 3

Focusing on the car, your background would appear to move like this (note: your wheels would still be moving, and thus... radially blurred) 
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If your focus was more distant (the trees perhaps), then the car would appear as the moving component in the image, like this 
 

 
 
For this tutorial, we will go with the background as our point of focus. 

Page 4

Step 1: Using the polygonal lasso tool, crop out your car from the background 
 

 
 
Cut and paste the cropped car into a new layer so that only the background remains 
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Since a true moving object appears semi-transparent around the edges, we will need to clone in some of the edges where we cut the car out. 
 

Page 5

Select your cloning tool and set the opacity to about 75%. Begin carefully cloning in the egdes so that you have a smaller exposed (cleared) area with somewhat fuzzy edges. 
 

 
 
Our last step is to select the car shape we originally cut out and use the motion blur tool to set it in motion. 
 
Make sure the direction of the blur is consistent with the direction the car is actually traveling in. Be cautious not to overdo things here... your car is not traveling at light speed! A setting of 15-20 pixels will probably be enough 
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That should get you started with a laterally moving object. Now what do you do if the object is coming at you?? 

Page 6

You still need to select some point of focus before you start. This would once again be an object in the foreground or the background itself. 
 
Take my recent Jackass entry for instance. In this pic, the focus is on the shopping cart and the people. The blast cloud behind them is what I chose to set in motion. 
 

 
 
Step 1: Make a layer copy of your original source image then crop out those parts of the image that should remain still for the most part (because they are the "focal point" of the image) 
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Copy the cropped area of your layer copy and paste it into a new layer like so, then make it invisible in the layers pallet. 
 

 

Page 7

Now go back to your original layer copy and apply a radial "zoom" blur to it. Once again, try not to overdo it. A setting of 15 pixels should be enough for our purposes 
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Now select the cropped layer of the cart and people (making it visible in the layer pallet) and using the eraser tool, partially erase the edges of the image that are closest to the blast center. Setting the eraser opacity to 50% should do nicely 
 

 
 
Now you should have something close to this with the focal point fairly sharp and the background blast in motion. 
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The key to any of this is "moderation"... don't overdo the effect and you'll get a pretty realistic Mmmmotion pic!! 
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How I puppetized Charlize!  
 

By Ziaphra  Paginated View 

A guide to turning a human into a puppet.

Page 1 

In this tutorial I am going to attempt to show you how to ‘puppetize’ Charlize from this… 

 
 
…to this! Bear in mind that I used PSPv9 and that this is my first attempt at a tutorial!!! 

 
 
The first step is to use your smudge brush at about 46% opacity and smooth out her skin, hair and teeth until they have a plastic look to them. 

Page 2

Now draw some oval shapes in the darker skin tones and place them on her joints…look at the angles of her joints to help you with the placing. Just keep adjusting them until they look right. Notice that I have some darker ovals and some lighter ovals…the lighter ovals are placed where I thought more light would fall. 
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Page 3

Where you only have one oval on a joint, eg, the neck/chin, shoulders, elbows and wrists, you have to copy and paste these joints from your background over the top of your ovals and then erase as much as is needed until it looks as though there is a gap between the joint and the oval. 
 
Now go to your background layer and using your clone tool, get rid of the bits of knee etc that you can still see behind the ovals. 
 

 

Page 4

After cloning, this is how your joints should look. 
 
Now using your pen tool, draw in the lines that hold the joints together. I added a shadow to the knee lines for more effect. 
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Page 5

Here you need to blacken her mouth and move her chin and lower lip down to give the full puppet effect. I also drew in two faint brown lines to define her chin/jaw more. 
 

 

Page 6

Next I airbrushed a lighter skin tone onto all of her body and gaussian blurred it until it looked right (you will have to play with this until you are satisfied with your result). I also added highlights to her hair in the same way. This gave Charlize more of the plastic puppet look that I was looking for. 
 
Now draw in the dots/holes where you would like to attach the strings. 
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Page 7

Using the pen tool, draw in your strings….and there you have it…all done!!! Good luck. 
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Out Of Bounds Shadows-Mini Tut  
 

By DerAlt  Paginated View 

This is an update of an old mini tut, inspired by the beginning of the then new Out Of Bounds contest format. There were quite a few images using an incorrect or impossible shadow treatment. While there are considerably fewer entries containing this mistake I felt it might be of some help, to beginners particularly, to update it. Essentially this is intended to be of some help to those who are either beginners to graphics programs or new to the OOB concept and would appreciate some very, very basic advice.

Page 1 

 
 
In very simplified form, this is the error I’m referring to, a shadow cast directly behind the section emerging from the frame. This is an impossible shadow, no surface exists that would make that shadow possible. In any case, considering the light direction, the lighthouse should cast a shadow at an angle away and to the left, not directly behind it.  
 
Even if the light direction called for a straight backwards shadow, this approach would be incorrect. 

Page 2

 
 
To illustrate the point more clearly, a side view shows that an imaginary surface available to receive a cast shadow from the lighthouse could be no closer than the end of the flat photograph. If the light direction suggested that a shadow should be cast directly back from the lighthouse, it could not look like the shadow in the first image. There is no logical surface that would allow that shadow to be cast. 
 
The largest portion of the shadow would run across the flat image and a small portion would be cast on the imaginary back surface. 

Page 3

 
 
Following the existing light direction correctly, the shadow would be cast diagonally across the flat image. If for some reason you wanted that rear wall surface to exist, only a small area at the top of the shadow would reflect on it. 

Page 4

 
 
Since this mini tut is aimed at beginners it seems appropriate to include one simple method 
to create a shadow.  
 
With the lighthouse layer active, press the Control key while clicking on that layer in your layers palette. That will give you a selection of the lighthouse and rocks. (all active pixels.) Create a new layer and fill it with black as shown above. (That shadow layer has been moved slightly so it can be seen.) 
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Page 5

 
 
Reduce the opacity of that layer to about 65% or whatever you feel looks correct. 

Page 6

 
 
I removed the selection “ants”, (Control>D) and used the Distort tool (Edit>Transform>Distort) to manipulate the shadow into a proper angle and size.  
 
I prefer this tool for this sort of manipulation because it gives you almost unlimited control of angle, size, width and taper.  

Page 7

 
 
This is the final image with what I consider to be a proper shadow. I eliminated all shadows except the one from the lighthouse to keep it simple. 
 
The finishing touches on the shadow included addition of Gaussian Blur (Filter>Blur> Gaussian Blur) and using the eraser tool with a very large soft brush at 5% to lighten the shadow as it recedes from the image casting it, with repeated overlapping strokes. Shadows get lighter and softer as they recede. 
 
It’s important, when doing an OOB image, to consider the space surrounding all the items included in the image. Unless it serves some purpose to indicate there are invisible surfaces that could receive cast shadows, I believe the image usually is enhanced by the illusion of unlimited space.  
 
If you have any questions please site message me. 

file:///C|/Worth1000/03.htm (2 van 2)13-6-2006 23:16:48



Worth1000.com | Photoshop Contests | Are you Worthy™ | tutorial

How to create rain  
Rainy day  

By guitargodleach  Paginated View 

A few people wanted to know how I created the rain effect in the "Turrets" contest, so I tried my best to write a tutorial, and here it is!

Page 1 : Step 1

Today we’re going to attempt to create a simplistic yet realistic rainy day. This is basically a beginner tutorial, and my first attempt at writing one, so stay with me here. 
 
We're going to try to reproduce the effect achieved in turning this image: 
 

 
 
into this one: 
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First thing you need to do is open the picture you want to add rain to. You can use any picture you want, or you can use the one provided. Next, duplicate the background layer (CTRL+J) by either dragging the layer to the “Create a New Layer” button  at the bottom of the layers pallet OR going to Layer > Duplicate Layer…(this requires you to click “OK”). 
 

Here’s the fun part! On your “background layer copy” go to Image > Image Adjustments > Curves… (CTRL+M) and make your setting something like this:  
 
 
Or you can play around with them to get the desired effect you want. This gives the image that “dark rainy day” appearance. 

Page 2: Step 2: The Rain

Next step, the rain! Create a new layer (Shift+CTRL+N) by clicking the “Create a New Layer” button as before, OR go to Layer > New > Layer… name it “Rain” and fill that layer with White (CTRL+Backspace). Head up to Filter > Noise > Add Noise… and your settings should be close to this: 

 
 

Page 3: Step 3 & 4

Then head over to Filter > Blur > Motion Blur… and the setting should be close to this: 

 
 
 
Now you need to head on over and adjust the levels. (CTRL+L) Go to Image > Image Adjustments > Levels… and my settings are: 
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But you can make them however you want. 

Page 4: Step 5

Last step!! Go to the top of your layers pallet and change the mode to “Screen” and Voila! You have a rainy day! 

 
 
Optional step! To double the amount of rain in your picture, just copy the “Rain” layer (CTRL+J) and press CTRL+T to pull up the transform handles. You can go to Edit > Free Transform… as well. Click just outside the bottom right handle, until the cursor looks bent. Then hold Shift and turn the layer clockwise until the bottom right corner becomes the top left corner. Then hit the “Commit” button at the 
top!  
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Linking Worth1000 Tutorials Directly From Photoshop  
Using Photoshop's Help Function to Link to Worth 1000  

By Groggie  Paginated View 

Photoshop has a customizable help function where you can write your own help function, or link to web pages for help. In this tutorial, we will be linking directly to other tutorials on Worth 1000.

Page 1 : Navigate to the Tutorial

First, you need to find which tutorial you want to start with. In this tutorial I will be linking to c1010010's Unwrapping Hatteras. So, click on it, and it will bring you to the tutorial. You should see this: 
 

 
 
Now, click on 'Print View'. It is next to the author's username, and highlighted in red. This will bring up a page without your username, without advertisements, and without the navigation bar. Highlight the URL and copy it. You will need that later in this tutorial. 

Page 2: Editing the Howto File

We need to tell Photoshop where and how it is going to link to the webpage, so find Photoshop's 'Additional How To Content' folder. In Windows, the default location is Programs/Adobe/Photoshop/Help/Additional How To Content. On a Mac, the default is Applications/Adobe/Photoshop/Help/Additional How To Content. 
 
***If you are using Photoshop CS2, you can not link to a webpage through the help menu. Instead, you will have to save the print view as an [b]html[/b] document inside of the 'additional how to content' folder.*** 
 
We need to edit the file 'Add_001.howto', so open it with your favorite text editor! Once opened, you will see a string already entered. 
 

 
 
The first set of quotations is the main folder. The second is the text that will be clicked to link to the tutorial. Press return and type the following string including quotations: 
 
"Worth 1000 Tutorials" "Unwrapping Hatteras" http://www.worth1000.com/tutorial.asp?sid=161114&print=1 
 
***If you are using Photoshop CS2, instead of using the URL above, only use the file name of the saved page (For example: unwrappinghatteras.html). Notice: If there is 'http://' or any extension other than '.html', CS2 will launch it's own help application.*** 
 
You can simply paste the url in after the second set of quotations. Now the text file should appear as follows: 
 

 
 
Be sure to save the file and you may now close the text editor. 
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Page 3: Open Photoshop

Did you ever imagine seeing a Photoshop tutorial where the last step is to open Photoshop? 
 
If you had Photoshop open prior to saving the 'Add_001.howto' file, you will have to close and reopen Photoshop for changes to take place. 
Once Photoshop is open, in the menu bar, click the 'Help' dropdown. At the very bottom of the list, there should be a choice for "Worth 1000 Tutorials". If you hover your mouse over it, the dropdown will extend and should read "Unwrapping Hatteras". 
 

 
 
 
Click it and your default browser will appear with the Unwrapping Hatteras tutorial showing! 
 
You can add as many as you like, and they will be automatically alphabetized in Photoshop. Here, I have also added Norrit's "Turning People Into Statues" 
 

 

file:///C|/Worth1000/05.htm (2 van 2)13-6-2006 23:16:51



Worth1000.com | Photoshop Contests | Are you Worthy™ | tutorial

WormHole  
 

By McGuffy  Paginated View 

Here's how I created the Wormhole effect for Future Glimpse 6.

Page 1 : Displacement

The effect I used for wormhole is easy to do and has many uses from rippling water to warping the fabric of space-time.  
 
1. Start off with the image you want to poke a hole in, and create another blank image at the same size and resolution, but in grayscale (Image - Mode - Grayscale). 
 

 

Page 2: Making the Warp

Working on the blank image, create a new Gradiant Fill, alternating dark gray and white as shown below. The more stripes you create, the more waves your wormhole will have. For a mild ripple, use a lighter shade of gray. For a really warped look, alternate between black and white. You'll also notice I got farther apart as I moved from left to right - this detail makes the outer waves larger than the inner waves, a characteristic of rippling water. I chose a medium gray below: 
 

 
 
Then apply the gradiant horizontally to your blank canvas: 
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Page 3: Twirl it!

Next, you're going to apply a Twirl filter to the gradiant (Filter - Distort - Twirl). Play around with the amount to get the effect desired. It doesn't have to be perfect, there will be plenty of time for editing. I used -450 here: 
 

 
 
When you're happy with how it looks, save it as a PSD file, such as WARP.PSD. 
 
Note: Instead of the twirl filter, you can apply the gradiant as a radial (it will have a bullseye-type effect when applied). This gives you a slightly different look. Experiment! 

Page 4: Setting Up

Back to your source image. First, make a copy of your source onto a new layer (Ctrl-J or Layer - Duplicate Layer). At this time, you can also place your "destination" image between the source and the duplicate, as shown below. Note that my "destination" is much smaller than my source, sized to fit in the "hole" we're going to make later. We can resize and reposition this layer as necessary once we make the hole. 
 

 

Page 5: Warp Reality

With the top (duplicate) layer selected, apply a Displacement Filter (Filter - Distort - Displace). In this example, I used a horizontal and vertical scale of 50, Stretch to Fit, and Repeat Edge Pixels (which aren't important since the displacement map we created on page 3 is the same size as our source image). Apply the filter, specifying the warp file you saved in step 3 as the displacement map. Your image should now look like this: 
 

 

Page 6: Restore Some Reality

Now you're going to define the wormhole. Apply a Layer Mask to the displaced layer. Set your foreground color to black, background to white, and select a soft-edged brush. 
 
Now, simply "paint" around the outside of the warp to expose what's underneath it. Remember, painting with black will Mask the area you're painting, painting with white will Reveal the area you're painting. Simply press X to toggle your foreground/background colors, painting in and out until you achieve the look you're going for: 
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Page 7: Poke the Hole

You could use the soft-edged brush to paint in the center hole to expose your destination, but I prefer the Ellipse Marquee Tool. Still in the Layer Mask, use the tool to make an ellipse in the center of your warp (you'll see how to best fit it to match the warp's waves), then feather it (Select - Feather) about 8 - 15 pixels (varies based on the resolution of your images - experiment!), and with your foreground set to Black, press Alt-Delete to fill the selection with black, exposing the center hole of your warp. You'll end up with something like the following: 
 

 

Page 8: Getting Things Just Right

Now's your chance to move and resize your "destination" (the Alaska layer in this example). Play around with positioning, size, levels, all that good stuff. You can also return to your Layer Mask and touch up the Masked and Exposed areas of the Warp layer. 

Page 9: Finishing Touches

To round off the image, I use the Smudge tool to smooth out any areas that seem to be too pixellated from the Displacement filter. I also use the Burn tool to darken slightly the opening of the hole, adding just a bit of depth.  
 
For some really cool effects, try the Liquify filter on the warp layer before starting your Layer Mask. You can also change the perspective of the displacement map (step 3) for an angled appearance to your wormhole. 
 
I hope you find this tutorial helpful, and I'm sure you'll find many cool uses for this effect. Please Message me with any questions or comments. 
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Fur  
 

By DerAlt  Paginated View 

In response to a request on methods of getting a soft fur edge I'm posting two examples. While the approach is similar in both examples, it depends on what type of fur/hair you need to deal with.

Page 1 : Example 1

 
 
 
 
In this example, the squirrel has soft but distinct fur. To replicate it takes a bit of time and practice but can be easily accomplished by anyone. 

Page 2: Example 2
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In this first step, removing the background, I used the eraser tool. This can be done just as well by masking but I prefer the eraser. 
 
Use a medium sized soft brush and remove all traces of the background including anything that shows through the fur. A small soft brush should be used where the fur isn’t as thick as around the face, ears and paw. 

Page 3
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Using the smudge tool with a small brush at about 30% pressure, “pull” out areas of color to simulate fur around the entire squirrel. It may take several strokes to accomplish each bit of fur but that adds to the more casual look of the new edge. Vary your stroke direction so that all the fur isn’t unrealistically going in exactly the same 
direction. 

Page 4
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On another layer, using a one pixel brush at 50% or less opacity, pick up color from the edge of the squirrel and stroke individual hairs. (using the ALT key changes the brush to the eyedropper tool) 
 
Again be careful to vary the length and direction of these strokes. Have some of them cross over other hairs for a more realistic appearance. Keep in mind also the varying length of fur that exists on different portions of the animals body. 

Page 5

 
 
For a finishing touch, use the smudge tool with a very small soft brush at about 30% and stroke over each hair you’ve added. “Pull” the tip of each one of these hairs to a softer point. This will result in a softer more photographic look. 
 
The whiskers were added in the same way as the fur strands, with a one pixel brush at about 50% opacity but with a longer quick stroke. 
 
 
I added a black background to make it easier to see the finished fur. 

Page 6
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In this case, with the longer more defined fur, all of it will be rendered in. 

Page 7

 
 
Using the same approach for background removal, a soft eraser brush or masking if you prefer, remove the existing background and all areas of fur where the old background was evident. Keep this edge as soft as possible.I added a black background just to make the work more obvious. 

Page 8
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On a separate layer, again using a one-pixel brush at about 50%, stroke on some hairs to imitate the fur on the original image. Use a single, quick curved stroke again keeping in mind that all hairs do not go in exactly the same direction. 

Page 9

 
 
 
 
Add more hair using the same technique. It’s a good idea to add additional hair using separate layers for each group. This will make it easier to smooth out the hairs later especially when they cross over each other. 

Page 10
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This is the final image will all the new fur added. Most of the hairs have been stroked with the smudge tool, as in the squirrel image, with the tips tweaked to make them look more realistic.  
 
As you can see, the creation of a reasonable fur effect is fairly simple. It may seem work and time intensive but with a little practice, mostly getting comfortable with the fur strokes, it can be done in fairly short order. 
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Motion Tweens and Motion Guides In Flash  
a starter guide  

By whazzat  Paginated View 

This guide will help familiarize beginner animators with the use of Motion Tweens and Motion Guides in Flash. A very basic knowledge of the panels and tools in the Flash interface is required, and the very fundamentals of how to create tweens in the timeline and the creation of Symbols will be helpful. 

Page 1 : Introduction

Hello and welcome to the wonderful world of tweens!!!! Today's lesson: Motion Guides and how they make life so much easier when you're trying to animate stuff. 
 
You probably already know about the two different kinds of tweens. There are shape tweens, which make transitions between one shape and another and generally end up looking incredibly crappy 98% of the time unless you're going for a very specific effect. That's so NOT what I'm writing about! 
 
I'm writing about MOTION tweens! 
 
Motion tweens can be your best friend when you're animating in Flash. But if you're not familiar with motion guides then you're probably working 10 times harder than you need to. So let's take a look at Motion Tweens and Motion Guides. 

Page 2: Starting Out - Symbols

First of all, when you're doing motion tweens, and pretty much whenever you're working with animation in flash, you have to observe a general habit and rule. [b]Symbols are your best friends, too.[/b] Just about everything you make as you're animating in flash should be a Symbol. There are about a dozen reasons for this, but in the case of motion tweens it's for the sake of file size and communicating with Flash better. So now let's take a look at an example. . . 

Page 3: Beginning A Tween

 

 
Ok. I've got a gear shape on my main stage, and I've already turned it into a symbol. I want to make it move from the left side of the stage to the right side. Perfect opportunity for a TWEEN, wouldnt you say? Of course you would. 

 
 

 

 
So at this point I extend the number of frames from 1 to 24 in the Timeline and create a keyframe at the end of it, then place my gear on the other side of the stage. 

Page 4: It
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Hooray! It's tweening! Wow, that's great! But the thrill wears off fast when you realize just how boring it is. I wish there was an easy way to make my gear look like it was ROLLING across the stage instead of just sliding like that. Oh yeah! There is! 

 
 
 
You can highlight any frame of the tween in the timeline and go to what you'll soon discover is your favorite panel, the PROPERTIES PANEL.  

 

Oooo look at all the goodies! You can adjust the tween type, whether or not the transition remains to scale, the "Ease" of the tween (this changes the speed of the tween from beginning to end, say for example you want the gear to start out moving slowly across the stage and pick up speed faster as it reaches its destination, you would choose "Ease In." Experiment with this, it's fun) and the Rotation of the object that's being tweened. 

Page 5: Settings

 

I want my gear to roll 5 times Clockwise. So I set the tabs and settings thusly and BING... 

 

I have a gear that rolls instead of slides!

That's pretty neat. . . for about a second. I'm sick of straight lines. I'd like my gear to look like it's being pushed into the distance along an arc. How can I do this without setting a million motion tweens or going frame-by-frame? 

Page 6: MOTION GUIDES!

Here's where Flash really makes things easy. I'm going to remove the tween I just made and my keyframe on frame 24 that I had for the previous example, but leave the frames. So now I have 24 untweened frames with only the first frame as a keyframe. 

To create a motion guide for an object: 

●     Highlight the layer on which the object rests. 
●     Right-click the layer and select "Add Motion Guide." 
●     A new layer appears directly above your object layer!
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This layer is specifically for creating a motion guide for the layer below it. It defaults with the same number of frames as its counterpart and the frames are blank. Now to make a guide. I said I wanted the gear to move back along an arc path. So, I'll make a simple arc using the line tool. 

 

Even though you can see the guides in the flash interface and on the stage, they will be invisible in the flash movie. 

Guides are best used with lines and not shapes, but it's possible to use just about any drawing tool as a guide. Your object will just stick to the edge of a shape, but will follow a line in a more definite way. Use the line tool, the Bezier Line tool, the pencil tool, or even the outline from the cirle or square tool will work. Experiment and check it out! 

Page 7: Snapping

I have my arc guide now, and I have my symbol. Am I ready to tween? Yes! But there's one more thing to explain: SNAPPING. You'll find snapping at times to be a big inconvenience when you don't want it to run, and at times, like now, it'll be very helpful. When snapping is enabled for objects and guides, as you move an object it will naturally gravitate toward the guide in question. Experiment with the settings from the View->Snapping submenu to get a feel for what each snapping setting will do. At this point I have snapping enabled for Snap Align, Guides, and 
Objects. 

 

 

Page 8: More Tweening

As I move my gear toward the motion guide, I can see how the REGISTRATION POINT is drawn to the guide. That's the SNAPPING factor. Remember that. 
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Ok, now I add a new keyframe in my object layer in the last frame of the timeline. I grab my gear (by the REGISTRATION POINT) and bring it to the other end of the motion guide.  

 
By making sure it snaps to the end, I can be pretty sure the path is going to conform to the shape of the arc in my guide layer.  

 
 

I wanted it to look like it was falling back, though, so I can scale the height and width of the gear to make it smaller. 

Page 9: Results and Properties

And here's the result: 

 
 

Cool, right? It gets cooler. Highlight any frame in the motion tween and then open the Properties Panel again. Now we can do all that neat stuff I wrote about up top to achieve different effects. First I went to the final keyframe again and flattened my gear's height scale. 

 

Then, by using these settings: 

 

It now has a cool spinning/flipping effect: 
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Page 10: More Effects

And by going to that final keyframe again, clicking on my gear and the opening the properties panel, I can change the color, opacity and brightness settings of the gear so it changes in transition during the tween. 

 
 

Like this: 

 

These are the basics of Motion Tweens and Motion Guides. It might seem like a lot to take in but once you get a handle on these fundamentals there's a whole lot of things you can do and it only gets more and more fun. 

Keep flashing, stay cool, and enjoy! 

whazzat 
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How to Build a Panoramic Tripod Head for $10  
 

By arodrix  Paginated View 

Stitching software and digital cameras make panoramic photos far easier than ever before. However, to get the best results, you need a special tripod head. These can cost hundreds of dollars, but making your own isn't that hard. Even better, it's dirt cheap.

Page 1 

There’s some amazing software out there for panoramic photography. Various software packages warp, stitch and blend sequences of photos so that they (ideally) look like one big, high-resolution, panoramic shot. However, getting these shots to turn out perfectly isn’t easy when handholding your camera or using a normal tripod, especially when some parts of the image are fairly close to the lens. 

 
The issue is “parallax”, or, to rip something out of the American Heritage dictionary since I’m not about to try to explain it myself, “an apparent change in the direction of an object, caused by a change in observational position that provides a new line of sight.” To fix this, you need to get the camera to rotate about a specific point that is forward of the screw socket in your camera. 

 
Panoramic heads can be very expensive – in the $300 to $500 range for “name brand” heads. Several designs for closer to $100 are available on the web, but look a tad on the flimsy side. 
 
 
Building your own panoramic head for an SLR isn’t too hard or expensive. The parts for the design shown here cost about $10. Every part here is available at a store like Home Depot. 
 
 
Once you get past some of the misinformation out there, the only really hard part is figuring out the dimensions. The downside is that the mount is only useful for a specific camera/lens combo. On the other hand, you can’t mistakenly mess up one of the critical adjustments once you’ve built it, and the homemade mount is as light as a couple small pieces of wood. 
 
 
Here’s the unit we’re going to be building: 

 

 
My woodworking skills aren’t top-notch, but there’s really not much need to make it look even this nice. Don’t worry about appearance, just get the key measurements close and you’ll have a fully functional new toy. 

Page 2

Before we start, we need to make a guess as to that magic rotation point mentioned previously. This is where the misinformation comes in.  
 
 
1. The point the camera must rotate about is the entrance pupil, not the nodal point as is often stated. Better yet, who cares what they call it, there’s a test to figure it out. 
 
 
2. The rotation point (entrance pupil) is NOT necessarily halfway down the lens. In fact, on many cameras, it’s not even close to that.  
 
 
So, what’s the test to find the entrance pupil? 
Our mount will hold the camera sideways, but for now it’s easiest just to hold it horizontally. Position two objects on a table so that they line up when viewed through your lens – a couple of batteries work perfectly for this. Now pan your lens right and left as you normally would. You’ll see the objects move relative to each other – that’s parallax.  
 
 
Now, let’s find a better pivot point. Put the tip of the index finger of your left hand somewhere along the bottom of the barrel of the lens. Now rotate the camera about that point. Try to hold that left hand as steady as possible (c’mon, you’re a photographer, you got steady hands, right?) Still see a shift? Move your finger/pivot point along the lens until that shift goes away. On my Canon 17-85 EF-S, the point was 4 1/8 inches forward of the screw socket. 
 
 
This photo shows the camera straight ahead, and the batteries aligned: 

 
 
 
Now the camera is turned to the side. The alignment is quite close, but not perfect - we can see the left edge of the rear battery poking out:  

 
 

Page 3

Finally, let’s get to the actual construction... 
 
 
There are four pieces of wood that we’ll need to cut: 
- The base 
- The side 
- The arm 
- The swivel 
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The swivel is optional. If you’re using a tilt and pan head, skip it. However, if you have a ball head, it’s a lot easier to include it than try to adjust the ball head every shot. 
 
 
First, cut a piece of wood for the base. Use a piece of very flat, thick (5/8” or so) oak plywood or a plank of hardwood. Make it about 5” by 4” (12 cm x 10 cm). Next, cut the side. To make sure the camera has enough clearance when you swing it down, make it a little over 5” tall. The width would be the same 4” as the base. Line up the two 4” edges so that the side is sitting on top of the base to form an “L” (see the picture above). Drill holes up through the bottom of the base into the side and screw the two together. A little glue and maybe some bracing might help – this less flex the better. 

Page 4

Now we need to drill a couple holes. The size of all the holes in this project except the last one are up to you, depending on what size fasteners you bought.  
 
 
The first hole needs to go in the base -we need to drill a hole near the center. The exact distance from the side is critical – it will need to run through the center of the lens. So, put your camera down on a table. Measure the height from the table to the center of the lens – that’s the distance the hole in the base needs to be from the side.  
 
 

 
 
 
If you’re not using a swivel under the base, you’ll need a fairly large hole here, as you’ll need to install a socket (or “insert nut”) so the tripod can screw into the tripod head. The dimensions of that socket depend on your tripod – if you’re planning to mount this to the screw that normally attaches to the camera, you want a “1/4-20” socket. Here's what an insert nut looks like: 

 
 
 
The hole in the side is where the arm will pivot. As such, it needs to be in the same plane as the hole in the base. In other words, if you’re looking at the unit from the side, the side hole will appear directly above the base hole. Make the hole in the side about 4 1/2 to 5 inches above the base – your camera will need room to swing downwards when you’re shooting a picture of the sky. 

Page 5

 
 
Next, cut the arm. To figure out the length, start with that previously measured distance between the entrance pupil and the screw socket (the one that was 4 1/8 inches on my Canon) – this distance is shown in green above. Add a half inch to an inch on either side. The width need only be a couple inches.  
 
 
Drill a hole at one end for the arm to attach to the side piece where it will pivot. Drill another hole 4 1/8 inches (or whatever your measurement is) down the arm towards its other end. This last hole is where the camera attaches, so it needs to be 1/4" wide. Insert a 1/4-20 thumb screw through this hole (1/4-20 means 1/4” wide, with a thread pitch of 20, which is the most common pitch). 
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Now, attach the arm to the side. You’ll need a flathead machine screw – you may have to gouge out a bit of the hole in the arm so the full head can sink into the arm and not hit your lens:   
 
 
Push the screw through the arm, then through the side, then use a washer and a wingnut to secure it.  

Page 6

If you’ve chosen to include the swivel, cut a piece of wood about the size of the base, preferable big enough so it sticks out a bit – that will allow you to put markings on it so you can see how many degrees you’ve swiveled. It’s not necessary, but I cut mine in a circle to make those markings easier to see (they’re not shown in the picture yet though). Drill a hole through the center of it, and push a flat head machine screw through it, then through the hole in the base. As with the hole in the arm, you will probably need to gouge out the hole in the swivel a bit so you can prevent the head from sticking out – that surface will need to be flush with the tripod. Secure the screw with washer and wingnut. 
 
 
Finally, you need to install a socket or insert nut as described above for the base section. Position it as near as possible to the center to maximize stability.  

 
 
 
Sand all the parts. To finish things up, you can varnish, seal or paint, but don’t get any of it on the rotating surfaces – they’ll stick every time you adjust the arm or swivel. Attaching a small level is highly recommended. 
 
 
That's it, we're done! 

 
 
 
When using your new panoramic head, remember that it never pivots at the point where the camera is screwed into the arm – that joint stays put. Pivot at the arm and base as necessary, overlapping 20-50% between shots.  
 
 
As far what software to use, this thread in the Worth photography forum has more info.  
But regardless of what you use, this new tool will make the stitching far easier and more accurate. For example, this panoramic was stitched together from 9 shots: 

 
The full size image was 32 megapixel, yet it stitched together without any error bigger than a single pixel! The image had no blending, yet the only seam that you can see (just to the right of the path) is due to an exposure error - it clouded up a bit on me in the middle of the sequence. 
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Make Grafitti with adobe photoshop  
 

By TMproductions  Paginated View 

This is a pretty simple tutorial that shows how to make a wall image overlay.

Page 1 : Introduction

Here is the goal of the tutorial:  
 
Turn this: 
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Into this: 
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Page 2: Select your Images

First you will have to select an image that you want to use. Of course I am using the wall picture from page 1 and this logo. 

 
Then use the Magic eraser tool or any method you want to create the shape you want the picture to be. 
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Page 3: Paste it

Now paste onto the background picture of your choice. 
It does not have to be a wall. It could be a car, a computer, on a person to make the appearance of a tattoo, or any other picture that you would like to use. 
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Adjust and tweak major glitches or problems to the pasted picture at this time. 

Page 4: Perspective

Now we will adjust to the direction of the background. 
Adjust your picture with the free transform tool right click then click perspective. 
This tool takes a little time to adjust to. Practice on a blank document. 
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The logo is now flattened and really unattractive. Let's adjust the height and length. 
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As you can tell I have erased the productions part of the logo to just showcase the TM in the square. 
 
Now on to the fun part. 

Page 5: Adjustments and overlay

Move your picture around the background making sure that the scale and perspective match the area you’re placing your picture 
 
Then  
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I will be selecting overlay to complete the picture. 
 
Choose the option that better suits the lighting or feel of your picture. 
 

Page 6: Solong

I hope that this tutorial helps with any problems you have or has shown you something new. 
 
TMproductions  
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Zombifying Mandy Moore  
 

By molf  Paginated View 

I've made a mini-tutorial to show you how I chopped Mandy Moore into a Zombie a while ago.

Page 1 : Skulls and bones

After I found myself a suitable source pic (1), I first used Hue/Saturation, to decrease the overall saturation and make the colours greener, and did this especially near the lips (2). For the head, I looked for a picture of a skull which was taken from roughly the same angle (3), and used a layer mask to make it seem as if her eye had been taken out (4). 

 

Page 2: Adding details

In the neck area (1), I used source pictures of a leg with spider veins (2), a mummy and a war victim (3). Source pictures which are usable for such a contest aren't always pleasant to look at... I experimented a lot with different blend modes, till it looked right. I finally decided the features of her body wheren't clear enough, so I did some masking adjustments to bring them back (4). 

 

Page 3: Dirty Laundry

The clothes (1) were soiled with a soft brush in red and greenish black colours, while using the overlay layer mode (2). 

 

Page 4: Finished

Finally it was time for some more detailed work. I took the image from (1) to (2) by, among other things: 
- drawing little zits and such 
- using hue/saturation very selectively to tone down the saturation and make some skin extremely green 
- desaturating the hair completely 
- using overlay, soft light and color burn layers and soft red and black brushes to add more shadow and bloody parts 

 
 
Hope this helps you a bit. Be creative and have fun! :D 
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Perspective  
 

By cl0ckw0rk  Paginated View 

I've been saying I'd get around to posting something about perspective for awhile cuz I dunno how often I see pictures where things are matched up very nicely but the perspective is off, which makes object look tilted. 

Page 1 

Well here's an example of how to figure out perspective and what it might look like if I hadn't.  
 
It all starts with the orginal 
 

 
 
I wanted to make it look dangerous and tall so skippin through the cloning and making a piece of slide i could duplicate here is what it might have looked like if I were to do the normal cut and paste of pieces. 
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Page 2

So I'm sure you see how off things are as this is an extreme example. Here is how to find the right way to do it and how I figured out the form for the top part of the slide(incidentally the bottom was brushed and the top I used liquify to distort) 
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The green is the horizon, the points where things connect are vanishing points. I didn't do everything perfect because i was losing details in the bars but the idea is there.  
 

Page 3

Here is what it looks like corrected. 
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I added some more things for the final, kids, a ladder, the shadow for the big slide. The final can be seen in the image at the beginning of this tutorial. 
 
Its worth noting as well that not everything needs to be perfect in chopping either. I didn't make a shadow for the new monkey bars, nor did I attempt to correct perspective on the body of the slide. 
 
So keep perspective in mind next time your chopping! 
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Gender Bending  
 

By CCZ  Paginated View 

A few people had asked me how I did some of the work on Reese Witherspoon in Gender Bending 3. For those of you who are interested, I've put together a little step by step to show some of my nasty little secrets. 

Page 1 

For the haircut, I picked my lasso tool with a good feather on it and selected bits of the hair around the circumference of her head.... 
 

 

Page 2

Then I copied it into its own layer... 
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I scaled... 
 

 

Page 3

then rotated... 
 

file:///C|/Worth1000/13.htm (2 van 5)13-6-2006 23:17:08



Worth1000.com | Photoshop Contests | Are you Worthy™ | tutorial

 
 
...and repeated the process all around the head until the hair was looking about as short as I wanted it. 
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Page 4

For 5 O' Clock shadow, I used my lasso to select the area where my scruff would be built... 
 

 
 
I added some noise... 
 

 

Page 5

...and chose to "Fade" the Noise filter to "Darken" mode. 
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Then I redrew a few different selections in the areas were I wanted to have the facial hair more concentrated and repeated the process. For extra realism, I had a seperate source with real scruff that I blended into the upper lip and chin after the beard was nearly complete. 
 
Hope someone finds this vaguely useful. 
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Faceswapping  
 

By arsidubu  Paginated View 

Find out how to face swap!

Page 1 

The following are some observations I have made regarding the art of "faceswapping", a skill that is used primarily in ModRen and mating type contests. A seamless faceswap should give a viewer the uncomfortable feeling of "Oh God! He's so pretty!" instead of, "Oh God! He's a mutant!" I feel the key to a quality image is recognition of the subject. Recognition relies on the proper matching of your source images, using correct alignment, scaling and masking. 
 

 
 
 
At the top are my 2 source images, Marilyn Monroe and Cary Grant, two of my favorites. Notice that the head angle is already close, and unless you are dealing with subjects that only have a few good images, I see no reason to make more work for yourself trying to tweak the images to make the angle look right. 
 
Image A is what I would consider a decent match. The position and scale of the face are appropriate for the underlying head. 
 
Image B, bigface. The face is just too large for the head. To make it fit, the cheeks and chin of the face are masked out, and to some extent the face becomes unrecognizable as Cary. When adjusting the face size, set the transparency of the face to 50% or so. At 50% transparency it is possible to compare the face scale to the face on the underlying head. I use the eyes as a guide for scale.  
 
Image C, benthead. My example is a little extreme, but you get the point. The head is pointing in one direction, and the face another. When positioning the face, look at the head. If you can only see one ear, this is the side of the nose you should see. It is a simple task to mirror the face to match the angle. Most faces can be mirrored and nobody would notice. A word of advice about benthead images...Avoid using base source images that have the head at odd angles relative to the body. It is guaranteed that even with the best blending, the resulting image will look odd when you are done. 
 
Image D, mutantface. Again, to improve recognition, I don't advise mixing and matching eyes, nose and mouth. It's all or nothing. As in my example, the subjects are unrecognizable. 
 
Image E, ET-head. This is when the face is scaled correctly, the head angle is correct, but the face is sitting too far forward on the head. Kinda like ET. If you find yourself doing a lot of cloning between the ears and eyes, there is a good chance you are gonna end up with an ET-head. Set the face transparency to 50% and use the eyes as a guide to align the images. 
 
Avoid these common mistakes, and you will do fine.  
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Saving Photographs for Contests  
aka  

By Dallas_TX  Paginated View 

This tutorial describes one of many methods for saving photographs in compressed format for the highest quality browser display within the file-size limits requested by webmasters. Simply put, we’re going to take a 100-pound photograph and place it into a 20-pound bag. Or, maybe you could consider this “freeze-drying” a photograph, with only small quality loss.

Page 1 : The Stuff:

SUMMARY: This tutorial describes one of many methods for saving photographs in compressed format for the highest quality browser display within the file-size limits requested by webmasters. Simply put, we’re going to take a 100-pound photograph and place it into a 20-pound bag. Or, maybe you could consider this “freeze-drying” a photograph, with only small quality loss. 
 
The screenshots in this tutorial are of Adobe Photoshop CS2, although almost every photo-editor has similar features. If you don’t yet own a photo editor, I strongly recommend you look into Adobe Photoshop Elements 3.0; it contains most of the photographic features found in the full-blown CS2 version (including “Save for Web” which we'll use here). Photoshop CS2 costs as much as a pretty good camera, and can take a long, long time to master. "Elements 3.0" costs a fifth as much and offers the great advantage of being able to look down your nose with incredible superiority at your friends who stole their full version; you can ask them if they use stolen software to write the copyright protections on their photographs…  
 
Why yes, actually I DO get carried away a lot, why do you ask? Let’s get started, un-huh, un-huh…. 
 
After one completes the editing of his photograph, and gets it *just* right (or omits the stupid editing because it came out of the camera soooo good), you want to save it with the optimal quality allowed by the website-guy, so you can beat-the-hell out your opponents and impress the chicks (but maybe that's just me). So, here’s one method. 
 
 
FILE > Save for Web  

 
 
(Not too hard so far, huh?) 
 

Page 2: the SAVE for WEB Dialog Box

This is the Save for Web dialog box. It looks scary, but it’s a pussycat. 
 

 
 
 
We’re going to go around this photo, counter-clockwise (just because I’m just that kind of guy) and put these five circles to work for us.  
 
#1) This is where we’ll set the size of our image, so let’s talk about that for a second.  
 
I’m only going to remind you of something you already know, size matters. In photo contests, your image must be large enough to be seen clearly or you don’t have a snowball’s chance. Ever bring up a contestant’s image to discover it’s about three inches wide and two inches tall? Enough said. On the other hand, have you ever seen an image you have to scroll around on the screen to view? Sucks as well. If you make your photographs too large or too small, people will laugh at you behind your back, you will bring shame on your entire family tree, and your dry cleaning will always be late. 
 
So, let’s assume almost everyone has a screen of at least 1024 pixels high and 768 pixels wide. If we subtract a fudge-factor for the scroll bars (at the side) and the menu bars (at the top); then 900 by 600 seems to be a pretty good guess at the minimum DISPLAYABLE screen size for our photographs. 
 
To keep our entire photograph on the screen, we scale the LARGEST side of our photograph to the dimension above (either 900 OR 600); if a portrait format (taller than it is wide) scale the height to 900 *OR* we’ll scale the width to 600 in the case of a landscape format (wider than it is tall). We can let the computer figure out the rest (after all, it IS a computer). 
 
We do that by clicking on the IMAGE SIZE tab on the right (#1) and entering either 900, or 600, in the appropriate box. Make sure “constrain proportions” box is checked and click “APPLY”.  
 
There. I knew you could do it. 

Page 3: Continued

 
 
#2) Inside the red circle marked #2 is the zoom factor. I recommend you set this to 200%, which doubles the viewing size (it does not change the actual size, we’re only zooming), so at the end of step #5, we can scroll around and verify the quality is acceptable. If we scroll MORE than 200% we’re going to see things that are just not visible in normal viewing mode and therefore irrelevant.  
 
On around the counter-clockwise circle…. 
 
#3) Click the 2-UP tab. 2-up is not a soft drink or ghetto talk (I just could NOT think of anything funnier to put there. Sorry), it just allows us to do a side-by-side comparison between our newly optimized version and our original photograph. See, step 3 was duck soup, a piece of cake, a walk in the park; getting carried away again... 
 
#4) Set the #4 box to “JPEG”. JPEG was made for photographs, actually that’s what the “P” in JPEG stands for, photographic. If you are doing line drawings or illustrations, JPEG is not the best choice. We photographers have a compression format that’s our very own. Awww…. 
 

Page 4: Continuation of "Continued"

#5) Click the little arrow marked #5 (from the previous picture) and you’ll get this: 
 

 
(I’m hell on those little red circles, huh?) 
 
Click on “Optimize to File Size” (marked #2), and you’ll get this box: 
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It’s a good idea to reduce the file size you want by 2% and enter that value in the box. We reduce the size by two percent so we don’t have to concern ourselves with all that propeller-hat-computereeze stuff. Our file will be under the desired size no matter what the computer-geeks throw at us. We’re artists; we’re above that…..  
 
 
So in this case, I wished to make the best possible image in fewer than 200 KB, so I entered 196.  
 
All right, compare the two images on the left and the right in the 2-UP (still, no better joke) view, and look for “show-stopper” errors. You won’t have to scroll very long; if they are there you’ll see them right off. The chances are very high that you’ll not be able to see much difference in quality between the images at all. If you do see “swirleys” (that’s a technical term I just made up), then reduce the physical size of your image about ten percent and try it again. But don’t be too picky here either; when it comes to looking for JPEG compression errors, you ARE your own worst critic. Remember, no one else will be zooming in on your image at 200% looking for JPEG artifacts. Well, maybe there’s a few that would; but I meant NORMAL people. 
 
Now, just press “SAVE”. BUT DON’T SAVE IT TO THE ORIGINAL LOCATION, give it a new name, it’s useless for anything other than kickin’ butt in web-photo contests. Giving it a new name prevents us from writing over our original image. I recommend you start a folder called “Saved for Web” and put these images there, so they don’t get mixed in with your real photographs. Also, end the filename (not the file extension,Einstein) with WEB, so they can easily be spotted (i.e. thisphotoWEB.jpg). Remember, we’re creating images not much larger than your cell phone produces, so keep them separate, OK? I know where you live. 
 
 
That’s it. Now, you know everything I know (well, plus what you knew before). I hope this works well for you; it is the way photographs are professionally sized for web sites. Think of me sometime while you’re polishing your trophies.  
 
If you have problems, ..rather if you have "Save for WEB" problems, write me. I'd sure be glad to help. 
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Tattoos  
Body Art  

By MaxManti  Paginated View 

Having had a bit of success applying tattoos to celebrities I'll explain the tricks and tweaks I used to create realistic tattoos. This tutorial uses a few basic photoshop techniques, masking, colour adjustment, liquify and the resize and transformation tools.

Page 1 : Geri Halliwell

We'll use my recent Geri Halliwell image as the template for this tutorial. Bikini clad, light skinned people are the easiest to make this rather simple but very effective bodyart. 
 

 
 

Page 2: Flash Sources

The source artwork I use for tattoos is the "flash" artwork that real tattoo artists design and use as a templates for their work. Walk into most tattoo parlours and hanging on the wall or in their design books you'll see a huge selection of artwork you might want to have a tattoo of.  
 
So just Google Image Search with the keywords tattoo + flash and you'll find ample sources to use. Be sure to use an image that is public domain (or ask the author first). It's possible to cut and paste tattoos off the body or image of a person and use different blending methods to achieve a similar effect, but it is very time consuming and much more difficult to get good results. For Geri's arms, legs and torso I used just 3 pieces of flash artwork. 
 

 

 

 

Page 3: Position and Multiply

Let's start with Geri's abdomen and the skulls artwork, just drag the image over her abdomen and apply a mask to the skulls layer. Using the Move tool roughly place the artwork where you want it to sit, using the Transform option stretch/perspective, etc. to get better placement. Mask out the areas where you have any overlap, return to the Move tool if need be and Transform it to your liking using its different settings, I ended up with this. Some people have used displacement maps to align tattoos, not once have I required them. 
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All you have to do next is click on the image thumbnail in the layers palette and alter the blend mode from Normal to Multiply. Simple as pie! because most flash artwork is on a white background selecting Multiply will cause the white background to instantly disappear,leaving you with the coloured or in this case black artwork blended to Geri's abdomen. Tattos are never a solid black so tweaking the layers, colour balance and lowering the opacity makes for a very realistic effect. 
 

 

Page 4: Joining patterns

The same process was used on Geri's arms and legs. a single piece of flash artwork was duplicated and used on 4 or 5 layers, masking, resizing and using the Multiply on each layer. Because the arms and legs had the same pattern I just placed the lower arm and the upper arm layer over the top of each other and masked out any overlap creating a smooth pattern.  
 
The image below shows the 3 layers used with some masking and a pretty good flowing pattern was achieved. Seems a little messy but remember once the Multiply blend is applied all the white instantly disappears. 
 

 

Page 5: Transformation

For Geri's shoulders and chest area, again a repeat of the previous process, just a different piece or artwork was used and it was duplicated onto 2 layers, then one was horizontally flipped for left and right.  
 
For some body parts you might consider using the liquify tool in moderation if the Move/Transform/ Distort option is not achieving the desired "fit". I also mask certain areas with a low opacity brush to achieve a feathered smooth flowing ink effect. You wouldn't want a solid colour to apply to areas in a body cavity or around the edge of a shoulder. 
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Page 6: Coloured tattoos

Finally, for coloured tattoos pretty much the same techniques are used as for black ink work. A little extra work is involved adjusting the opacity of the layer to get that blurred well worn effect, you don't want too vibrant a colour or you will not get that see-through ink applied to skin look. I sometimes use Adjustment layers and the Replace Colour option to lessen a red or to make a green more vibrant.  
 
So basically there you have it, there is nothing too difficult to creating bodyart.  
 
1. Use "flash" source images 
2. Use Multiply for your layers 
3. Use the Transform option to position and distort the tattoo. 
4. Be a little creative and play with the colour and opacity settings. 
 

 

file:///C|/Worth1000/16.htm (3 van 3)13-6-2006 23:17:13



Worth1000.com | Photoshop Contests | Are you Worthy™ | tutorial

Displacement Maps and Textures  
Making a wooden banana in photoshop  
By Maestro_Calhoun  Paginated View 

Through general information and practical application, this tutorial will give you a better idea of how to apply a texture to an object through the use of displacement maps.

Page 1 : What is a displacement map and how does it work?

I had some free time and energy to burn, so I figured I would take what I know about displacement maps and the use of displacement maps to apply texture to an object, put them in to this tut and teach you, the general worth1000 viewing public, about displacement maps through general information and practical application 
 
The displacement map filter in photoshop warps and distorts images by moving pixels according to the guidelines set out by a predefined "map." You can find the displacement map filter under filter>distort>displace 
 
If you've never used them before, displacement maps probably seem like a complicated and foreign concept. However, they're actually very simple if you think about them in terms of black and white. Like masking, black and white are the basis of a proper displacement map. Black moves pixels to the right and/or down. White moved pixels left and/or up. 
 
Once you understand how black and white effect displaced images, then you can start thinking about them in terms of being shades of grey. The shades of grey, depending on what end of the value scale they're on, will mimic that of black and white in a displacement map, only to a lesser degree. Fifty percent (mid grey) makes absolutely no difference on the distortion of the image.  
 
Below is an example of how the different values effect a displaced image with a simple value map over a candid photo: 
 

 

Page 2: Wooden Banana: Getting Started

Now for an example of how to apply a texture to an object with the displace filter. This is the kind of thing you would use most often for you general photoshopping needs here at worth1000. 
 
I am going to use the filter to help me put a wood texture on on a banana peel.  
 
Basically turning this: 

 

 
 
into this: 

 

 

 
 
Now on to the really good stuff. 
 

Page 3: Wooden Banana: Making a Map

First, we make the map. Start by desaturating your main source image. In this case, the banana. This gives use the shades of grey we were talking about earlier. However, if you remember, shades of grey don't have as big of an impact on an image as blacks and whites do. So, in order to get those blacks and whites we're going to adjust the brightness/contrast on this image to add contrast to what we have. 
 

 

 

 
 
Now you probably notice that the different values are defined a bit too harsly where they meet. This will make our texture look choppier than it should (kind of like how the candid example looked above). Therefore we want to add a bit of blur to smooth this out. Typically one or two pixels of blur will get the job done. 
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What we have now is essentially our displacement map. Save the image you have now as a .PSD and remember where you put it. We will need it later. 

Page 4: Wooden Banana: Applying the Texture

Now you can revert your image back to its original state so we can go back to apply the texture. 
 
Now, open your texture. In this case, I chose a fun wood bark with lots of ripples great texturing. Don't mask your texture just yet, we need to displace it first. 
 

 

 

 
 
Navigate to the displace filter and once you select it, this window will pop up. The percentages in this little dialogue box defines how much the blacks and whites will affect the pixels of your texture. Typically, the default settings will work fine, but if you want a more drastic or subtle displacement, you can adjust the percentages to your need. For the purpose of general image editing, like we do here at worth1000.com, keeping the stretch to fit and repeat edge pixels radio buttons selected will work for 
you.  
 

 

 

 
 
Now, once you press ok, another box will pop up for you to select the .psd you made earlier, select that and watch your texture distort. After this, go ahead and mask out the texture to the image. You'll end up with something like this: 
 

 

 
 

Page 5: Wooden Banana: Finishing Up

Now we can go ahead a move on to something that is a different tutorial altogether. Making the banana actually like the wood texture is a part of it. I'm not really going to go in depth into this part. I suggest looking at some of the fine statue making tutorials on the site for more information on this. Once you start playing with this, however, you'll notice how the map really made the texture fit, and made it look very natural. 
 

 

 

 
 
There you have it. Now, you all have the essence of what displacement maps are and how they work. Remember that this tutorial is just a guideline, and applying it to some images may require a slight alteration of what has been presented.  
 
If you have any questions about the things I've talked about here, you can reach me through a site message on worth1000.com. Now, go ye thereforth, and texture stuff. 
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Zebraceros  
Animal Crossbreed Example  
By variant2  Paginated View 

Using the transform, liquify filter and some shading, were going to effectively dress up a rhino in zebra fur.

Page 1 : Source Images

In this tutorial, we're going to combine 2 animals: 

 
 
and this: 

 
 
To make our final product below: 
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First and most important is to find the proper source images. I chose these 2 since the angles and stances are very similar. 
 
Since I liked the high contrast color of the zebra, I decided to use the actual fur and "mold" it over the rhino's body. So with that said, I extracted the zebra from its background and pasted it into the rhino file on a new layer. 
 
NOTE: It's a good idea to use a hi-res image because when you're stretching pixels, a low resolution file is going to lose its realism. 

Page 2: Test Fit

 
 
Okay, let's see how similar or different these two images are. 
 
Lower the opacity of Zebra and compare it to the Rhino background. Using the Transform tool, stretch and compact the image as needed so that you could get the best fit possible. The better match now means less work later. 
 
I found it important to match up the legs first and then the head for this image. 

Page 3: Liquify is your friend
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Since my goal is to cover the rhino's body completely with the zebra, I decided to use the Liquify filter to make the rest of the adjustments. 
 
You need to have quite a bit of patience with the Liquify filter to get the best results. I'm going to assume that you have some experience with this filter so I'm gonna get to the point. 
 
1. Decreased the the Zebra's opacity to about 70% This will help you get better results matching up the two animals. 
 
2. Start off by using a fairly large brush (about 1/3 the size of the animal) and with small strokes, pull the Zebra's main torso to match the rhino. Try to avoid making looong pulls because you won't get desired results. Using the large brush, I basically stretched out the top, buttocks, belly, chest and then I repositioned the head. 
 
3. Once you're happy with those results, you're then going to fine tune the rest of the body using smaller sized brushes. For the Zebra's head, I used small, even strokes to match the shape of the underlying Rhino.  
 
Since the legs are so close together, I had to use the Liquify filter's built in mask tool to protect one leg as I shaped the adjacent one. 
 
Once you have matched the entire silhouette of the Rhino, save your adjustments and get ready for the next step. 

Page 4: Shading

 
 
Okay, the shaping looks ok but our new animal friend is looking a bit flat. We're going to add more depth to this image by adding shadows. I'm not going to be using any blending modes because I want to keep as much detail and contrast as I can -- so with that said: 
 
Make a new layer atop the Zebra and select a soft brush set a 15-30% opacity.  
 
TIP: Hold down the OPTION key and move the cursor in between new blank layer and the Zebra layer. When the cursor changes it's shape, click the mouse button and you have now effectivley made a clipping mask. All your shadows will now be contained inside the zebra. 
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To get the best shading, I occasionally turned the visibility of the Zebra layer on and off used the Rhino background as a reference as to where to add new shadows. 
 
Yeah, that looks better. 
 
Now for the head: 
 

 
 
If you look at the original rhino picture, you'll see that the head has a distinct shape under the horns. It looks like its beefed up.  
 
Okay, add a new layer 
 
Using a smaller, soft brush at around 30% opacity, draw out the distinct lines under the horns (again, use the rhino background image as a reference). With some patience you should get the desired results. 
 
If you find that the shading is a bit too dark, you could adjust the layer opacity of your shadows. 
 
Good Luck and I hope this helps. 
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How I turned Ayumi into a Pinocchio  
 

By luckychingi  Paginated View 

How to adjust a real person's features into a cartoonesque caricature.

Page 1 : The concept

We will turn: 
 

 
 
To 
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Page 2: Lets Begin...

Select the parts which you want to edit and keep them all on different layers. 
 

 
 
Select the 'LEFT EYE' and free transform it 'CTRL + T'.  
 
Lock the 'Maintain Aspect ratio' and increase the width to 150 % 
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Repeat the same step with the 'RIGHT EYE' 
 
Once done, Lower the opacity and place the eye in the proper location. 

Page 3: Cleaning Up

Using a soft eraser, clear out the unwanted parts from around the eye. 
 
You should end up with something like this. 
 

 
 
We are not working much with the nose, so you can just enlarge it a bit. 

Page 4: Lip-syncing
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Now comes the part where in we make the lips smaller and clear out the original lips. You can use any way you find best.  
 
I used the method mentioned below. 
 
Copy a part of the skin from the main layer and paste it on a new layer. Using free transform and the stamp tool cover the original lips. 
 

 
 
Once done, free tranform the lips layer and place it at the proper place. 

Page 5: Finishing Up

For hands, duplicate the main layer and use the liquify tool to make the hands look thinner. 
 
The Final photo will turn up like this: 
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The Aging Process  
Age Progression of a Female Face  

By Grumplebits  Paginated View 

Here’s a little tutorial showing you how I basically go about aging a woman’s face in Photoshop.

Page 1 : Preface

I've been asked several times by different members to post a tutorial on how I age-progress a person. So, here it is! 
 

 
 
Men and women age a little bit differently but since I've only aged female celebrities thus far, I'll just focus on women for this tutorial. I’ll be using the image of Katie Holmes that I did for a past W1K contest, as an example. 

Page 2: Step 1: Choosing an Appropriate Photo

When deciding to age-progress a celebrity’s face, I try to select a picture that is touched-up as little as possible. 
 

 
 
I find that candid shots, or any shots that have not been taken in a studio, work best because the resulting harsh lighting reveals more of the skin’s details i.e. slight bags under the eyes and faint wrinkles. The appearance of such details makes it all that much easier to visualize how your subject will age. Visualizing what the end result will look like brings you one step closer to aging her face realistically. 
 

 
 
In Katie’s case, we can see very faint horizontal lines on her forehead, fairly obvious lines under her eyes and lines bracketing her mouth. 

Page 3: Step 2: Collecting Reference Material

Reference material is key in my method of aging. Keeping Katie’s face in mind, I scoured the Web, looking for faces of old women who either resemble Katie and/or share the same facial expression. Here, Katie is smiling with her face positioned at a 3/4 angle so I tried to gather as many pictures of old women who are smiling in the same manner or close to that. I then opened up the picture of Katie in Photoshop and pasted the found images around her face on a separate layer, spread out to provide easy visual access. 
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Another kind of reference I like to use but is usually hard to find, is pictures of the subject’s parents. I managed to find a couple of reference pictures of Katie’s mother online and they really helped me to decide whether or not to give Katie a double chin. Since her mom has quite a bit of mass under her chin, I decided I would apply that to Katie too. 

Page 4: Step 3: Thinning Brows

Now the fun begins! The first thing I like to do is to thin out the subject’s eyebrows and eyelashes. The older people get, the thinner their hair gets - either because hair falls out and/or because it dries out as it greys. 
 

 
 
So to achieve this, I like to use the Clone Stamp tool at 100% with a relatively small brush size depending on the size and resolution of the image. I sampled the surrounding skin to thin and reduce the number of hairs. 

Page 5: Step 4: Mold the Face

Next, I like to add the basic sags to the skin. I do this in the Liquify mode. I tried to create sagging effects to the cheeks, jowls and the cliff just above the eyes by using the Push tool. For the eyes, I tried to be subtle; otherwise she may end up looking somewhat ghoulish. 
 

 
 
From what I’ve learned about the aging process, I know that while bones cease to grow, and in fact shrink, cartilage does continue to grow. As a result, the end of a nose may appear larger as a person grows older. So while I was still in the Liquify mode, I used the Push tool to extend the length of the nose slightly. Then I used the Bloat tool to also enlarge it slightly, being careful not lose the essential quality or character of the nose. Go too far and it may not look like Katie anymore. 

Page 6: Step 5: The Aforementioned Double Chin

 
 
Based on her mother’s pictures, I then added a fairly massive double chin. I initially used the Airbrush tool with some fairly broad strokes, sampling the colors that were already in the area of her neck. I then worked in the details with a finer brush size. Also, keep in mind that I was also using the other reference photos of older women to guide me. 

Page 7: Step 6: Wrinkle Up the Eyes

For me, the most important parts to get right are the eyes. They can make or break the project. Done wrong and the picture may no longer be identifiable as one of Katie Holmes anymore. I sought out the fine lines around the eyes and I tried to imagine how they would progress into wrinkles. I then extended them in length and width accordingly. Referencing the pictures of old women helped a lot with this step. 
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I used a combination of the Stamp tool and Brush tool. I wish I could explain my technique at this point in a more clinical manner but mostly I relied on my artistic instincts. I emphasized the wrinkles around the eyes by widening and deepening the lines slightly and increasing the contrast by darkening the recesses and lightening the edges. Also, I extended wrinkles to the cheekbone areas. I then applied the same technique to the wrinkles around the mouth and to the forehead. 

Page 8: Step 6: Reducing the Lips

In this step, I work on the lips. As people grow older, the outline of the lips tends to recede. Using the Stamp tool, I sampled the skin surrounding the lips and thinned them out. 
 

 
 
While I was at it, I also added a few vertical wrinkles above the lips to give her a bit of a "prune" effect. We just want a hint of that, so don’t carve out deep lines; deep lines would only be necessary if she was puckering her lips. 

Page 9: Step 7: Planning Out More Wrinkles

 
 
Here, on a separate layer, I faintly outlined or sketched, with a relatively thin brush size, areas that I may or may not add more lines and wrinkles to. It’s easy to get carried away with the addition of wrinkles. So, I stopped, took a step back and assessed where to take to image. For me, it's essential and a great test to see what best works. 

Page 10: Step 8: Touching Up the Wrinkles

Based on the previous step, I added wrinkles where I thought they were needed most.  
 

 
 
Overall, I found that the wrinkles and lines seemed a little flat in comparison to the rest of Katie’s features. They needed more definition so that they could pop out more. So, I highlighted the raised edges of the individual lines with the Brush tool and with a lighter skin tone. 

Page 11: Step 9: Hairy Lips

Facial hair becomes an issue with most women as they age. For some strange reason they lose it in the brow area and grow it back around the mouth area. I didn’t want Katie to be the exception so with a very fine brush size and the Brush tool, I added hairs to her upper lip. 
 

 
 
I tried to make it as subtle as possible. Hairs too thick or dark would draw the viewer’s attention straight to her mustache and I didn’t want that. I also added more wrinkles to the area below the corners of her mouth. 

Page 12: Step 10: Refining the Neck
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I decided that the neck was too smooth for a woman of 75 years of age. So I added finer wrinkles to that area. Also, I added more mass and weight to her jowls with the airbrush by increasing the value of the tones in those areas thus creating more contrast between surface planes. 

Page 13: Step 11: Adding Age Spots

A key component to effective aging of a face is the addition of age spots. 
 

 
 
So at this point, I sampled one of the darker skin tones on her face, and on a separate layer that was set to Multiply and 30% opacity, I brushed them in and tried to create irregular shapes (there IS no perfect age spot). You can add as many as you like; the amount varies from person to person. I decided to be conservative with Katie. 

Page 14: Step 12: More Refinements

I took a little break from it and came back to it later to possibly get a better perspective on it. When I looked at it, at this point, I decided that certain areas needed refining and added detail. This is the beauty of working with a high-resolution file; I can zoom in real close and deal with a wrinkle up-close and personal. 
 

 
 
Unless their teeth were subjected to regular whitening, most people’s teeth yellow with age. Gums also recede, showing less gum and more bone. And so with that in mind, I sampled a yellowish-brown color and on a new layer that was set to Multiply and 30% opacity and painted that color to the teeth with the Brush tool. Her gums didn’t show to begin with, so receding the gums here wasn’t necessary. 

Page 15: Step 13: Preparing the Hair

 
 
The finishing touch here is greying the hair. I began by creating a mask defining the area of the hair. I used the brush for this and tried my best to define as many loose strands of hair that I could. 
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With this mask as a selection, I then created a Hue/Saturation adjustment layer and reduced the saturation to –63. 
 

 
 
I then created a new adjustment layer based on the same mask and adjusted the Brightness/Contrast to brightness +9 and contrast –36. As a result, I found that the darker areas were too pale and caused a loss of depth and so to adjust that, I then selected the mask and scratched out the darker areas with a 5px brush size at 50% opacity so that they could show through from the original image. 

Page 16: Step 14: Hair Raising

The next step was to raise the hairline and thin out the hair. Hair loss is common with both sexes. 
 

 
 
I sampled the area at the top of the forehead and extended the skin area above the original hairline. 

Page 17: Step 15: Greying the Hair

A lot of details of the hair were lost in the previous step so with a thin brush size at 80 percent opacity I drew in fine grey hairs, sparsely laid out. 
 

 
 
Patiently, slowly, stroke by stroke I added more and more hairs until I was happy with the amount of grey I had added. 

Page 18: Step 16: Finishing Touches

Finally, I took a step back, refined a few wrinkles here and there ET VOILA! 
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I hope this tutorial was insightful. It may not be the most technically detailed tutorial but it gives you a good idea of the process I go through to get the job done. Hopefully, it will help you create your own trophy-winning images for future Fountain of Age contests! 
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Unwrapping Hatteras  
Hey, what's going on in there?  
By c1010010  Paginated View 

A real beginner's guide to Unwrapping Cape Hatteras Lighthouse for Invisible World 16. Written from the perspective of a 'chopper with just a little artistic ability but a huge addiction. Trust me, if I could make it... so can you. Go look at my first entry if you don't believe me.

Page 1 : Introduction

In this tutorial, I will show you how I made the black stripes of Cape Hatteras Lighthouse vanish and reveal the insides for all to see. 

 

 
I've broken the process down into four general stages; Erase, Replace, Insert and Convert. 

 
In the first stage, Erase, you will remove the black stripe from around the lighthouse... allowing you to reveal the insides and/or whatever is behind. 

 
In the second stage, Replace, you will let the clouds blow in to show what it looks like behind the lighthouse. You will also add the missing portions of the spiral white stripe. 

 
In stage three, Insert, you will add the spiral staircase to the inside of the lighthouse. Want to tumble down those steps, it's a loooong way down. 

 
And in the final stage, Convert, you will add the final touches to the image and convert it to JPG for post. Yes, yes, I know. The conversion part is kind of lame, but you try to find a good rhyming word for insert that conveys the idea of "finishing touch up"; you let me know. Geez! 

 
I used Adobe Photoshop for Mac OS X for this particular entry, but I used none of its fancy features to get these results. I see no reason this could not have been done using any other decent photo editor. There are many ways to achieve the same results, this tutorial shows mine. Your milage may vary. 

 
At the end of each section I've tried to boil things down into a tip or two that I've slowly learned while at Worth with the comments and generous help of the Worth Masters. 

Page 2: Sources

Before you ever start, you need to have great sources. Not just good ones, mind you... great ones. Many times I've had a fantastic idea but could not find the source images to back it up. A perfect idea is a dud without the great sources. 

 
For this contest I knew I wanted to peel away some of the stripes painted on a lighthouse to show the sky behind. I started off looking for images of a lighthouse with an interesting paint job. I eventually settled on the lighthouse at Cape Hatteras because it's recognizable and has lots of good source material out there. What I ended up with was this fantastic shot, courtesy of NOAA image archives: 

 
 

 

 
As you can see, it has a very interesting point of view. It was this fact that sent me down the spiral staircase route. "How perfect, a spiral stripe AND a spiral staircase. Genius!" So, I google'd for a spiral staircase. I was looking for something that had a similar point of view; "looking up-ish" at a spiral staircase. What I found was: 

 
 

 

 
Perfect. 

 
 
Tip: A perfect idea without perfect source images is a losing entry. 
Tip: Save early, save often... save, save, save.  

Page 3: Step 1: Erase

First, duplicate your background layer by dragging the the "Background" layer to the "Create a new layer" icon at the bottom of your Layers palette. 

 
 

 
 
You never want to work with your original image layer... never. So, duplicate it and name it White Stripes. Turn off visibility on the Background layer, and select the White Stripes layer. 
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In this particular image, we have great contrast and hard edges between the black stripe, the white stripes and the sky. We can cheat a little here and use the Magic Wand to help with our selection. Select the Magic Wand Tool and set the options like so... 

 
 

 
Page 4: Step 1: Erase (continued)

Now, begin by selecting the big black stripe at the bottom of the lighthouse. Once that is selected, hold down the Shift key and select the other black stripes. (Don't forget the little bit at the bottom right, at the base.) Also, there is no need to worry about the Magic Wand grabbing the top of the lighthouse... we'll fix that in a second. 

 
 

 
 
Now, we are going to make a layer mask, but we want to mask everything BUT the stuff we just selected. So, invert your selection. 

 
 

 
 
You should end up with a selection that looks like this: 

 
 

Page 5: Step 1: Erase (continued)

Now, create a layer mask by selecting "Add Layer Mask" from your Layers palette. You will get a linked layer mask in your White Stripes layer. 

 

 
 
You will then see that your White Stripes layer now has "holes" punched where the black stripes used to be. You've just masked them out of the image, but the image data is still there... just no longer visible. 
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Now, with the White Stripes layer mask selected... 

 
 

 
 
...select the Brush Tool and set it's options to a small hard-edge brush... 

 
 

 
Page 6: Step 1: Erase (continued)

Select a foreground color to 100% black and begin brushing black into your layer mask. The effect of black on a layer mask is to make the mask 100% opaque or 100% masking the image. (Conversely, 100% white will make the mask 100% transparent or unmasking the image. Grey will get you something in between... it all depends on how black or white the color you are using on your brush.) 

 
 
It will look like you are erasing part of the image... you're not, it's just being hidden by the mask. 

 
 
Begin to clean up the boundary line between the white stripes and what was the black stripe. It would be very helpful to zoom in a little. Don't worry about the boundary line between the sky and the black line just now, we'll get to that shortly. What you should end up with is a clean, hard edge at the white stripe. 

 
 

 
 
 
Now, begin to clean up the boundary line between the sky and the black line. Since we are dealing with fluffy, wispy clouds we do not want a hard edge here. So, select a brush with 0% hardness... 

 
 

 
 
...and begin to erase the sides of the black stripes. Don't be cheap, really push the edge out. We want the clouds to blend in, and we're going to need a little space to do that. 
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Page 7: Step 1: Erase (continued)

Now, we've got to deal with the top of the lighthouse. Remember the Magic Wand selected it as well? Change your foreground color to 100% white and go grab a small hard-edged brush. With your White Stripes layer mask still selected, brush white at the top of the lighthouse to make the layer mask transparent. The top will reappear. 

 

 
 
Ok, so at this point you should be finished with the Erase stage and your image should look a little something like this: 

 

 
 
Tip: Never work on your original background layer. 
Tip: Always use a layer mask when hiding image data on a layer. 
Tip: When painting on a mask, 100% black = 100% opaque, 0% black (a.k.a. white) = 0% opaque (a.k.a. fully transparent) 

Page 8: Step 2: Replace

Now, we are going to begin to bring in the background clouds. To do this, first we want to create a new layer which will accept our cloned clouds. You always want to have your cloned data stored on a new layer. This way, if you have issues later, you can undo it without destroying your entire image. 

 
 
Click the Create a new layer button on your Layers Palette and name the new layer Clouds. Re-order your layers by dragging the new Clouds layer below your White Stripes layer. The reason we are doing this re-order is because we only want the clouds to show through in the "holes" in the mask we just created; not on top of the white stripes. Your Layers Palette should look something like this: 

 
 

 
 
Zoom in so that you can see decent detail. With your new "Clouds" layer selected, select the "Clone Stamp Tool", grab a medium sized soft-edged brush and set the options to... 

 
 

 
 
Now, Option-Click on part of the clouds to define the source for your clone. Begin to clone the clouds from the source point to the new Clouds layer. Watch the colors and textures you are cloning... blend; you want to make the transitions as smooth and subtle as possible. Pay closest attention to the boundary lines, because that is where people's eyes will first jump. 
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Page 9: Step 2: Replace (continued)

For example, the clouds seem to have "fingers" of white and blue towards the upper right. If you make the "fingers" extend past the boundary convincingly the transition will look best. It may take some time to get it right. Spend the time... don't cheat. 

 
 

 
 
You will most definitely need to re-define source points quite a few times for this step. To best match color and texture, you will want to work in from both sides of the lighthouse. So, for the left side of one of the stripes, you will want to the pull clouds from the left side relatively close to the area you want to fill in. For the right side... pull from the right side. In the middle you will have a rather harsh boundary line where the left and right clone data touches. Just continue to blend that boundary line with the clone tool using similar colors. I zoom in and out frequently to get different perspectives on the work. If you can tell where the "real" clouds and the newly cloned clouds meet... you are not done 
yet. 

 
 
You should end up with something like this when your are done: 

 

 
Page 10: Step 2: Replace (continued)

Now, it's time to add in the remaining part of the white spiral. If you think about it, the only part of the white stripes that we want used to be covered by the black stripe. 

 
 
Create a new layer and name the it Hidden Stripes. Re-order your layers so that the Hidden Stripes layer is between the Clouds layer and the White Stripes layer. 

 
 

 
 
With your Hidden Stripes layer selected, grab the Gradient tool. It's a sub-selection under the Paint Bucket tool. Just click and hold, and a menu should pop up. 

 
 

 
 
Look at the white stripes on the lighthouse... they are dark on the edges, light in the middle. This gives the feeling of depth. Since you already know the general shape of a lighthouse (cylinder or cone), this feeling of depth translates (in your head) to round. We want to have this same feeling for the parts of the white stripe we have to create. 

 
 
Select a foreground color close to (but a little darker than) the middle of the white stripes. Then, select a background color close to (but a little darker than) the very edge of the white stripes. The reason we are choosing colors which are a little darker is because we are dealing with the inside of the lighthouse and the colors will be the same, only darker, inside. 

 
 

 
 
Set the Gradient tool options like this... 
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Pay close attention to the type of gradient selected. The fourth option available, Reflected Gradient. 

 
 
With the Hidden Stripes layer selected, and your Gradient Tool selected, click and drag from the center of the lighthouse outwards to about the edge. Hold down the Shift key while dragging as this will allow you to constrain the line to the horizontal plane. This will force the "line" of the gradient to match the direction of the lighthouse itself. When you let go, you will have a nice smooth gradient from light grey to dark grey underneath the existing white stripe. It will bleed over a bit, but don't worry about that for now. 

 
 

 
 
If the colors are not right, change them and just draw a gradient over and over until it seems to fit in nicely. 

 
Page 11: Step 2: Replace (continued)

Now, with the Hidden Stripes layer still selected, create a layer mask and fill it with 100% black. Your gradient will disappear, but that's OK, we only want it to appear in very specific locations. 

 
 

 
 
With the layer mask of the Hidden Stripes layer selected, grab a hard-edged large-ish 100% white brush. Begin "painting in" (really unmasking the gradient you created before) the back white stripe. Since the gradient is already there it looks as if the stripe has depth to it. If you need to, change between 100% black and 100% white to remove and add to your image. Because you have been using masks on other layers, and are painting into a lower layer things end up looking pretty nice. 

 
 

 
 
 
Page 12: Step 2: Replace (continued)

Just for grins, you can move your Hidden Stripes layer to the top to see just how sloppy you were. But, since you were doing things on a lower layer... it does not matter. 

 
 

 
 
Ok, enough of that. Back to work. Put your Hidden Stripes layer back between White Stripes and Clouds. 

 
 
When you are done any touch ups, you should end up with a nice looking, contiguous, white spiral; you are done with the Replace stage. 
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Tip: Always clone to a new layer. 
Tip: Take advantage of layers and masks you already have in your image. There is no need to waste time and detail on hidden parts of the image that you will never see. 

Page 13: Step 3: Insert

It's now time to start working on the long spiral staircase that will end up in the middle of the lighthouse. (Yes, I know a real lighthouse would not have a single spiral staircase in the middle like this. They are not invisible either.) 

 
 
Jump over to your spiral staircase source. Since we are going to be shrinking this down pretty substantially to make it fit into the lighthouse, you can be a little less than perfect at this point... i.e. cut some corners. (If you really want to be hard-core about it, take our time here and select things carefully by hand. I didn't... and I won.) 

 
 
Grab the Magic Wand tool, set the tolerance to 64 and click on the black portions of the staircase. (You will have to play around with the tolerance value for things like this... if you are not getting enough selected, increase the tolerance, deselect, and try again. If you are getting too much, decrease the tolerance, deselect, and try again. For some reason I have a liking for powers of 2. Can't explain it, I just do, OK?) You should end up with a selection like this: 

 
 

 
 
Copy your selection and paste it into your Lighthouse document. Rename the new layer Staircase and move it to the very top of your layer stack. It's going to look pretty rough at this point, but that's OK for now. 

 
 

 
Page 14: Step 3: Insert (continued)

Create a layer mask for your Staircase layer and mask out the portions of the image we will not need. Really, all we are looking for here is 1/2 turn. So continue masking till you've got a decent 1/2 turn of the stairs. It will be much easier to work with if we shrink the size of this turn a bit. So, with the "Staircase" layer selected, Edit>Transform>Scale to about 50% size. 

 
 

 
 
Now, it's time to start building the complete staircase. Select your "Staircase" layer and duplicate it. It will automatically be named Staircase Copy, that's fine for now. Since we only have 1/2 a turn so far, we need to work on the other 1/2 of the turn. Do an Edit>Transform>Flip Horizontal on Staircase Copy. Move it around a bit so that the central post and hand rail of the staircase match up. You may need do to a little bit of mask clean up here. What you should end up with is a pretty convincing looking full turn of a spiral staircase. 
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Now, if you've been saving lots in the past, we're about do something that is not easily undoable. At points like these, I like to save a new version of my document, so if I ever have to go back, I can. 

 
 
With the highest Staircase layer selected, select Layer>Merge Down. Essentially merging Staircase Copy and Staircase into a single layer called Staircase. It will ask you if you want to Preserve or Apply the layer mask. You want to select Apply. You are now left with a layer, Staircase, with one complete turn of a spiral staircase. Edit>Transform>Scale an additional 50% so that you have some room to work. 

Page 15: Step 3: Insert (continued)

You want to duplicate and stack multiple Staircase layers on top of each other until you end up with spiral staircase that will reach from the base to the top of the lighthouse. Once you have a large enough stack, merge all those layers back down into one single Staircase layer. 

 

 
 
You should then have a complete spiral staircase, ready for insertion. 

 
 

 
 
Now position your Staircase layer on top of the lighthouse. Use Edit>Transform>Scale so shrink and squash the staircase a little so that it looks like it would fit inside. 

 
 
Page 16: Step 3: Insert (continued)

Use Edit>Transform>Perspective to pinch the top and widen the base of the staircase so that it looks like it actually has some perspective and appears to get smaller as it goes up. Tweak and adjust things till it looks right to your eye. 

 
 

 
 
Now it's time to re-order your layers so the staircase appears to be inside the lighthouse. Move Staircase between White Stripes and Hidden Stripes. 

 
 
And you are now done with the Insert stage. 
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Tip: Make use of perspective and scale. It's easy for people to notice when something "just looks off" in an image. 

Page 17: Step 4: Convert

It's time now to step back and look at the image as a whole. More often than not, a 'chopped image is too clean. For instance, the Hidden Stripes layer is just too smooth and even for me. It needs to be lighted a little differently, maybe some noise, etc. This is purely personal taste. 

 
 
For my image, I chose to run the Filter>Render>Lighting Effects filter. The sun in the original image appears to be coming from the upper left... so you want to mimic that with the filter. 

 
 
I also chose to run the Filter>Noise>Add Noise to add 1% of noise to the gradient. Then, after a quick use of Filter>Blur>Gaussian Blur things started to look a little more like I was imagining. 

 
 
There are thousands of ways to adjust your image, color balance, brightness, contrast, filters, etc... keep at it until it feels right. 

 
 

 
 
Finally you will want to size, crop and convert your image to JPG for posting. (See, I told you I would get convert in there somewhere.) 

 
 
And you are now done with the Covert stage... and with your final image as well. 

 
 

 
 
Tip: Don't be afraid to add some "wear" or "age" to your image to make it look more real. 
Tip: Walk away from your image for a while before you submit. It is hard to have a critical eye after staring at something for a few hours. 

Page 18: Conclusion

There are many ways to achieve the same goal... this was mine. I hope you found this tutorial useful and easy to follow. 

 
 
Thanks for reading. If you have any questions or want some more information about any of these steps, please feel free to ask. Worth has been so good to me when it comes to learning and practice; time to pay it forward. 

 
 
Good luck on your next entry! 

 
 
-c1010010 
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Photo Edit 101  
Basic techniques for enhancing your scanned and digital camera images.  

By Dallas_TX  Paginated View 

These are the basic steps in image enhancement. Almost every image you’ll see in print will have had these basic steps performed. Granted, some images have had many, many more modifications done, yet these steps will be paramount in the mix. And these steps are early in the batting-order. This is the ways the pros do it.

Page 1 : Inrtroduction

First, lets take this picture as an example. Not bad, huh? Looks all right I guess? Well, let’s see what we can do with this image with a few basic steps, OK? Then we’ll see how much we like this unedited image.  
 

 
 
 
Oh, yeah. These screen prints have been taken from Photoshop CS and CS2. There’s almost an identical tool in every photo-editing package. They all work the same way; so don’t be rattled if your photo editor is not from Adobe. The tools will still look almost the same too (I bet Adobe loves that). If you don’t yet have a photo editor, there are several free ones on the web, and I highly recommend you consider Adobe Photoshop Elements 3, as it is a fine, fine non-professional photo editor. All the Adobe photo editors are free for a 30-day trial at www.adobe.com 
 
Gee, that was boring, let's get started. Whadda say? 

Page 2: Step one, set the Black and the White points…

Here, we are going to explain to our computer what area of this image is BLACK and what area of this image is WHITE. You’ll notice your color improve greatly as we define these points. The color shift will lessen, the brightness of the image will be unveiled and friends will like you better.  
 
 
NOTE: All the stuff on this page only needs to be done ONCE. No, it's really true, we'll change a couple of settings and save them as our defaults.  
 
Open your levels dialog box by Image > Adjustments> Levels  
 

 
Fig L1 (This might be very slightly different for non-Adobe editors)  
The dialog box should look like this, that is, without all my tacky arrows on it.  

Fig L2  
 
WE ARE NOT GOING TO MOVE THESE SLIDERS, as it’s not usually needed. Here’s how the big-boys do it: 
 
First, click the OPTIONS button (See Fig L2) and let’s tell the computer what we mean when we utter the word BLACK or the word WHITE. We’ll only need to do this step once. So, click the OPTIONS button as in Fig L3.: 
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Fig L3 Change the BLACK to RGB values of 12,12,12. Make sure the "Save as Defaults" is checked.  
 
 
 
Clicking the BLACK box next to “Shadows”, that brings up a color picker. Fig. L3. Change the RBG value to R=12, G=12, and B=12. Then click OK.  
 
Good, I knew you could do it (all your friends were wrong). Now, let's define WHITE: 
 

 
Fig L4 Changing the WHITE value to RGB 245,245,245. Make sure the "Save as Defaults" is checked or you will die. 
 
Just click the WHITE box next to the “Highlights” and, in the color picker, change the RBG values to =245, G=245, and B=245. Then click OK. Fig L4 
 
 
 
TURN ON THE “SAVE AS DEFAULTS”! Remember, we only have to do this once. Then click OK.  
 

Page 3: Still (sigh) setting the BLACK points and the WHITE points....

So, uh, what did we just do? Oh, and why?  
Actually, we just redefined what BLACK really is, and what WHITE really is. We redefined BLACK to be “almost black” and WHITE to be “almost white”. Why? Good question. In BLACK, or in WHITE, there’s absolutely no detail. None. And those shades that are close to BLACK, or close to WHITE, are by default, too extreme to contain any detail whatsoever either. So, now we’ve set the extremes so that shades near black or white can now display detail.  
 
For example, when that Cop shines his thirty-cell flashlight in your eyes at night, it's really hard to read the printing on the bulb. We're gonna turn down Bubba's flashlight just a little so we CAN read the bulb maker. But, still, no donut jokes; they hate that. 
 
Whew, finally back to our picture! Now that we’ve told our computer how we want BLACK to appear and how we want WHITE to appear, lets find a place on our image that should be black and let’s find another point on our image that should be white.  
 
This next technique is secret, an undocumented feature of Photoshop, so please don’t tell anyone. With our levels dialog box still open, place your mouse cursor on the little slider on the LEFT side (I labeled that slider as BLACK above), hold down the ALT key (YES, your picture will disappear), click and hold the mouse button and SLOWLY drag the slider to the right. Fig L5.. You’ll start seeing very small parts of the image reappear, STOP! Notice the location of the FIRST “glob” that appears. Release all the buttons your holding down. The first little black glob that appeared is the darkest area of your photo. 
 
 

 
Fig L5 ALT-Click and drag the left slider slowly until a black spot appears. this is the darkest area of our image. It appears the darkest area of our example image is under the bushes. Just return the slider to its original position, click the black eyedropper then click the area under the bushes! 
 
Now, comes the first cool part, finally. Drag your slider back to it original, upright and locked position (all the way to the left). Click the little eyedropper on the left (it’s supposed to look like a BLACK eyedropper. Hey! I didn't make it.), finally click the area of the image we determined as the darkest “glob”. WHOA!! Suddenly our image looks much better already! Oh, this is really cool…. 
 
 

 
In the above image, see what one click can do? Notice areas such as the water, the flagpoles, the sky, etc. The original does not look nearly so good now, does it? Now, do you see why people like me just so darned much?  
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Let's see what TWO clicks can do..... 

Page 4: Final (honest) Steps in Setting BLACKS and WHITES

So, let’s define WHITE in the exact same fashion, using the slider on the RIGHT this time. We’ll ALT-Click the slider, slowly move it (drag) to the left until something reappears, return the slider, click on the left eyedropper (it’s supposed to look like a white eyedropper, I didn't make that one either..) and finally click the white area on the image.  
 

 
Fig L6 As one might expect the whitest area is the sun-side of the flagpoles. Now, just return the slider, click on the white (right) eyedropper and click this point again. You're a pro! let's keep going.. 
 
A NOTE ABOUT CHOOSING WHITE: Some images may not contain white, so be happy with the improvement most all images will get from setting only the black. Also, SPECULAR HIGHLIGHTS, like the sparkle of a diamond or the shine of chrome are not white. They are, for our purposes here, whiter than white. Don’t use them as a white point. None of the really cool people do it... 
 
Now you CAN do the same for the middle eyedropper, click on any area you KNOW is somewhat middle gray. There’s not a cute little alt-click method for middle gray, and the tricks for determining middle gray are poor at best. So, omit the middle gray if your not sure something is gray, or you can click on things that appear to be gray, if you don’t like the change in your image, just CNTL-Z (That’s UNDO, THE most used command), and try elsewhere. Most of the time I don’t define middle gray with an eyedropper, unless I’m pretty sure something is actually gray.  
 
Just click the “OK” button on the levels dialog box and admire your improved image. But we’re not through yet. Nosireee. 
 

 
Difference in original images and setting the black and white points. See, you thought I was an idiot, didn't you?  

Page 5: Step Two: Bumping the color a tad

This step is MUCH simpler; we’re just going to increase the color saturation a little bit. Color saturation is a cool term for the richness of the colors. So here goes: 
 
Open the “Hue/Brightness” dialog box with IMAGE > ADJUSTMENTS> HUE/Brightness 
(Remember the weasel words above? It may look a little different on other editors, but it’s there). 
 

 
Slightly increase the color saturation.  
 
Now, drag the middle slider to the right just a little. Usually a value between 4 and 15 is good. Too much and you’ve changed your image into a velvet painting of Elvis. Usually, between 8 to 15 are my most common choices. 
 
CLICK “OK” 
 
I told you this was much easier than the last step, see? 
 
 
 
Page 6: Step Three: Just a little sharpening

I own at least a hundred pounds of books and technical papers on sharpening (No, I’m not too sure why). It seems it’s the most written about topic in photo editing, yet FAR from the most important. Still, it needs to be done, so let’s sharpen using some general settings and see what we think. With me? 
 
 
 
We’ll use the Unsharp Mask sharpener (really a stupid name, from the old days, but you’ll get used to it, eventually). Access the USM dialog box with: 
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FILTER > SHARPEN > Unsharp mask 
 
 

 
General sharpening settings using the Unsharp Mask. Now, be stingy with the settings, you can turn Granny's face into a Rand-McNalley Road Atlas.  
 
You’ll see three sliders, Amount, Radius, and Threshold. I’ll leave the descriptions of these to the HELP button, and just suggest a setting that’s good for general sharpening.These settting will also leave your breath minty fresh. 
 
Amount = 100 to 130% 
Radius = 1.0 to 1.5 
Threshold = 0  
 
Press OK 
 
With sharpening, less is more, if you over sharpen, you'll create ghastly halos around all your dark edges. So, be cool... 
 

Page 7: Step Four: This image looks just a little tilted to me, ...you?

To straighten an image, I think best results are obtained when we can define a line on the image that should be either horizontal or vertical, and let the photo editor adjust the straightness from there.  
 
In Adobe image editors, you find, hidden under the eyedropper tool, a handy little gizmo called the MEASURE TOOL. Usually, it’s for measuring distances and angles, as for text and stuff, but this little guy “talks” to the ROTATE command. Lemme show you.  
 

 
The Measure Tool is hidden under the eyedropper. 
 
Find a line on the image that should be horizontal (or vertical). With the MEASURE TOOL selected click one side of the line, hold down the mouse button and move the mouse to the other side of the horizontal (or vertical) line and release the mouse button.In our example image, we've got choices, but the edge of the pool looks like it's level (or the water would be pouring out), so let's drag our measure tool across there.  
 

 
Dragging the Measure tool. Drag across something exactly vertical or horizontal. The yellow highlight was added for visibility and it makes me look good because I know how to do it.. 
 
I guess we now can see that this image is quite titled. But we can fix that…. 
 
Go directly to IMAGE > Rotate Canvas > Arbitrary  

 
The exact angle derived via the Measure tool is automatically entered. Just click OK! 
 
Wow! Notice that the exact angle for the tilt, which we determined with the MEASURE TOOL, is already inserted! Just click OK. Now, our image is straight. Just CROP off the corners, and PRESTO! We’re straightened. Cool, but then again, I don't leave the house too much.... 
 
 
Page 8: Stick a Fork in Us, We

We're done! It's Miller time... 
 
OK, let’s do a side-by-side (below), whaddaya think? After you get a grip on these steps, they’ll take literally only a couple of minutes and greatly improve your images and increase your popularity with the opposite sex. Well, it’ll improve you images anyway. 
 

 
Well, here's what we've done. Better, huh? These steps take about two minutes. I really hope this helps you improve your image, your family has been getting concerned... 
 
 
If you have questions, please site message me (click on my username); I’ll sure help ya' help if I can. 
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Turning people into statues  
How I made the Anthony Hopkins bust.  

By Norrit  Paginated View 

A few people wanted me to share how I created my Anthony Hopkins Bust for Future Memorials 7. The technique I used is different from the methods presented in the other two statue tutorials posted here, and I hope some of you can find my technique useful.

Page 1 : Sources

The key to success is (as always) to find good sources to work with. One of the hardest things to deal with when you are creating a statue is turning the hair into stone (or bronze, or gold or whatever). If you are hoping to learn how to achieve this, you will get disappointed. I’ve tried several ways of making the hair look right in the past and failed miserably every time.  
 
The easy way around this “hairy” problem is of course to forget your Don King or Donald Trump idea and go for Bruce Willis instead. If you don’t want to base your statue on a bald celebrity, try to find a source that has the hair you are looking for. I never decide what celebrity I will use beforehand. When I find a good source I ask myself “What celebrity has hair like that?”. (Too bad everyone in ancient Greece and Rome seemed to have super curly hair. If you don’t want to do 218 Frodo statues). For my Hopkins bust, I used this source: 
 

 
 
Looks pretty much like Hopkins’ hairdo, right? Maybe Nicolas Cage could work too. And maybe a few more. Anyway, Hopkins was my choice and fortunately I managed to find a good source pic of him: 
 

 

Page 2: Positioning and Masking

Ok, we have found good sources which means 50% of our work is done. :o) Time to align the layers. Lower the opacity on the Hopkins layer and make sure the hairlines are aligned. Resize his face if you have to. Don’t worry about the eyes, nose and mouth being off. We will keep the whole lower part of Hokpins’s face for this project so it doesn’t really matter. Remember to make a copy of the Hopkins source, you will need it later. 
 
I decided to mask out the background behind the statue. The boat doesn’t make sense so I go for a plain black background instead (by placing an all black layer below the statue layer). The disturbing metal pipe was removed with the clone tool. I also mask out the parts of his face I don’t need, using a very soft brush.  
 
These steps leave me with this: 
 

 

Page 3: Smudging

Here comes the most important step. We have to lose some of his face texture to make him more statue-like (even if DerAlt tells you wrinkles don’t hurt). For this, I use the smudge tool with the pressure set to about 30%. I use short strokes and try to follow his facial lines so the shadows don’t get too messed up. Don’t overdo do it or he will end up looking too blurry and almost rendered. Here’s a before and after shot to give you the idea of what we are trying to achieve: 
 

 

Page 4: High-pass filter

Ok, time for another little trick. We will use a filter that isn’t used very often (at least not by me) called high-pass. You can find it under filter - other. Set the radius to about 90 pixels and hit ok. Pretty neat, huh? 
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Page 5: Adjustments

Let’s get rid of some color. Choose image – adjust – Hue/Saturation and lower the saturation to about -70. We also want to take advantage of his natural highlights. To make them stand out a bit more, go to image – adjust – Brightness/Contrast. Don’t be shy here. The highlights will be very important to make him look like he is made out of a smooth shiny material. I set the contrast to +30. That’s a bit too much so I lower the brightness to -10. (All values throughout this tutorial are of course based on the particular sources. You’ll have to experiment when you try this technique with other sources). 
 
Ok, this is where we are at now: 
 

 

Page 6: Lighten

Ok, so far so good. The contrast helped us with the highlights but the shadows are now too dark. No sculptor will cut that deep into the block as our current shadows are suggesting. To fix this I create a new layer above and group it with the face layer. Then I set the layer blending mode to lighten in order to not affect the highlights we just created. I also lower the layer opacity to about 40%. Now we need to find a good color. We will use trial and error for this and try different colors until we are satisfied. Pick a color from the scene and work from there. I ended up using this color: 
 

 
 
I painted with a normal brush on my lighten-layer. As it is grouped with the face layer, I don’t have to be careful. The mask I have on the face will take care of it. This is what we get: 
 

 

Page 7: Fixing things

We are getting closer! Now it’s time for some details. Personally I think the chin turned out a bit dull. I want some highlights there too so I use the dodge tool. With a big soft brush, range set to ‘highlights’ I go over the chin area, directly on the face layer. (exposure set to about 30%) 
Hmm, still some color shining through, especially on the lips. Use the sponge tool and desaturate those parts. There! Hopefully your image looks something like this now: 
 

 

Page 8: Color matching

The color match is still not perfect. Instead of tweaking in absurdum, create a new layer above the others but don’t group it with anything below this time. Set the layer blending mode to color and lower the opacity to about 50% (Full opacity would make him look to monochromatic). Pick a color and paint it all over the statue. Try different colors and layer opacities until you are satisfied. This is how my image looks now: 
 

 

Page 9: Eyes

We need to fix his eyes. That will be a big improvement. Fortunately, our original source had pretty good looking eyes so I copy the left eye and paste it on a new layer just above the face layer (it will automatically be grouped). I lower the opacity and use free transform to align the new eye with Hopkins’ left eye. I mask out everything except the eyeball. (Use contrast and/or saturation to make it match the face if you have to). Same procedure for the right eye. I think the right eye on the original statue looked pretty strange so I just copy the left eye layer and use that for the right eye as well. As we just use the eyeball, the symmetry will not be noticeable. Here is what we get: 
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Page 10: Ears

Sir Anthony would be mighty upset if we left him with those goofy looking ears. We will solve this using the same technique as we used for the eyes. Copy from original statue, lower opacity, use free transform to make them look like Hopkins’ ears and mask out parts you don’t want. Place your copy of the Hopkins source image below the ear layer so you can match the shape. (If you have a later version of Photoshop, you can also try liquifying the new ears with Hopkins face as a backdrop layer to get a perfect shape). 
 

 
 
Hopkins ears are smaller than the original statues (thank god!) so you’ll have to mask out the ears on the statue layer. We are almost finished now: 
 

 

Page 11: Final Touches

The last step is all about final adjustments. I added three adjustment layers on top. Contrast/brightness, curves and hue/saturation. Play with them until you get a nice result. This step also involves fixing things you aren’t happy with. Maybe lighten some of the shadows that are still too dark with your dodge tool. Maybe give him some more/less saturation here and there with your sponge tool. If you think the highlights in the face are too visible, try lowering the opacity on the face layer. Not too much or the original statue will shine through. About 80% is a good value. Experiment until you get an image YOU are happy with. (My final result looks slightly different than my entry in the contest but that's just because I used different values on my adjustements layer this time.) 
 

 
 
I hope some of you can find this tutorial helpful. 
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Fattening Folks  
 

By DerAlt  Paginated View 

My attempt to help beginners get familiarized with various approaches to fattening people.

Page 1 

 
 
 
 
When attempting to fatten people there are several options available. While I’m by no means an expert in this area I am aware that there are choices of methods. In the few that I’ve worked on I’ve found that usually you will need to use more than one of the techniques. I think the obvious one is the liquefy tool. This is particularly useful when fattening smaller areas like the contours of the face, arms, fingers etc. 
 
Larger areas can be effectively fattened by isolating the particular area on a separate layer and using the Transform>Distort tool. Cutting and pasting body parts from a source image of a fat person can work well too…if the lighting, color and texture are within the workable range of your image. Cloning the body part larger is also an option but I feel that is fairly laborious and useful on certain features only. Rendering portions of the body is another option that can work very well and it’s very useful in restoring areas that are in need of repair from the artifacts of using the Liquify or Clone tool. 
 
In this example we’ll use all of the above in some form and we’ll take this image of Elizabeth Hurley and add some poundage. Note that all steps taken are on separate layers. 
We’ll go from here.... 

Page 2

 
 
To here. 

Page 3
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A good place to start is the face. The best tool for enlarging the contours of a face is the liquify tool. The brush size is important. A larger brush will create less “drag lines” but naturally will give you less control than a smaller one. You’ll have to experiment a bit here to choose the right size for your job but my rule of thumb is to use the largest size brush that will still give you the control you need. 
 
Set the brush just inside the outer line of the flesh contour and carefully pull the flesh outward to the amount desired. You’ll have to repeat that around the entire area you want to enlarge and adjust brush sizes accordingly. Patience and care are virtues here. 

Page 4

 
 
The same approach can be used for the shoulder, arm and forearm. Carefully work the contours outward until you get a fairly reasonable fattened look. 
 
Using the liquefy tool requires careful and precise movements. It can't usually be done quickly. It can be a bit tedious on a large area to be extended and the proper brush size for the task is very important. Patience is definitely a virtue with this tool. 
 

Page 5

 
 
At this point I like to have some guide/idea of what the eventual enlargement should be. It’s helpful to create a sketch on a separate layer to use as an approximate guide. 
 
To work on the left breast I isolated a copy of that area on a separate layer and used the distort feature. [Edit>transform>Distort] I selectively enlarged the breast to get as close to my overlay guide as I could, paying particular attention to getting the bulge of flesh above the bra to fit the guide.  

Page 6
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This is the result of the distortion after trimming away most areas extending beyond the guidelines. It’s obvious that the distort tool will not solve the problem of creating a reasonable bra area and another approach will have to be used here. However, the bulge of flesh above the bra looks OK and is a keeper. 

Page 7

 
 
Use of the liquefy tool in this case proves to be less than satisfactory also. While it will extend the bra area out to the guidelines it loses too many of the original characteristics and texture. 
 
Note that by checking the BACKDROP box you can select various layers to be visible to help guide your liquefying progress. 

Page 8

 
 
I felt the only way to get the enlarged breast I had in mind was to use the clone tool and create one. The left image shows the cloning process in it’s raw state, choosing areas to clone from as close as possible to the correct density. As you clone across the new area change your access point to approximate the color and density change needed to create the shape you need. They will not blend perfectly but that will be fixed in the next step. 
 
The right image shows the effect of cloning over areas that did not blend well. Use a soft brush at a 5 or 10% opacity and clone over all the areas that need to be blended properly. Cloning light areas over dark “edges” and vice versa. When that was finished I applied a noise value to that area of 2.03 to simulate the original texture that tends to get lost when doing the light value cloning. 

Page 9

 
 
To create the upper portion of her bra, I used a section from the original image. 
The right image shows it in place with some minor adjustments. I blended it in with the cloned bra by erasing the hard edges with a soft brush and completed the blending with some brushed on local color using a soft brush at 10% opacity.  
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The white piping has been trimmed to fit the outer curves and completed by drawing in whatever was missing. A small suggestion of the piping was added at the lower left area of bra to add to the illusion of size. All remnants from the previous steps were removed by either erasing them on the other layers or retouching them out with a small soft brush using the local colors at 10% opacity and adding 1.55 of noise for skin texture. Painting with a brush at low opacity takes longer and requires many more strokes but it results in a more natural blend. 

Page 10

 
 
Beginning work on the outer breast we start with isolating a copy of the original on another layer. 
On the right image, again using Transform>Distort, the breast was enlarged to conform as close as possible to the guide sketch. Obviously, by itself, this doesn’t quite do the job. Some retouching and rendering will again be necessary to improve it. 

Page 11

 
 
The left image shows the retouching/rendering. The distracting white highlight on the breast was removed, the white piping was narrowed to conform to the rest of the bra and a shadow was added to the cup for dimension and to imply more heaviness to the breast. The bottom of the breast is unimportant since it will be covered by her stomach in the next step. 
 
The right image is an enlarged view with noise added for matching texture. 

Page 12

 
 
The best way to add an enlarged stomach, in this instance, is the use of an appropriate source image. The pregnant belly I found is a bit over the top but for this illustration it works well. In an actual job you may want to find something a bit more realistic but the application will be similar. 
 
I removed the background from the belly shot, did a minor resize and rotated it to a logical position. 
 
Using the erase tool with a soft brush I removed portions of the belly, keeping the edges very soft to help the blending step to follow. When I had this edge finished I reduced the opacity of the belly layer so I could see through it and used a hard edged brush to remove the lower portion of the belly to conform to the bathing suit line I wanted...something that would indicate the belly pushing it down. 

Page 13
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The belly was finished off and blended into the body by brushing some of the darker body colors over the edges at low opacity with a soft brush. A shadow was added on the lower area to enhance the roundness and help the blend. A shadowed white piping was rendered in by brush on the upper edge of the bathing suit with some color picked from other shadowed areas of piping. A shadow was also added under the left breast. 

Page 14

 
 
The forward leg is perfect for simply resizing/distorting. Isolate the leg on it’s own layer and use the distort tool to shape it to make it look fat. It’s the best way to enlarge a body part when possible. It retains all of it’s textural characteristics unless the distort is extreme. Unfortunately this works well only in areas where the entire selection is to be affected. 
 
A slight trim was made on the leg where it touches the chair edge. 

Page 15

 
 
The next step is working on her back to further the fat illusion. Again I duplicated and isolated a portion of the back as in the left image and using the liquefy tool used the same technique of carefully “pulling” the outer edges of the back to create some bulging around the suit back, some on the bra strap and a bit near the waist area. 
 
I also used the liquefy tool to enlarge her other leg, mostly on the underside. 

Page 16
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The back needed some blending into her body. On a separate layer I brushed on some of the local color, at low opacity, to blend the addition and match it to the rest of her back, toning down some of the highlights a bit. 

Page 17

 
 
 
I searched for a good image of a double chin at the right perspective but came up empty. 
Instead, I decided to render one. It’s not as good as getting something photographic but it should do the job better than one that’s been forced to fit the image and doesn't look right. 
 
I started with a quick mask creating the double chin shape. Then added some local colors picked up from her chin, both from the dark side and the highlight side on the right. 
I used the smudge tool to blend the edges of the colors into one another and further blended them using the brush at 10% opacity with a medium tone also from her chin. 
I finished it off by erasing some of the double chin contour to fit her face shape better and added some noise to match the other skin texture. 
 
The double chin made it necessary to enlarge her neck also. I used the same procedure as above. Use local colors and smudge tool it onto shape. 
 

Page 18

 
 
This is the final image. A few final touches have been made. I added a small shadow under the bra ring. Added a small wrinkle on the bathing suit below the belly and decided to fatten up her fingers a bit with the liquefy tool.  
 
Obviously there are other possibilities to further enhance the illusion such as stretch marks on the belly, skin wrinkles etc. That’s all part of the fun of doing one of these, adding touches that make this kind of image your unique perspective. Just be careful that you don’t step over the line into the ridiculous and totally unbelievable.  
 
I think I’ve stretched a few things here, perhaps with the pregnant looking belly and the too large breasts, which might have been better less full and more pendulous. However, this was just to familiarize those of you that haven’t tried this before and not necessarily to create a totally believable image. 
 
Naturally this is just my take on how to approach fattening up someone. Many of you will have techniques that 
may be quicker, better or make use of some PS tools I'm unaware of. But I hope this will point some of the less experienced PS'ers in the right direction. 
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Doing an Invisible  
A Basic Approach  

By DerAlt  Paginated View 

As in all image manipulations there are usually several ways to do the job. When doing an invisible this is particularly true. It depends on the original image and what needs to be replaced. In most cases using various areas of the original can create the missing background and either by cloning or duplicating, most of the needed area can be created. 

Page 1 : Basic information

In some instances interiors of the garments have to be created. Sometimes that can be done by cloning, other times it needs to be rendered and shadows added to create the right form, as in this case. Almost always the interior of sleeves, cuffs, necklines or shoes have to be created. I feel that using a second source image to create a background for an invisible removes the challenge and that challenge is the fun of doing an invisible in the first place. 
 
I’ve chosen this image because it requires several of the basic elements found in most invisibles. I couldn’t find any that covered them all. 

 
I’ll insert the usual disclaimer and say that this is just my way of doing this. You may find/have quicker, easier or better ways to do the same thing. 
 
I’ve used just the basic tools and an occasional quick mask. Some minimal drawing is required but nothing that any of you couldn’t handle. It should be noted that each significant step is done on a separate layer, saved each time and noise has been added each time a color has been applied with a brush. 
 
On to the tut. 

Page 2: Step One

 
 
Here is the original, a photo of Cathy Bell. I chose this image because it maximizes the amount of body replacement needed which seemed appropriate for a invisibles example. 
 

 
 
We’ll begin by using the clone tool and start removing her face, hair and the shadow she’s casting on the vent. On a new layer, making sure the “use all layers box” is checked, clone portions of the available vent over the areas you need to remove. I like to use a smallish brush, varying between a hard and soft tip. That makes it easier to get clean edges around items you’re keeping, such as the hat. You could also duplicate areas of the vent on another layer and place them into position. A little bit of touch up with a brush is usually required to fix anything that doesn’t perfectly line up with the cloning. If I get cloning “artifacts” I remove them by spot retouching the area with a click instead of a stroke, from a similar area of color, density and 
texture. 

Page 3: Step Two

When that’s done we’ll have this. 
 

 
 
In this step I also cloned out her arm and began cloning out portions of her leg as well. Cloning is obviously necessary whenever you have a texture or detail to duplicate. When you have a blank area, as in parts of the white funnel, you can simply brush in those areas of color. 

Page 4: Step Three
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Working on the other side of her legs I used the clone tool on the brown railing to keep the texture but used a brush and color to draw in the white and gray rails, sky and cast shadows. Remember to add noise to those areas you are adding with brush work. 

Page 5: Step Four

When completed, that area will look like this.  
 

 

Page 6: Step Five

To create the interior of the garment I started with a base color picked up from a light area of her shirt. Using a quick mask I brushed a flat tone on for starters. This does not truly replicate the look of the shirt in the original. I tried using the bright translucent color area caused by the sun but it looked incorrect. For some reason it looked artificial and kind of “electric.” So I opted to use a slightly darker color. 
 

 
 
The interior of the collar is multiple layers of cloth and would be darker. I picked up a tone from the shadow side of her shirt to use there. 

Page 7: Step Six

Here’s where a bit of drawing is required. With quick mask still active, using black at 10% opacity and a large soft brush, I added shadow to the inner areas of shirt to simulate the hollowness of the empty garment and create the illusion that it’s being filled out by a body.  
I use only the edges of a large brush to keep the shadows very soft and build up the density with multiple strokes for better control. 
 

 
 
When adding these shadows check to make sure they conform to the direction of the light source.  
 
If the “marching ants” are distracting, you can toggle them off and on with Control + H in PS. 

Page 8: Step Seven
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Adding the shadow to both sides and the collar creates the illusion of form. I added a few suggestions of wrinkles which will be enhanced later if they prove to look correct. I also removed a section of shirt at the bottom, above the bikini, to give it a bit more of a flowing look. It’s very important when adding areas of color, to add a bit of noise to them to simulate the texture of the original. Usually a value of 1.55 to 2 will do it I also added a slightly darker tone, using a smaller soft brush, just under the left side of the bra. 

Page 9: Step Eight

 
 
In the previous image you may have noticed a change to the lower left corner of the shirt. To simplify the area and enhance the flowing look I added a curl to the edge. It was done in the same simple drawing method: use a quick mask on the area, add a light base tone and create the form with the edge of a soft brush with a darker color and build up the density with multiple strokes. 

Page 10: Step Nine

At this step several more things have been done. 
Using quick mask, I drew in the shape I felt would look correct for the back of her bikini, reversed it, filled it in with the lightest tone needed and added form with darker tones brushed on in the same manner as the shadows in the previous step. 
 

 
I chose to make it a lighter tone than the front of the garment to create a better separation...using the rationale that the bikini had a lighter lining as most bathing suits do.  
 
I added a bra shadow by using a small soft brush, again at 10% opacity, with multiple stokes. I don’t bother with a mask for these small details. Since it’s on a separate layer it’s simple to erase any overlap.  
 
The remaining bits of her fingers were cloned out on the right side of the shirt and with cloning and some brushwork the existing wrinkles and shadow were extended or adjusted. 
 
At this point the wrinkles added to the shirt back seem to be Ok. So I darkened them a bit more and added slight highlights to give them a little more dimension. 

Page 11: Step Ten

 
 
Using quick mask, I painted on the shapes needed for the interior of the shirtsleeve, collar label and boot. Using the same procedure as before, I filled in a base color and using a small soft brush I added the shadows and highlights for shape. The copy on the collar label was faked with a one pixel brush. 
 
The bra straps were freehanded and a highlight was added to the shirt edge where her hand had cast a shadow. 

Page 12: Finish

Just a final few things to finish the image. 
 
A shadow cast by her cap and shoulder are the final steps. Using quick mask I painted on a shape guessing as to what the shadow should look like and added a color picked up from an area in the dark space between the red louvers. I reduced the opacity of that layer to 65% and had to add some yellow (edit> Color Balance) to get it the correct hue. 
 
I repeated that sequence to create the shoulder shadow. There would be no shadow cast on the shaft of the vent since it’s not close to her. 
 
The area of her boot showing a portion of her leg was retouched to remove the last remaining evidence of her body. 
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At this point I checked the entire image for anything that may have been overlooked in previous steps and to remove anything in the original that should be retouched. I found a few spots here and there on the shirt. 
 
As you can see, the drawing element, as shown on her shirt interior, is basically simple. While some of you may not have tried this sort of thing before it will just take a bit of trial and error practice to master it.  
 
I hope this will have been some help to those of you asking for some advice on doing an invisible. While they’re all a bit different, this example contains most of the issues in a basic invisible. 
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A Simple Layer Mask  
 

By jonboy  Paginated View 

This is a very basic tutorial on layer masks

Page 1 : A Simple Layer Mask

A layer mask is simply a way to hide parts of a picture or text. 
Even though the masked parts are hidden they are still available if you need them. 
 
In order to use a layer mask you need to understand two things: 
black takes away and white adds it back. 
 
When you create a layer mask your foreground and background 
colors change to black and white. 
 
If you fill an area on your layer mask with black,  
that area will disappear. However you use black, 
whether you use a brush, a selection, or a fill, the 
area will disappear. The reverse holds true if you use white. 
White will reveal all there is in the layer mask while black 
will hide all there is in a layer mask. 
 
This is a simple layer mask tutorial. 
The purpose of this tutorial is to mask the 
lettering so that it looks like it's behind the glass  
and so you can have a basic understanding of how a layer mask works. 
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Page 2: A Simple Layer Mask

 
 
I started with this image of the strawberries (layer 2) which I placed in another document.  
I could of easily done this without placing it in another document but this is how I did it. 
 
 
Next, I typed in my text which created its own layer. In order to mask a type layer you 
must render the type by using the menu Layer>Rasterize>Type. 
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You need to create a layer mask as above. The Reveal All means 
everything on that layer can be seen and Hide All will make everything 
disappear. If you use Reveal All (which i always do) you need to use 
black as your foreground color to mask out any areas you want to get rid of. 
If you use Hide All you will need to use white as your foreground color 
to reveal everything which was hidden. 

Page 3: A Simple Layer Mask
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Once you create your layer mask, your text layer will have another icon on it. 
This is the actual layer mask which you will be working on. On this layer  
you have the actual rendered text thumbnail, a layer mask thumbnail, and 
a chain in between. The chain is a link which links the layer and the mask  
together so that they both move together if you decide to move the layer. 
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For this project, I will be using a brush to mask out the area 
of type I want hidden. My foreground color is set to black so I 
can remove the parts of the layer I need to. 

Page 4: A Simple Layer Mask
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Make sure the layer mask is selected. It will have a border around it. 
 
 
 

 
 
 
I start at the top of the text with my brush with the foreground color set to black. 
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By moving my brush along the shape of the glass the text disappears. 
 
 
Page 5: A Simple Layer Mask
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We're getting there, just keep painting with the brush. 
 
 
 

 
 
In this case I went too far and removed part of the text I didn't want to. 

Page 6: A Simple Layer Mask
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No big deal. The beauty of the layer mask is that all of the text is still there. 
I just have to get it back by using white instead of black as my foreground color. 
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Using white will bring back what i mistakenly took away. 
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and this is the finished project. 
 
This was a simple project on describing a layer mask.  
I hope it helps explain how a layer mask works. 
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Fire in the Night  
Day to Night Part 3: Using Fire, the Living Light Source  

By DakotaBoy88  Paginated View 

This tutorial is geared toward the intermediate Photoshop artist who already has a basic grasp of the program's interface and tools. You will learn more advanced masking and lighting techniques, plus some hand-drawn illustration techniques to make your images come alive.

Page 1 : Getting Started

I used Photoshop 6 to write this tutorial, but you can use whatever you want, just be aware that some tools might not work exactly the same and you may need to experiment to replicate the effects. 
 
Turning this: 

 
 
And This: 

 
 
Into This: 

 

Page 2: Masking the Fire

Masking an undefined shape using the "color range" selection tool. 
 
Add the fire to a new layer above the cabin background. 
 
Open "select/color range" to load the color range selection tool. Set the fuzziness to approximately 180, leaving all other settings at default. Click on on the darker area of the fire, then hold the "shift" key and click on the bright center to add it to the selection. 

 
 
With the selection now active, add a layer mask to the campfire layer (the layer mask button is at the bottom of the layer pallet and looks like a rectangle with a circle inside it). Your image should now look something like this: 

 

Page 3: Making the Fire Fit

Use the Free Transform tool to scale down the fire and move it over the top of the right window. Holding down the "shift" key will allow you to maintain the proportions of the fire while you scale it. 

 
 
 
Use the airbrush tool with a nice dark orange color and a small soft brush at low opacity to paint details into the fire to simulate it blowing around the window stiles. Use the smudge tool to lightly cut into the fire base at the stiles to further enhance the effect. 

 

Page 4: Lighting the Interior With Fire

Use any technique you like to select the window panes and door screen. Create a new layer on top, set the layer blend mode to color dodge, then fill your selection with a bright pale yellow color. This image shows the window light by itself in normal mode on a black background for clarity. 
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This image shows the layer in color burn mode over the background. Note: I locked transparency and painted darker areas on the lower portions of the windows here to make the light show brightest only in the highest portions of the windows. Heat rises, so does fire, thus the brightest and hottest parts of the fire are up high casting the most light. 

 

Page 5: More Fire!

Copy the fire layer. Free Transform the new fire layer to shrink it a bit and move it over the door. Use the Liquify or Smudge tool to manually move the new fire around a bit to randomize it's shape; you don't want it to look like a direct copy of the other fire. 

 

Page 6: Day to Night: Setting up the Light

Since the source of the fire is a night scene, it will be far easier to convert the background to night than it would be to convert the fire to daytime lighting. On this page we will start the night conversion of the rest of the image. You can skip this if you have a better fire picture or don't want to do the night conversion. 
 
Make two copies of the background layer just above the background. Select the lower of the two copies and open the "gradient map" adjustment tool. Create a color pallet of brown, tan, and orange that resembles what I have shown below, then apply the gradient. Use the "levels" tool to brighten the dark woodwork, remember you are creating the lit portions of the image at the moment, so it is important to get some detail in the dark areas. 

 

Page 7: Day to Night: Setting up the Night

Click on the upper copy of the background to make it active. Open the "hue/saturation" adjustment tool and select "colorize", then move the sliders to acheive a basic indigo tinted image; apply the changes when you are happy with them. Open the "selective color" tool and make further adjustments to the black, neutral, and blue channels to acheive a higher contrast image as shown in the right panel below. 

 

Page 8: Merging the Light and the Night

Adding Light in the Night 
 
For starters, the windows will never light up if we don't mask out the darkness from them. Hold the "Ctrl" key and click on the window illumination layer; this will automatically select the transparency of the windows. Pretty nifty huh, you didn't even have to save an alpha mask of the windows to do this. With the new selection and the dark layer active, add a layer mask to the dark layer. The lighting on the windows should now come alive. However, the windows are not the only things that need to be lit up; the fire is blowing out the windows and will also light up parts of the exterior structure and surrounding foliage. Deselect the windows and use a soft black brush at low pressure to paint light into the dark image (you are actually just revealing the orange/tan image hidden below). Mask out more where closest to the fire and less the farther you get from it; using a speckle brush will allow you to add lighting details to foliage and fallen leaves. 
 
Mask shown on green background for clarity: 

 
 
Here is the image as you would see it: 

 

Page 9: Color Correcting the Fire

Eew, that greenish-yellow on the outside of the fire just does not go with anything. So, let's fix it. Merge the two fire layers together then open the "selective color" tool. Play around with the the sliders for each of the colors to achieve something you think gives more natural life to the fire. Try each color and see what happens, it's a good learning experience that's better if you try for yourself rather than me telling you where to put each and every slider. Anyway, the new colors I've come up with are shown below. 

 

Page 10: Adding Highlights to the Structure

Fire is bright and tends to leave lots of light on surface joints. Lets add some additional light to the window frames and trim pieces. Make a new blank layer below the fire layer, but above any structure layers. Set the new layer to "screen" mode. Using the line tool with a pale yellow color at low opacity, draw in highlights. Build up successive lines to increase the brightness/thickness for details that are close to the fire. Below is my rendition as applied to the image. Note: I took the liberty of turning out the lights in the leftmost room since it is not yet on fire. 

 

Page 11: Adding Damage Part 1
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The fire is pretty, but it should do more than just look nice. It should be tearing stuff up. Lets do some damage here. 
 
Make a new blank layer just below the fire layer. Hide the fire layer so that just the structure layers are showing. With the new blank layer still active, hold the "alt" key and select "merge visible" in the layer pallet menu. This will make a copy of all the visible layers and paste it into the blank layer. Why do this? So we can do some damage without damaging other layers we have worked hard on. 
 
Use the liquify tool on this new layer to distort the shingles. Don't worry about messing up anything else, we will fix that shortly. 

 

Page 12: Adding Damage Part 2

Fixing the mess we made on the last page and creating real damage. 
 
Use whatever masking technique you like and mask out a burned out area of the shingles, making sure to return the front trim to normal. Hint, you don't need to clone anything, just mask to reveal the original layers where you don't want the damage to occur. Create a block of black just below your damage layer making sure it doesn't cover the room trim. 
 
This image shows the new damaged area. 

 

Page 13: Adding Damage Part 3

Details and lighting to the damaged areas. 
 
Use manual selections to mask and draw in roof joists (upper image). Invert your selection and use an orange airbrush to paint in a "spooky orange glow" between the joists (lower image). 

 

Page 14: Adding Smoke

If the fire is clean and hot you don't need smoke, but we will add it here anyway. 
 
Make a new layer just under the fire. Select a very dark, almost black, airbrush and paint in some smoke. 

 
 
Create another blank layer above the smoke but under the fire and set it to "screen" mode. Using a soft medium orange airbrush add highlights and color to the bottom parts of the smoke billows where they might recieve light from the fire. Change the brush clolor to medium red and add more color just above the orange areas. 

 

Page 15: Blending Smoke and Fire

At the moment the fire looks like it is sitting on top of the smoke. We want the smoke to grow out of the fire so we need to do a minor bit of editing. 
 
Select the fire layer and add a layer mask. Use a large black airbrush at low pressure to fade out the tops of the fires. Click back onto the smoke layer and use a light yellow brush in screen mode to add more light where the fire now hides in the smoke to simulate smoke lit from inside. 

 

Page 16: Final Touches

I made a new layer on top of all the other layers for the final corrections. Set the new layer to "soft light mode" and using a medium orange airbrush paint color onto the areas that are lit by the flames; be sure to mask out the sky and anything else that is not lit by the flames. Note: I also used the same color with a speckle brush to further add details to the foliage and increase the visibility of the image on darker monitors. 

 
 
 
If this were an actual contest image I would remove the daytime shadows, add shadows from the fire, add more damage, and do more with the background. But for the sake of keeping the tutorial somewhat simple I have left these things out, though you would do well to continue on and finish off the little details. Have fun and feel free to send me a message if you have any questions. 
 
--Dakota 
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How I cubed a cherry  
 

By DerAlt  Paginated View 

How to combine illustration and photoshopping to achieve a cool result.

Page 1 : Introduction

This tutorial is not aimed at teaching you new methods in PhotoShop. Instead it’s just an illustration of an alternate way of solving a problem with the basic tools found in most graphic programs. There are many ways to approach image manipulation without relying on filters and actions that sometimes give you less than a satisfactory result. A combination of a simple approach combined with some filter use can be just as effective overall. In this example the only filter used was noise.  
 
As usual, all steps are done on separate layers. 
 
Here's the original source: 
 

 
 
It was chosen for it’s good color, range of density and interesting water droplets. 

Page 2: Getting Started

 
 
The original cherry on the left was chosen from the group of three. As a start, the Free Transform tool was used to stretch the cherry into a more oblong/squarish shape. 
 

 
 
To complete the basic foundation for the cubed look, I cut and pasted some areas from the original that contained details I intended to incorporate into the final and to add to the cubed effect. I elongated some of them with free transform. Some of the interior edges on the additions were softened a bit, with the eraser tool at 20%, to make the transition somewhat smoother. 
 

 
 
I sketched a guide on a separate layer showing the eventual shape/perspective to help in creating a proper cubed look. 

Page 3: Using the brush tool
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Some highlight color from the cherry was picked up, and following the overlay guide, the brush tool at 20% opacity was used to add soft edge highlights to help create the cubed form. I like to use the brush tool at low opacity [about 10%] and build up the intensity in areas where a brighter highlight is needed...as on the upper forward corner. 
 
It gives more control and I think a more natural look to use multiple strokes instead of increased opacity. 
 

 
 
Since the light was coming from the upper right, the left side of the cherry needed to be in a bit of shadow. Picking up some of the darkest cherry color and using the brush tool at 50% a darker tone was added. Avoid getting it too opaque, allow some of the natural texture to show through. Always use colors from the object itself and not from the PS color palette. It creates a better match. If the proper density of color is not available from the object, pick up a color in the object close to it, make a swatch in the background, select it and darken or lighten it as needed for a source 
color.  
 
Most people would create a soft edged mask for this step. I didn’t, I just brushed on the color and removed any part I didn’t like with a soft edged eraser. I don’t necessarily recommend this method, but I don’t see the need to use a mask for every single procedure. Since this is on a separate layer I can still lighten, darken or adjust color without needing a mask. Just my quirk. 
 
Note: Getting the color right is the most important element in retouching and graphic arts. Your eye will pick up a minor color error much more quickly than it will notice a technical one. 

Page 4: Continuing with the brush

 
 
Using the same technique, I brushed on a tone to the front side of the cherry. 
 
This was done with a higher opacity setting, 30 to 40%, with slightly different color densities and applied until it covered most of the detail below it. [I didn’t like the look of most of the detail that existed. In other cases you may want to keep some of it.] Some darker color was brushed near the lower portion of the front to maintain a rounded look to the edges. It’s important that the area doesn’t look too flat and rigid since a cherry would not have a perfectly flat side. Noise was added to give it some texture. A cleanup of the edges and overall shape was done at this point. 
 
Adding some noise is essential to give almost all brushed/airbrushed areas a more realistic/photographic look. 
 

 
 
I brushed a slightly lighter cherry color on the upper right front surface to avoid a totally flat look and to tone down the too bright highlight on the right edge.  
At this point we can cut and paste some water droplets. I like to put them into position and using the eraser tool with a soft brush remove any areas around the droplets that don’t work. I find I usually can’t evaluate what needs to be removed until the object is in place. Sometimes I’m surprised at how well something looks without much manipulation. For purposes like this I use the eraser at 10% opacity to get a very soft transition. 

Page 5: Conclusion
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We’re pretty near being done at this point. The droplets have had some shadows added. Again, this was done with the brush tool, at a small, soft setting and opacity at 10%. Build up the density of the shadows slowly so you can evaluate the results more critically. The larger drops cast a slightly darker shadow than the smaller ones. A proper stem was added with some final inspection and cleanup and shaping of edges and shapes. 
 

 
 
This is the final step. A necessary shadow was added to “sit” the cherry down. 
 
This shadow was added freehand on three different layers. The brush tool with soft edge applied black at 10% opacity. On one layer the basic shape was formed with lighter softer edges as the shadow recedes from the object.  
 
On a second layer the darker tone closer to the cherry was added. Both built up by repetitive strokes.  
 
On the third layer some dilute color picked up from the cherry was added since most strong colored objects reflect some of their color into shadows.  
 
Remember that shadows are darker and sharper close to the object and get softer edged and lighter as they recede. Trying to draw them this way is a bit difficult so I usually finish by touching them up with the eraser and smudge tool. 
 
I hope this was of some help to you. While I realize that this method can only be used on objects with a relatively smooth surface like cherries, peppers, plums etc., the idea of using a brush technique to solve other problems is something to consider. The use of the brush tool here is so simple it doesn’t require great artistic skill. A bit of trial and error and you’ve got it. 

file:///C|/Worth1000/28.htm (3 van 3)13-6-2006 23:17:45



Worth1000.com | Photoshop Contests | Are you Worthy™ | tutorial

Modern Ruins  
 

By Tocath  Paginated View 

How to turn a modern day city into decaying ruins.

Page 1 : Overview

This tutorial will show you the steps and tricks I used in turning Hong Kong harbor into a wasted reflection of itself.  
 
Basically, we're going to turn this: 
 

 
Into this: 
 

 
 
Let's begin! 

Page 2: Planning

Any photoshopped image must start with a great source. Ruins are no exception. For my H2H with Norrit, we were limited to Non-American, Non-European cities. I chose Hong Kong. Ideally, you want a city with a recognizable landmark or building. This can get tricky, as your contest may have 18 New York entries and 20 from Paris. So, be aware that whatever city you choose may be duplicated. Impirnt your own style on whatever city you choose.

 
After selecting a city, find a picture that displays a good view of the features you want to destroy. I would suggest using only images greater than 1024x768 in size. Using a tiny source image for this contest will make things very difficult when it comes time to put in detail. 
 
Here is our source image, a small crop for tutorial purposes: 
 

 
 
Let's talk for a moment about the source pictures for our destruction. I can almost guarantee you that typing "ruins" into Google will get you nothing better than the Parthenon or the Pyramids. While these are certainly ruins, they don't offer much help to those of us who have to ruin modern buildings. Modern materials require modern ruins. So, here is a quick list of words that will bring us modern destruction:

 
 

●     bombed 
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●     bombed out 
●     destroyed 
●     gutted 
●     rubble  

 
It also helps to know your geopolitics. These words brought me the most useful images: 

 
●     Belgrade 
●     Grozny 
●     Kosovo 
●     Lebanon 
●     Sarejevo 
●     WTC 

 
I used 24 different images of rubble and destruction in my Hong Kong image. You don't need nearly that many, but you'll be happier with a greater variety to work from. 
 
We're almost ready to start butchering our buildings. First though, I find it helpful to have some organization. My final Photoshop file was over 50 layers deep, and I would have been lost had I not given the buildings names, like this: 
  

 
You can see that I only know the real name for one building. It doesn't matter, just as long as you can remember it. 

Page 3: Preparation

Let's start destroying! 
 
The first thing is to identify areas where you will be taking large chunks out of the building: 
 

 
 
Create a new layer. Set the Clone tool to "Use all Layers" and clone the sky and ground to create what we would see if a piece of the building wasn't there. Notice that the sky behind the Bank of China building isn't perfect. For this building, I was aware that I would be putting some rubble over that, so I didn't spend a ton of time getting it just right. You only need a nice backdrop to work from. 

Page 4: Bash

Creating the destruction and rubble is perhaps the most time consuming bit of work. 
 
The first thing I'll show you is creating false structure. This is not always necessary, but it can add a sense of realism. Let's create some struts for the Bank of China building. I came across a picture on the net of this building under construction, so I have a good idea of what the insides looked like. 
 
Grab a rubble pick to make our struts. This'll do: 
 

 
 
Then, cloning from the rubble, create strips. These are the floors of the building. Copy these until you have a good amount, then rotate and place over the Bank like so: 
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Pay close attention to the angles when creating false structure. You want it to match as closely as possible to the angle of the building. 
 
Next, eliminate a portion of the struts. This is where you get to be creative. Try to think as you are doing it what consequences your actions have. If you erase a floor here, the mass from the floor must have fallen somewhere, right? Maybe it took out a floor below. Maybe it just landed on the floor below, depositing rubble. Be creative, but don't be completely random. It's an interesting balancing act between chaos and structure. 

Page 5: Bash continued

Now that you've created any false structure necessary, lets get to the real chaos. 
 
Open your rubble images, say, these three: 

 

 

 
 
Now this next part will be much easier if you have a tablet. A tablet's best feature is the ability to sense pressure. If you have a tablet, set your clone brush to "Shape Dynamics" with the Size jitter controled by the pen pressure. This will let you make very thin, light strokes. If you don't have a tablet, that's ok. Simply control the size of your brush by tapping quickly on the bracket keys. [ = decrease brush size, ] = increase brush size. 
 
Ok, create a new layer and clone some chaos from your rubble pile, like this: 
 

 
 
Use varying widths of stroke to create areas of light and darkness. Pay close attention to your shadows. You need to be aware of where the light in your scene is coming from, and where it will cast the shadows. In my scene, as in most, the light comes from above. Notice that in areas where surviving structure overhangs destroyed buildings, I have added shadows. I prefer to use cloned shadow area instead of simply painting black or using the burn tool. Using cloned shadow from a rubble pile will give you a more realistic effect. 
 
Continue cloning until you have something like this: 
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Create new layers for each building, or set of buildings. This will help you control what you see, and will avoid destroying detail you have worked hard on. 
 
Try to pick a different source rubble pic for each building. Even before you start cloning, it can be helpful to adjust the hue and saturation on the rubble pic to more closely match the building you're destroying. 
 
Note also that I took some liberties with the actual look of the brick building as well as the short and busted. If you need to make adjustments to allow for more destruction, do so. This is your image. Who knows what kind of upgrades the buildings have had! 

Page 6: Trash

Now that we have destroyed some facades and collapsed floors, lets add an element of age. The first thing to remember is that destruction is dirty. Clouds of dust in the air, acid rain and soot can make a place look absolutely filthy. Let's throw some on! 
 
I like to apply dirt and grime on a new layer, set to 'multiply' or 'darken' blend mode. Eyedrop a shadow color from your building. It's best to use this method instead of straight black, since the eyedrop will pick up on any hue present. Create a new layer and paint thin strips of color on and around ledges. Next, use the smudge tool to grab that color and smear it down, simulating the effect of rain carrying particles downward. You should come up with something like this: 
 

 
 
After you've done that, I like to apply some nice color to get a rust and soot effect. For my Hong Kong pic, I used a sheet of paper with coffee and tea stains. A texture like this will have lots of great detail that will further grime up the image. Select a few buildings and paste it over like this: 
 

 
 
Selectively erase in areas and get rid of anything that is jarring. Then, set the new texture layer to 'color burn', and drag the opacity down just a bit until it looks good, like so: 
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Page 7: Trash continued

Next, we want to simulate some oxidization and salt deposits from rain and sea. Grab a new texture pic. For mine, I used an image of white paint cracking on a wooden fence. Again, create a new layer and paste in the texture, like so: 
 

 
 
Erase any detail you don't want and set the layer's blend mode to 'soft light'. Decrease the opacity until you're happy with it. This should leave your building looking like this: 
 

 
 
Next, we're going to work on the water. First off, realize that any boats in the water may be sunk, or sitting lower. Raise the water level so that the boat appears to be taking on water. Additionally, remove any white water that exists. Your boat is not moving, and should not be creating a wake. Next, select a brownish color and paint some detail onto the water itself. Set the layer to darken mode to achieve this: 
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Next, you're going to want to add some rust and age to the boat. Grab a new texture map. I used the paper with the coffee stains. Paste that over the boat and erase any unwanted detail. Set the layer at 'color burn' and decrease the opacity to arrive at this: 
 

 

Page 8: Finishing up

You're almost done. We've got a good image, but we want to bring it all together with some post-effects. 
 
Use ctrl+shift+c to copy the entire image merged, or go to 'Edit >> Copy Merged'. Paste this at the top of your layers list. 
 
The first thing we want to adjust is saturation. Crank down the saturation about 25% to simulate a somewhat overcast day: 
 

 
 
Next, we want to make the image a bit more contrasty. I prefer to use 'Image >> Adjustments >> Selective color'. Using 'Brightness and Contrast' can affect saturation, and we don't want that. Selectively darken the blacks first, adding 5%. Next, edit the Neutrals, taking out 10% black. Additionally, for my image, I corrected a slight blue cast by taking out 3% cyan and adding 3% yellow. You should arrive at something like this: 
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Finally, to give the entire image a sense of cohesiveness, and further add to the grimy feel, use 'Filters >> Sharpen' and 'Filters >> Noise' to sharpen the image and add a little noise. Don't go overboard, use sparingly to add some dirt. Do a final once over, selectively desaturating anything that pops too much. 
 
You've now got a finished product: 
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How to make your own 3D Images  
A use for those dorky 3D Glasses.  

By Ankabout  Paginated View 

Learn how to make one of those cool 3D images that you can look at with those 3D glasses.

Page 1 : What you are getting yourself into

We’ve all seen those cool 3D images on the back of cereal boxes or in the “Spy Kids 3D” movie. Even the Mars Lander has sent us 3D Photos. Now you can make your own 3D image by following this simple tutorial. 
 
NOTE: It helps if you actually have a pair of these glasses. If you don't there are websites out there that offer them for free if you send them an adressed enveloppe. 
 
Okay so let’s dive into the depths of the 3D world. Okay bad pun, I know. 
 
As you all know there are usually more than one way to achieve a desired affect, but this method is what I’ve found works best for me. I used Photoshop CS, though it can easily be done in other versions as well as PaintShop Pro. 
 

 

Page 2: Taking the photos...

First of all you’re gonna need to take your photos. Easiest would be with a digital camera but of course you can use a regular camera and scan the images… Up to you… 
 
What the 3D image does, is simulate your eyes seeing 2 different photos, one for the left, and one for the right eye. So naturally, you’re gonna have to take 2 photos. 
 
Find a nice subject with some nice depths and some texture. A bare wall with one subject won’t really do. It would be best to use a stand or something to put your camera on so that it doesn’t move vertically. Take one picture, for the left eye, and then move the camera a bit to the right, about the same distance as the distance between your eyes, about 7cm. 
(This will give you the most realistic view, but feel free to increase the space for a more dramatic effect.) 
 
Feel free to practice with my left eye and right eye pictures. 
 
Upload your pics and save them “left_eye” and “right_eye” respectively. 

Page 3: And then there was no color...

Now we start working on the images, so fire up Photoshop or whatever program you use, and open your 2 images.(If you want to adjust your images before you start working on them, make sure you do the same layer/color adjustments on both images.) 
 

 
 
First we will edit the left_eye photo. Select that image, and then change it to grayscale by going to Image…Mode…Grayscale. Then change it back to RGB. 
 

file:///C|/Worth1000/30.htm (1 van 3)13-6-2006 23:17:49

http://www.worth1000.com/stories/stats.asp?uid=13902
http://www.worth1000.com/tutorial.asp?sid=161051
http://marsrovers.jpl.nasa.gov/gallery/3d/
http://www.worth1000.com/hosted/tutorials/13902_left_eye_small.jpg
http://www.worth1000.com/hosted/tutorials/13902_right_eye_small.jpg


Worth1000.com | Photoshop Contests | Are you Worthy™ | tutorial

 
 
Next, change the right_eye photo to grayscale, but don’t change it back to RGB mode. 

Page 4: Here come the Red & Blue...

Save your left_eye image as 3d_image, as this will be your final image. 
 
Select your 3d_image, and display the channel window. If it is not visible, activate it by going to Window…Channels. 
 
Select only the BLUE and GREEN channels by clicking one of them, and then selecting the other by pressing SHIFT as you click. Your image should now be only in blue. 
 

 
 
Next select your entire right_eye image by going to Select…All. Copy it and paste it into the 3d_image, with only the blue and green channels still selected. 
 
Now click the eye next to the RGB Channel, to activate all channels. Your image will now have a blue and red image overlapping. 
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Technically, you are done now, but your image might need some adjusting… 

Page 5: Now get some glasses!!!

If your image was taken from very far away, you might need to move the 2 overlapping images closer. To do this, choose a point in the middle of the image that would be the same for both eyes. 
 
Then select the red channel only, by clicking it once, and move the image so the point matches for both the red and the blue image. 
 
 
Congratulations, you have your own 3D image. Let’s just hope you have one of those dorky glasses now. 
 
NOTE: To get optimal results, move your head farther and closer to the image until you get a perfect 3D image. 
 

 
 
For different results, experiment with different distances between your left and right eye photos, as well as the distance form the subject. 
 
Of course, if you have any questions feel free to message me. 
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Masks in illustration  
 

By JinxRLM  Paginated View 

One way of going from sketch to finished picture, without the chaos that usually brings.

Page 1 : Introduction

This tutorial shows an example of how masks can be useful when creating original illustrations in Photoshop. 
 
I've gone a bit into explaining masks in general, but not the absolute basics, so it helps if you atleast know where all the buttons and commands are in PS. 
 
I'll also explain what I think is a good allround way of sketching from the ground up. A fairly detailed sketch is required for this method of masking to work out right. 
 
As the example in this tutorial I've used my illustration: 
 

 
 
I chose it because it's a picture where masks really worked out great. With a little brainwork of your own I'm sure you can gel this information with your own methods. 
 
Here we go.... 

Page 2: Sketch

Sketching in Photoshop has many advantages over natural media. For one thing, you can easily erase or adjust while sketching, and you end up with a composition that is, if not done, then almost. 
 
I sketch with a fairly big semi-soft brush (penpressure controlled size and opacity), and a big, rigid eraser (pen contr. size only). Brush foreground color is set to a warm mid-level brown, brush background color is set to the paper color (in this case white). 
 

 
 
If the sketch has several complex items, I usually work on them in separate layers, so I can easily erase overlapping objects. This image is fairly simple so it's all done on one layer. After sketching is done I resize, rotate and move some bits and pieces slightly with the Liquify tool. 
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If I'm unsure of any proportions I might flip the image horizontally to check if anything looks odd, edit the odd part, and flip it back. 
 
After all this I flatten the image, and the "pencil-sketch" is done.  
 

 

Page 3: Sketch coloring

Sketch coloring is good, because it gives me a better view of what the finished image will look like. 
 
On a new layer set to multiply (or gel in Painter), I paint the various colors I want, not worrying about edges that much for now. 
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On another layer on top of this one (set to normal) I paint with a 50% opacity brush in black and white, highlighting and shading based on the direction of my light source (in this case the sun, "off camera"). 
 
I colored this sketch both in Painter and PS, can't really recall the exact brushes used because I was just experimenting. 
 

 

Page 4: Layer separation with masks

This is the part where I tried a new (to me) approach to layer masks. Earlier I've either painted a completely new image in layers on top of the sketch, or created a mess of layers merging with the sketch to make the final pic. 
 
This time I copied the flattened sketch to several (4) new layers, and made layer masks for each copy. If you're fairly new to masks, in this case they mimic the matte painting technique used in movies and animation. It's a great way to separate objects in the foreground from the background. 
 
To help me see what I'm masking out, I use a 50% opaque layer with a bright blue fill between the layer I'm masking and the background. 
 

 
 
I mask all the layers from foreground to background. These layers will now act as a base clipping-layer (new PS CS term) or group (older term). In essence, anything painted on a layer which is on top of the masked layer, and grouped with it (Ctrl+G) will only show what is within the base masks borders. 
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Masking can be done with either lasso or a hard brush. Using a soft brush is usually not a very good idea, if your mask has a very complex outer edge (for example the grass in this image), it's probably better to make a rough mask as a base, and add grass to an ungrouped layer on top. Alt-clicking the layer mask in the layer palette helps you see if you've missed any spots. 
 

 
 
Some of the internal details get their own masks to make sharper outlines. 
 

 

Page 5: Detail work

This is where everything becomes one big blur :) 
 
Basically, add as much details and polish as you like. I usually "sweep" the image several times, each time going into smaller details. It's a good idea to take a break from the image once in a while, doing it all in one sitting can make you miss something. Another tip is to print out your work in progress, and circle parts you'll need to work on with a pen. 
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Page 6: Final master

When I'm staisfied I can't possibly cram any more details into the image and still like myself, I make a merged copy of the whole image to a new layer (Shift+Ctrl+C, Ctrl+V). On this merged copy I try out some level adjustments to give it more oomph. In some cases some color adjustment (with for example selective color) on the merged copy might help the pic as well. 
 
Before: 
 

 
 
After: 
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And that's it. 
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Colorizing Line Art  
 

By SkunkDuster  Paginated View 

Using layer blending modes to simplify the process and get dynamic results.

Page 1 : Getting Started

Here are the basic steps describing how I colorized this image. 
 

 
 
It is done in a three step process: 
1. Block in the area to be colored 
2. Add shadows and highlights 
3. Add effects 
 
For this tutorial, I'm just going to redo one of the gloves. Once you get the fundamentals down, then it is just a matter of repeating the steps for all the other areas in the image. 
 
The first thing you need to do is put the original lineart image at the top of the layer stack. When you open the picture to be colorized, it will probably be called the "Background" layer. Photoshop forces the background layer to be at the bottom of the layer stack, but we want it at the top of the stack. 
 
What you need to do is copy that background layer to make "Background Copy", then delete the original "Background". Now you have your original lineart on a layer that you can freely move up and down the layer stack. 

Page 2: Painting the Lineart

In the following screenshots, the lineart layer is called "Layer 1". Use the dropdown box on the layer palette to set the blending mode of the line art layer to MULTIPLY. You are done with this layer for good. You don't want to do any editing on it at all. The only thing you need to do is make sure it stays at the top of the layer stack. 
 
Create a new layer and name it "Fill". It will appear at the top of the layer stack, so you need to drag it down below the line art layer (Layer 1 in my example). With the fill layer active, pick a medium shade of the color you want and start painting in the area using a hard edged brush at 100% fill/opacity. Since the lineart layer is set to multiply mode, you don't need to worry about being real accurate with your initial painting. You can paint right over the black lineart and it won't affect it. Just make sure you completely fill in the area to be colored and don't go outside the lines. I ended up with something like this: 
 

 

Page 3: Shading

Check the box to preserve transparancy for the fill layer. That is extremely important. If you're not sure what I mean, it is the box highlighted in yellow in the following screenshot. By preserving transparancy for the layer, there is no way you can screw up and color outside the lines. It is a huge timesave when you can start slopping paint down where ever you want instead of meticulously trying to stay within the borders. 
 
Now is the fun part. Pick a lighter shade of your base color and select the airbrush tool with flow set to about 5%. You are going to want the softest brush possible, so use the shortcut SHIFT+[ three times to soften up your brush edges. Now, just start painting in the highlights. You'll need to figure out for yourself where they go. 
 
Once you are satisfied with the highlights, choose a darker shade of your base color and paint in the shaded areas. I ended up with something like this: 
 

 

Page 4: Lighting

To really make it jump out, duplicate your fill layer and set the layer mode of the copy to HARD LIGHT from the drop down box (highlighted in yellow in the following screenshot). 
 

 
 
As a last step, I like to add a bit of noise to the fill layer. 
 

 
 
That's just about all there is to it. The only other things I did was to use the smudge tool a bit on the highlights and shadows and a bit of experimentation with changing the hue/saturation of the hard light layer to tweak the colors after the hard light step. 
 
Good luck! 
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The Slime Factory  
Web design effects  

By pegaweb  Paginated View 

Follow along with the steps the author took to create a navigation bar for the "Slime Factory" website. This shows how to mix metallic textures with gelatinous substances. 

Page 1 : Getting Started!

Follow along with the steps I took to create the website for the "Slime Factory". This website mixes metallic textures with gelatinous substances. 
 
The owners of the Slime Factory wanted a website theme that would match their company name, so they enlisted me to design it for them. The purpose of this tutorial is to show you some of the effects I used to make their navigation bar. 
 
This tutorial goes through the steps I took in Photoshop to make that website. It requires Photoshop 6.0, 7.0 or above to be able to replicate every aspect exactly as shown. 
 
In Photoshop, create a new image (779 pixels wide), and draw a small line with the Freeform Pen Tool. (Make sure you have the "Paths" option at the top left of the screen selected.) Ctrl+Click the line to select it. The line should have a small block at each end. Hold Ctrl and drag the blocks (points) apart, to extend the line. Add new points by clicking on the line (don't press Ctrl.) If you select a point (Ctrl+Click on it), you'll notice it has two "arms". By dragging the arms around (while holding Ctrl), you can change the curve of the line. 
 

 
 
Try to make something similar to what I've made in the diagram above (feel free to vary it as you see fit). It's okay to go off the canvas at the left and at the top (press the "Maximise" button at the top right of the window so you can see outside the canvas.) However, it is very important that the two ends of the line are very close together, as they'll connect up in the next step to form an enclosed area. 
 
Remember - always hold Ctrl when moving a point or an arm. 
 

 

Page 2: Adding Clouds and other Effects

With the Freeform Pen Tool still selected, right-click the line, and choose "Make Selection". 
 
Choose a light green as your foreground colour, and a dark green as your background colour. Click Filter > Render > Clouds, and your area will fill with splotchy green. 
 
In the Layers list, double-click on this layer, and the Blending Options screen will appear. Set the following options: (Leave all settings as default unless specified.) 
 

●     Drop Shadow 
●     Bevel and Emboss (Style: Inner Bevel. Technique: Chisel Hard. Size: 2. Angle 131°, 39°. Global Light: Off. Gloss Contour: Ring – Double, Anti-aliased: Off.) 
●     Gradient Overlay (Blend Mode: Color Burn. Opacity 29%. Gradient Black - White - Black - White. [Click on the little gradient bar and put in extra tabs to do this.]) 
●     Stroke (Size: 3. Colour: #D8D8D8 [light grey].) 
  

Page 3: Spotlights

On the Toolbox, hold down on the Selection Tool icon, until a few other Selection Tools appear. Choose the Elliptical Selection Tool. (Shift+M will also work, if you're using Photoshop 7.0). With this tool, draw an upright elliptical selection. 
 
Change your foreground colour to white, and select the Gradient Tool. Click on the visual representation of the gradient at the top left of your screen. (If you're not using Photoshop 6.0 or Photoshop 7.0, you'll need to click on the Options Palette, and click Edit.) Choose "Foreground to Transparent". 
 
Apply the gradient inside your selected area, from top to bottom. Press Ctrl+D to deselect. Click Filter > Gaussian Blur, and set it to about 5.0. 
 
Change the layer's Mode from Normal to "Overlay". 
 
With the Move Tool, move the layer over the top of your green area. It should now look something like the spotlight at the centre-top of Diagram 3, above. With the Move Tool still selected, hold Alt, and move the spotlight somewhere else. This should copy it. After you've made a few copies, press Ctrl+T for each one, to rotate it a bit. 
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Page 4: Creating something vaguely resembling an egg yolk

With the Freeform Pen, select an area as shown. After the pain of Step 1, creating a shape like this should be no problem. :) Right-click the line, and click "Make Selection". 
 
Create a new layer. 
 
Choose an orangey-yellow colour, and fill the area, using the Paint Bucket Tool. 
 

 

Page 5: Adding some Effects to the yellow area

In the layers list, double-click your yellow layer. Set the following settings: (Leave all settings as default unless specified.) 
 

●     Outer Glow (Colour: Black.) 
●     Inner Glow (Colour: Black. Opacity: 54%. Size: 13px.) 
●     Bevel and Emboss (Style: Outer Bevel. Size: 5. Soften: 1. Gloss Contour: Ring – Double, Anti-aliased: On.) 
●     Contour 
●     Satin (Mode: Multiply. Opacity: 14%. Angle: 19°. Distance: 21px. Size: 32px. Contour: click on the little box, and change it so it looks like this.) 
●     Stroke (Size: 3. Colour: #D8D8D8 [light grey]. Position: Inside.) 
 

 

Page 6: A glossy coat

In the layers list, Ctrl+Click on the layer of your yellow area. This selects it. 
 
Create a new layer. 
 
Fill the area with a white, top-to-bottom "Foreground to Transparent" Gradient, like you did before. 
 
Change this layer's Mode from Normal to Overlay. 
 
Press Ctrl+T to Transform the area. drag the sides and bottom in a bit, as shown on the diagram. 
 
In the Layers list, right-click this layer, and Duplicate it. 
 
Change the Mode of the new layer from Normal to "Lighten". 
 
Press Ctrl+T to Transform it, and bring in the sides and bottom again. 
 

 

Page 7: Menu text and a header

In whatever font you choose (I've used Flying Dutchman here), type in your header text in a very dark grey. In the Layers list, move it below your Lighten and Overlay layers. This makes it look like it's in with the yellowy substance. 
 
In the layers list, double-click the text layer, and give it a Bevel (Style: Inner Bevel. Technique: Chisel Hard. Size: 29. Gloss Contour: Ring. Anti-aliased: On.) 
 
Right-click on the layer and click "Copy Layer Style". 
 
In an orangey-yellow colour, type in your menu text. 
 
Right-click on the layer and click "Paste Layer Style". 
 

file:///C|/Worth1000/33.htm (2 van 3)13-6-2006 23:17:54



Worth1000.com | Photoshop Contests | Are you Worthy™ | tutorial

 

Page 8: Getting your design into a web page editor

If you're using Photoshop 6.0 or Photoshop 7.0, use the Slice Tool to draw boxes on your image. These boxes will each be saved as a separate image when you Save for Web. I'd recommend drawing one big box for your header, and one big box for your menu. There will be a big box of white space, but that doesn't matter. 
 
Also, make sure you save two thin slices (I call them "slivers") at the right and bottom. These should be one pixel thick (I've exaggerated them here for clarity.) 
 
Slivers are simply images that repeat indefinitely to fill up the whole width/height of the screen, regardless of the size of the screen. 
 
Click File > Save For Web. Choose Jpeg, Quality 60. 
 
In your web editor, Create two tables, one above the other. Set the top table to 100% width, sets its background to be the appropriate "sliver" image, and put your header image in that table. 
 
Divide the lower table into two columns. The left column should be as wide as your menu image. Put your menu image in it, and set its background to be your sliver image. Depending on your web editor, you can use Hotspots or an Image Map to make parts of the menu into links. 
 
The right cell should be around 500 pixels in width. If your cells aren't behaving, make sure the table's width is equal to the width of both cells added together. 
 
That's it! 
 
Oh, and there's no *real* Slime Factory. Well... there might be, but I don't really want to know. :) 
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Out-of-Bounds  
 

By hbomb  Paginated View 

Here is a simple tutorial to explain the process behind a typical OOB entry. 

Page 1 : Disclaimer

An Out of Bounds entry, referred to as OOB throughout this tutorial, refers to an entry which makes use of the image borders to add to the 3D feel of the image. 
 
This is how "I" do it, mostly. Though I only use Photoshop, I'm sure all the same ideas can be applied to whatever program you are using. 
 
The single most important element in any OOB entry is the source picture. I'm a purist, so I tend to only use ONE source pic, so I will be showing you how to go from this... 
 

 
 
to this (which is not exactly like my original entry, but I chose to do this over for the tutorial) 
 

 
 
Here we go... 

Page 2: The set-up

The very first thing I do is set up my layers palette like this... 
 

 
 
I have a back up for the original source pic, and two background layers, one black, one white. I use these while I'm masking as you'll see soon.  
 
Next, above my original layer, I create a "Frame" layer. I add layer masks to both the Original and the Frame layer. Now, the setup is complete. 
 

 

Page 3: Framing

Next, I take a few moments to look closely at the original and decide where the best perspective is for my frame, the part that will set it "out of bounds". Since this shot has such a great natural perspective, I'll be working with that, making the front part of the frog the focus "in-frame" and his back legs "out of frame" as if he was walking into the picture. 
 
In the Frame layer I'll draw a white rectangle of the approximate size I'd like my finished frame to be. 
 

 
 
I'll then make a selection inside the box to allow for the thickness of the border. And cut away the excess. (CTRL-X) 
 

 
 
Finally, with the Frame layer selected, I choose Edit-Transform-Perspective (CTRL+T then right click - Perspective) and adjust the top and right sides of the frame slightly. (There are no secret numbers here, this is very much subjective to the picture and 'eyeing' the adjustments is the only way.) 
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I then use the Distort Transform (CTRL+T then right click - Distort) to adjust the frame to allow all the frog bits I want in and out of frame. 
 

 
 
When I'm satisfied with the frame placement, then it's off to masking. 

Page 4: Masking 1

There are numerous ways to make selections for masking, the pen tool (which would be a tutorial in itself) the lasso tool, quick masking. I'm going just select my layer mask on the original and paint with black all the areas that I don't want to show. I click on the white layer mask box in the Original layer. The small circle in box icon appears next to the layer picture and I know I'm painting ONLY in the mask. As you can see, as I paint with black, the image disappears (or is masked out). Painting with white reveals (or unmasks) the Original layer. I've turned off the Black and White layers (Layer 1 and Layer 2) for now, we'll use them when we closer to the edges of the frog. 
 

 
 
I've completely masked out all parts of the background that would fall 'out of frame'. As you can see it's pretty rough at this point. Next well go in close and do some fine tuning on the mask. 
 

 

Page 5: Masking 2

Now, let's zoom in on our frog's hindquarters and get some serious masking done. I'm using a soft 10pt brush with the air brush turned on to mask closer to the contours of the back and legs. Remember, if you mask over part of the frog, you can always select white as your paint color and reveal it again. 
 

 
 
Now that I've fine tuned the mask closer to the frog, I turn on either the black (Layer 1) or white (Layer 2) background layers. This is nothing more than a way to help reveal areas that still need to be masked out, in this case the rust colored background shows up very well against the white, so I'll keep that one turned on. 
 

 
 
Using a combination of smaller brushes, and the smudge tool on the layer mask (which will smudge the black painted areas into the white of the layer mask, giving a little more control over the detail work) I completely eliminate all notions of the background. Remember, working with layer masks is virtually foolproof. You can reveal what you mistakenly masked, or discard the entire mask and start again. After some tweaking and even finer tuning, I have this... 
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Now, onto the frame... 

Page 6: Masking 3 - The Frame

I select the layer mask on the Frame layer. Now we'll remove the parts of the frame where we'd like the frog to overlap. In this case, it's helpful to me to have the black (layer 1) background layer turned on, since my frame is white. 
 

 
 

 
 
Using the same masking principles as before, I begin removing the frame up to the edges of the frog, giving the illusion that the frame runs behind him. When I've revealed all I want to reveal, it's time to start adding some shadows. 

Page 7: Shadows

There are differing views on shadows in OOB and where to add them. I like them when they're dramatic enough to give extra depth, yet subtle enough to not scream LOOK AT MY SHADOWS. Most importantly, we want to match the light from the source pic, which appears to be coming from the top left. 
 
I'll add two layers for the shadows. The first for the frame which I'll call Frame Shadow. This will be placed above the Frame layer and grouped to it (CTRL+G) so all the painting I do on the Frame Shadow layer will ONLY be visible within the confines of the Frame. The shadow for underneath the 'out of frame' portions of the Frog will be painted on the Frog Shadow layer, underneath the Original. 
 

 
 
On the Frame Shadow layer, using a very soft brush with its opacity set to approx 75%, I'll paint where I think the shadows would fall. I do the same to the Frog Shadow layer, making sure my shadows line up with each other. I add the same Gaussian Blur to both shadow layers (in this case a blur of 4.0) and set both layers to Multiply in the blending mode. 
 

 
 
Next, I like to add a subtle shadow for the frame as well, to give a little extra dimension. I'll create a new layer under the Frog Shadow layer called Main Shadow and use the same technique there as described above. I've also lowered the opacity on all the shadow layers to make them more subtle. 
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And that's it. There is probably much more fine tuning on the shadows and the mask that can be done, but this is a basic idea of an Out of Bounds entry. I hope this was helpful in some small way. Feel free to email me with any additional questions, or if you think something needs more clarification. 
 
Thanks and good luck! 
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How to Build a Complete Photo Studio for Less Than $100  
 

By jmbaggs  Paginated View 

Shopping list, prices, and step-by-step instructions to build a durable and versitile home studio...for less then $100!

Page 1 : Shopping list

In this tutorial you will learn how to make this as well as some attachments: 
 

 
 
If you need any questions answered, do not hesitate to email me. 
 
Equipment to buy: (I used Home Depot, Jo-Ann Fabrics, and Photo Market (may be local only)) 
 
Links go to photos of items. They may help as I didn't know the names of some of the items I purchased and thus made up names for them. 
 
Plumbing section 

●     Two ½” x 24” steel pipes (pre threaded for all pipes) $7.96 
●     One ½” x 30” steel pipe $4.98 
●     Two ½” x 10” steel pipes $3.78 
●     Two ½” x 2” steel pipes $1.68 
●     Three T joints $2.76 
●     Two 90º joints $1.44 
●     Two 45º joints $1.78 
●     One ½” copper ring mounts with threaded hole (look at the picture) $1.39 
●     One ¾” copper ring mount with threaded hole (like above only larger) $1.09 
●     One large (the six foot was the cheapest!) threaded rod (3/8 inch). I found it also in the plumbing section (not with the other threaded rods). Be sure to get the big one you will need all of it. $1.39 
●     One bag of mounting brackets $1.79 
 
Nuts and Bolts 
●     One 1" long 1/4" wide bolt 
●     Two 1/4" washers 
●     Two 1 1/2" washers with 3/8" holes 
●     Two 1/4" nuts 
 
Total price: less then a dollar 
 
Electrical section 
●     One steel, one-holed socket cover (don’t look where the regular covers are, the  
cheep ones are with all the steel electrical items) $0.24 
●     Two clamp lamps with 8” metal hoods $15.84 
●     One box of two Halogen flood lights $8.97 
●     Two plug replacements for the lamps $1.96 
●     One can of black spray paint (or any color you want the frame to be) $0.98 
 
Oversized wood section 
●     You have to look around, but there is a 24”x48”x3/4” board that is pre-painted white. It can be found with the large panels of fiber, particle, and While you are there, get it cut into half so you have two 2” squares. You can buy the shelves for pre-fab shelves for storage products but they cost almost twice as much (trust me, I spent about 3 hours searching Home Depot for deals:-P) Paint one black. $9.95 
 
Backdrops: 
●     Four yards of white Muslin @ $.99 a yard $3.96 
●     One yard of Black felt @ $4.99 a yard (it was long enough to keep it down to one yard) $4.99 
●     One quick release camera mount for tripods $19.95 
 
Total: $91.45 
 
The cheapest I have seen this premade was for $700. 

Page 2: Constructing the frame

Use this diagram for the next few steps 
 

 
 
First, screw the two ½ by 2” rods to the T bar across from each other and the 30” rod into the remaining hole. 
 
Next screw the two 45º joints to the ends of the 2” rods and the 24” rods to the remaining end of the two 45º joints.  
 
Next screw the two 90º joints to the 24” bars and the 10” rods to the remaining end of the joint.  
 
Finally screw the center hole of the T joint onto the end of the 10” rod.  
 
It should look like this: 
 

 
 
Note that I have already added the lamps in the picture (instructions in a couple pages). 
 
Now paint the entire frame with the spray paint.  
 
You should now have something looking like a metal alien. Lets mount it. 
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Page 3: Mounting the Frame

Find a small table you don’t use much. You can always remove the table if you need to use it for other reasons. 
 
Place the table against a wall and position the frame above the table with the base sitting on it.  
 
Take the ½” ring mount and slide it on the 30” vertical rod with the 3/8” hole sticking out towards you, not the wall.  
 
Using the copper mounts attach the frame to the wall. Be sure to screw it into a stud so that you don’t have to worry about it falling off the wall. 
 
I placed one on each arm and it held it up just fine. I also put one mount at the very top of the vertical rod to keep it from moving when the camera mount is attached. Make sure you put the ½ ring mount on it first.  

Page 4: The Lamps

Take the two clip-on lamps and remove the clip-on part by unscrewing The wingnut below the light socket. It helps if you remove the light shield as it dents easily.  
 

 
 
Next cut off the plugs on the lamps and thread the cord through the T joint with the lamp end on the inside. Replace the plugs. I know this is drastic but it’s the only way to get the cord through. I tried removing the wires from the light socket itself but I couldn’t. If you get a different type of clip on lamp, you may be able to get around cutting off a perfectly good plug.  
 
Because the lamps are plastic and the frame is metal, it is very difficult to attach the two pieces together. So, I used duck tape to hold the lamps in place.  
 
You can not re-attach the metal hood and screw in the two flood lights.  
 
Since the lights are so big the hood does not serve much of a purpose but you can attach diffusers and other equipment to the hood without damaging or touching the light itself. Also, if you later replace the bulb with a different, smaller light the hood will help to direct and spread the light. 
 
The completed lamp setup should look like this: 
 

 

Page 5: Building the camera mount

Take the half of the large ring mount with the threaded hole in its center. Size the small screw holes of the ring to the screw holes on the metal socket cover. The holes on the ring should be slightly further apart then the holes on the cover. To fix this place the ring mount half on a hard surface (like a cement floor) and gently hammer one end. Do not over bend the ring as it is very difficult to unbend it. Just take it slowly. When the hole line up, screw the socket cover onto the ring mount.  
 
It should look like this: 
 

.  
 
Use this diagram as a guide for the next step: 
 

 
 
Place the screw, nuts, washers, and camera mount onto the ring mount and socket cover. It should like this (minus the camera mount) when you are finished.  
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Make sure the quick release camera mount is well secured by tightening the screw. Be sure the quick release mount is not rotated and lines up with the socket cover so that the camera will point straight down when attached to the mount. 
 
This diagram should help for the next step: 
 

 
 
the center of the 2’ by 2’ squares you have is obviously 12 inches so the center of the camera lens must be at the center of the square. 

Page 6: Camera Mount cont.

Attach your camera to the camera mount kit you made in the previous step and measure the distance from the center of the lens to the end of the hole in the ring mount. I needed 8 inches. Yours may or may not need to be that long. Keep the rest of the rod!  
 
Subtract this distance from 12 inches and that is the length of rod you will need to cut for the camera mount. 
 
After cutting the rod, screw it first into the camera mount kit. (remove your camera first and put it in a safe place away from all the construction:-P) The rod should go all the way through the hole and up against the bolt. This is a good thing, trust me. 
 
Next screw the other end into the ½” ring mount that should already be on the vertical rod. Because the screws of the small ring mount will face the wall it will be difficult to secure the ring mount to the pole so that the camera mount kit won’t move up and down. Fortunately, the threaded rod will go entirely through the hole on the ring mount and into the vertical rod. Continue screwing the entire camera mount into the rod until it is both very secure and will not move up and down, and the quick release contraption is not tilted so that the camera, when attached, will point straight down. 
 
If you need to adjust the height of the mount, just loosen the rod and move it to a new height before retightening it.  
 
The completed camera mount should look like this: 
 

  

Page 7: Backdrops and notes

The Backdrops 
 
To use the backdrops you will first need to remove the overhead camera mount.  
 
Granted you will not be using the above camera mount too often but it was a necessity to me as I will be using it in the future for photographing artifacts (I’m studying to be an archaeologist). I really hope it does serve some use to you though. 
 
The cloth backdrops are extremely easy.  
 
Wash, dry, and iron the muslin. Because it is so thin you will need the entire four yards. Double up the fabric so that it has two layers. 
 
You do not need to do anything to the black felt. 
 
I went very low tech on the backdrop. I slide the remaining part of the threaded rod inside the fold of the white sheet. Holding the rod length wise with the fabric hanging over it I pushed a nail through both layers of the fabric just below the rod. I then hung the rod and fabric by putting the end of the nail inside the open top of the vertical pole. It held nicely and the hole won’t show in any photographs. 
 
For the black felt I folded about four inches over the rod and did the same nail technique as above to hold it up onto the frame.  
 
That’s it. Your now ready to use your studio:-)  
 
Some additional notes: 
 
I have been informed by Satyricon that “The other thing that will really help getting the pictures to come out right (esp. if shooting film) is a couple of 18% gray cards. You just slip them in front of the subject, meter, then remove and shoot. It’s that simple, and you will get a perfect exposure virtually every time. They are available for about $5 at any camera shoppe.” Thanks for the tip! 
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Also, I would recommend using something to diffuse the light a bit such as some wax paper or professional diffusers you can purchase at photo shops. 
 
The next page has different views for reference. 

Page 8: Views

A few shots of all the different possibilities for your new studio: 
 
The first two are with the white/black board used for above shots. 
 

 
 

 
 
The next two are with the black and white background (un-ironed because I was in a hurry to post this) and with just the built-in lights turned on. The fabric goes up about three feet in the back. The thing on the table is the camera mount for bird’s eye view shots. I had to remove it in order to get the fabric on. I highly recommend using a tripod with this setup. 
 

 
 

 
 
One last one with the lights on: 
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Thanks for viewing this and I really hope you can make one! 
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Hand Drawn Stitches in Photoshop  
How the Yoda Badge was made  

By eDorie  Paginated View 

So you want to be a stitcher? Well get your needle, thread and embroidery hoop ready... or just fire up your photoshop, google image search and pour yourself a fresh drink. 

Page 1 : Intro

I'm going to show you how i went from this:  
 

 
 
to this  
 

 
 
in a way that is easy to understand. Please remain seated and buckle up, the ride is about to begin. 

Page 2: Step1... Setting up your patch

First things first.... Find yourself a good surface like this patch 
 

 
 
and put it on the layer above your background) and a cool subject, Like this adorable yoda 
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place yoda in the layer above your patch (and name the layer if you wish to). Turn Yoda's opacity down to 50% or so and position his head over the middle of the patch. 
 
Now you are ready for your base stitching.  
Create a new layer and call it stitches. turn your yoda layer up to 100 percent to sample his forehead color, turn his opacity back down to 50% and begin drawing stitches using your line tool set to 1 pixel, don't worry about getting your lines too closely together, that will be fixed in future steps. 
 
Try to angle your stitches to match the yoda pic and switch colors to match his different skin tones (remember to turn yoda's opacity up before sampling a new color). Try to keep your colors to a minimum though because a real patch isn't going to have 50 seperate colors. I ended up using 6 colors. (inner ears, light skin, dark skin, medium skin, eyewhites, and eyecolor) 
 

 
 
 
whew... all this lining!! Dorie must be crazy!!!! don't worry, you are now officially done with the line tool! Lets move on.... 

Page 3: Step2 Filling In the Empty Spaces.

Make your Yoda layer invisible (but don't trash it, we'll be needing him later) You'll see that your lines don't show up very well, we'll be working on that in this step. 
 
Select your stitches layer and add the layer effect "Bevel and Emboss". Set the style to inner bevel, the depth to 1 up and the blur to one. Click ok. 
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Now you'll make 3 copies of the stitches layer. rename them and order them like this (top to bottom) St. Screen, St. Filler, stitches (original), and St. Mult. 
 
Move the St. Screen layer one pixel to the right and one pixel up, then set the layer option to screen. 
Move the St. Filler one pixel up and to the right 
now Move the ST. Mult layer on pixel down and one pixel to the left and set the layer option to multiply. 
 

 
 
That looks better, but there are still some holes... read on and we'll address that. 

Page 4: Step 3 ACK! Not more Filling!

We can still see some of the red patch through your stitching. This step will fix all that and more! 
 
Create a layer right above your patch layer and call it underpainting, now grab your paintbrush and use Yoda's forehead color to paint behind the stitches, don't worry about going all the way to the edges, because you'll want a bit of red to show through there.  
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Now set your underpainting layer to multiply.  
 

 
 
Lets add some depth to the stitching real quick. Create a new layer on top and call it Depth1 Set Depth to multiply and grab your airbrush, set it's opacity to 50% or so and lightly brush at the edges of your yoda stitches with a medium brown color. You should encircle each area of stitching so that it's darker where the stitching ends (or where real stitching would enter the patch) Don't worry about getting it perfect now... we'll be touching it up in a 
bit.  
 

 
 
Now let's turn our Yoda layer back on. Add a layer mask and mask out everything but his pretty little head. Now set his layer mode to color. 
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Wow! no more Red showing through! We're almost done, just one more step to go.... 

Page 5: Step 4. Finishing Touches

Well... in case you haven't noticed... yoda's ears are hanging out a bit (he's a big eared little guy). Make a copy of your patch layer and move it to the top, add a layer mask and mask yoda's head back in hiding the parts that are outside the red part of the patch 
 
Make a copy of the yoda layer and put it right below the depth layer, change his layer mode to overlay and turn the opacity down to 25% or so (I did this to help add some depth to the stitches, but it's really not that big of a change and is optional)  
 

 
 
Now touch up your depth1 layer to taste. 
 
Whew we're done! Congrats!!! You've stitched Yoda! Feel free to mess around a bit and try your own techniques. This tutorial is the watered down version of what I did in the original Worth Merit Badge Contest, I couldn't include everything, because a lot of what i did was trial and error and tweaking (my original PSD had 30+ layers!). So don't stop here. mess around with lighting and stitching. Good Luck. 
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Sketch / Painting Effect  
 

By Redbull_UK  Paginated View 

Create a sketched or painted effect in Photoshop from a photograph.

Page 1 : What we want to achieve

Basically, I wanted to find a way to create a sketched effect in Photoshop. It can be adapted in many ways toward the end to change the effect completely, so you'll hopefully find it quite versatile. 
 
This assumes a reasonable knowledge of PS. I use PS6. 
It works best with an image which 'fills' the area and is quite colourful. I started with this one ; 
 

 
 
And turned it into this one ; 
 

file:///C|/Worth1000/37.htm (1 van 7)13-6-2006 23:18:03

http://www.worth1000.com/stories/stats.asp?uid=1249
http://www.worth1000.com/tutorial.asp?sid=161032


Worth1000.com | Photoshop Contests | Are you Worthy™ | tutorial

 

Page 2: Sort out the layers

Step 1. Firstly duplicate the layer (right mouse click the layer and select 'Duplicate layer'). 
 
Step 2. Desaturate this new layer (Image > Adjust > Desaturate or Shift + CTRL + U) and rename it Desaturated. 
 
Step 3. Duplicate the layer named Desaturated. 
 
Step 4. Invert this new layer (Image > Adjust > Invert or CTRL + I) and rename it Desaturated & Inverted. 
 
Your image should now look like this ;  
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And your layers should appear like this ; 
 

 

Page 3: Blend Modes 1

Step 5. Right mouse click the top layer titled Desaturated & Inverted and choose Blending Options. Change the Blend Mode to Color Dodge. 
 
Your image should now appear to have almost nothing in it, like this ; 
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Page 4: Blur to see the image

Step 6. With the top layer titled Desaturated & Inverted selected, use the Gaussian Blur filter (Filter > Blur > Gaussian Blur). 
 
I used a radius of around 2 pixels, but you'll need to play around until you find a level you like. 
 
Now it should look like this (and as a pencil sketch, it's not bad) ; 
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Page 5: Color !

Step 7. Merge the 2 top layers titled Desaturated and Desaturated & Inverted (CTRL + E will merge the layer you have selected plus the one below) 
Step 8. Change the Blend mode of this new top layer to Luminosity 
 
The original color layer at the bottom should now show through like this ; 
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Page 6: Filters

Step 9. This is where you can play around to find different effects. I used the Fresco filter (Filter > Artistic > Fresco) to achieve this ; 
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but Cutout works well, as does Smudge Stick and Film Grain. 
 
Have fun with it. Let me know if you find any nice variations. 
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Photo Color Cast Correction  
 

By squaredd  Paginated View 

A quick way to get rid of unwanted color casts in your photographs.

Page 1 : Getting started...

Here is a quick and easy way to get rid of unwanted color casts in your photographs. It is the method they taught in a recent Photoshop seminar for Photographers I attended and it works like a charm on almost any image. This tutorial is for Photoshop users so I am uncertain whether it would translate to other programs such as PaintShopPro. I'm going to present it in a barebones fashion, no explanations of the theory behind it, just the steps involved in action. So without further ado, let's get right to it! 
 

 

Page 2: Halfway there...

First open your photo in Photoshop and duplicate it. (Just so at the end you can toggle and see the difference between start and finish.) For this example I am using tampadan's Mother and Daughter photo because of the strong yellow/green cast it has.  
 
Once the image is opened and duplicated go to Image - Adjustments - Threshold and move the slider all the way to the left until you are left with just a little blob of black about 5 pixels across, no smaller. Move the cursor over it (you will have defaulted to the eyedropper tool) and hold Shift and then click on the blob. This will set a marker on your image. 
 

 
 
Now go back to the Threshold slider and pull it all the way to the right until you are left with just a small blob of white 5 pixels across and Shift/click on it too. Again this will set a marker, and it will be numbered #2. When doing this pick make sure the white blob is not one made by a shiny highlight in your image. For example the glint off of glasses or any reflection off of metal is not good to use. (You can click on and off the Preview checkbox in the Threshold dialog to see what you are picking.) 
 

 
 
Cancel out of the Threshold dialog box. Don't worry about the markers disappearing, they'll come back. 
 

Page 3: Finishing up....

Go to Image - Adjustments - Curves. In the curves box you will see three eyedroppers.  
 
It is suggested that you preset the white point in the Curves dialog. Do this by double clicking on the white (right) eyedropper, then set the RGB values to 240. This prevents any real trashing of detail by over whitening. There is also a theory that you should change the RBG values for the black (left) eyedropper to 20, but I think that is really more of a personal preference on your part. 
 

 
 
Now chose the left eyedropper (single click on it), the dark levels one, then go to your image and click on the marker, #1, you set when you had the threshold levels to the left.  
Then click on the right eyedropper and click on the marker you set with the light, or right threshold level, the one marked #2.  
 
Next is the middle eyedropper. This is the only real judgment call you are going to have to make. You need to click on an object you recognize that shouldn't contain any color at all. A grey object preferably. Perhaps the tire of a car, a grey stripe in a shirt, the pavement of a road, etc. In this example I used the daughters shirt up near the collar. (If you are stuck then go to the Info palate and take the eyedropper for a tour around your image. Look at the RGB numbers. Find a spot in your image where they are as close to being equal to each other as possible (because equal parts of red, green and blue equal grey) and click there. 
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If you are not entirely pleased you can try clicking the middle dropper in another grey area for a different result. Remember that you should only be using the eyedroppers that help. Sometimes a color cast is wanted, like in a sunset, or a fire. In that case just use the ones that help, probably the middle and black ones.  
 
Finally, toggle back and forth between the original and the adjusted images to make certain that you are satisfied with the results, then save. If you follow these steps then you images should come out well color balanced in less than 5 minutes worth of easy work! 
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The Making of Secret Pond  
A look at lighting in a day-to-night  

By Grimtooth  Paginated View 

This tutorial will explain how I created the lighting effects I used in the making of Secret Pond.

Page 1 : Getting started...

In this tutorial, I’m going to take this image: 
 

 
 
and use lighting and color to try to set mood and end up with this: 
 

 
 
This tutorial was made with Paintshop Pro 7, and I’ve only used Photoshop for a few seconds, but I’m sure photoshoppers will be able to figure out what I’m talking about. 
 
Of course everything in this tutorial can be done more then one way, but the way I’m showing you is one of the quickest and easiest ways I could figure to do it. On to the tutorial! 

Page 2: Creating the Highlight Removal Layer (1 of 3)

This is basically a B2B Day to Night image, so first things first, we’re going to make it look like it takes place at night. First, duplicate the layer. This is going to end up being a Highlight Removal Layer. Right click on a layer in the layer pallette and choose Duplicate: 
 

 
 
One of the most obvious indications that this was taken during the day are the sharp contrast of shadows, so we’re going to remove those first. This new layer we duplicated is what we’re going to use for this, so call it something clever like “Highlight Removal.”  
 
Next, we need to make the new layer shades of grey (but not the entire image) so go to Colors -> Colorize. 
 

 
 
Use the settings shown. Hue: 0 and Saturation 0 
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Page 3: Creating the Highlight Removal Layer (2 of 3)

Okay, the reason this layer is greyscale is that it’s going to be used as a mask, of sorts. It could be color, but then we’d have to do a few other things to make it work. 
 
Select the Highlight/Midtone/Shadow filter by going to Colors>Adjust>Highlight/Midtone/Shadow. 
 

 
 
Set everything as you see it. Shadow -100, Midtone-100, Highlight 0. Also make sure Dynamic Adjustment method is set, or this is not going to work at ALL.  
 
Oh, and a note. If you don’t understand Hilight/Midtone/Shadows you should read the help file or a tutorial on it, because it could be a little confusing. Suffice to say that it basically selects ranges of light values and either darkens or lightens them according to what you’ve entered. We’ve told it to darken the darkest values to black, and to also darken the middle values to black. What we’re left with is the highlights. 

Page 4: Creating the Highlight Removal Layer (3 of 3)

Set the layer to Difference mode. It should look like this: 
 

 
 
This doesn’t always work perfectly, and may take some fiddling around with, or slight blurring, but for this pic, it does. 

Page 5: Setting Blue Color Cast and Darkening

Next, we’re going to apply a couple of real easy effects real quick-like.  
 
First, to make it look like it’s night time, an effect that can be achieved by setting the entire image to be a cool color, such as blue. Create a new layer and make it blue, and set the blend mode to Hue. 
 
Second, we’re going to darken everything a bit. Right click on the create new layer button, select New Adjustment Layer, and choose Brightness/Contrast. Set Brightness to -45. 
 

 

Page 6: Sprinkle with Fairies

This next step I’m going to breeze through because it’s repetitive and extremely simple. I cut the fairies out of their background (tutorials for this are all over) and made them appear to glow. I am ashamed to say this, but I used an Eye Candy 3.1 filter; Glow. I actually suggest that you avoid using filters if at all possible, so you might want to try to airbrush the glow around the fairies in a new layer, Gaussian blur it, and mess around with it till you like how it looks. 
 
After this, just place the fairies where you want and resize them so that they appear to be closer or further from the camera then each other. 
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Okay, we’re almost there! 

Page 7: Recreating Highlights

This next part is the pay off for using the weird methods of removing highlights and the Brightness/Contrast adjustment layer. 
 
First things first, go to the Removing Highlights layer we had earlier. Create a mask (there are many tutorials on this, and it would take far too long to explain it, but if you don’t know how to use masks, just use the eraser tool). 
 

 
 
It should look like that. It’s a giant mess, but as long as it looks right in the real pic it should be fine. I’ll show you a close up of the effect you’re going for: 
 

 
 
See, you’re basically removing a layer that was used to remove highlights. You’re selectively reapplying highlights to make it appear as if the fairy is lighting the leaves, and not the sun. This is super fast and easy, and looks pretty damn good for the lack of effort it takes compared to using dodge or burn. 
 
The next part is basically exactly the same as the last part. Go to the Brightness/Contrast adjustment layer and erase sections of it to further light up areas where the fairies are. Masking doesn’t seem to work on adjustment layers, I suppose because the layers are masks themselves. This is more subtle then the last step. 

Page 8: Adding Glare

Now we’re gonna add some glare off the water, just because I like the way it looks. Draw some horizontal lines in a new layer that look a bit like the following: 
 

 
 
Gaussian and motion blur it, and set the layer to Dodge. We’re going for this kind of effect: 
 

 

Page 9: Adding details

Now’s the step I spend forever on, and I think is important for all pictures. Screw around with it and add as many details as you want until you get bored. Heh. I added some trails to the fairies (I Gaussian blurred an airbrush trail I drew), gave the fairy with her feet in the pond’s feet a different sort of effect to make it look like they were under water, darkened shadows where I felt they needed to be darkened and ended up with this: 
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Using Vector Designs & Customizing Text in Photoshop  
 

By Outpatient  Paginated View 

This tutorial will help demystify the lesser known vector side of Adobe Photoshop. We will learn how to produce and alter a vector shape plus we'll get you started on the basics of altering text so no longer will the look of your images containing text have to be defined by somebody else's font.

Page 1 : Introduction

As most of you know, even the current version 7 of Photoshop does not import any vector formats (with the exception of a direct cut 'n paste from Adobe Illustrator). It does open many vector based formats (PDF, AI, EPS) but when it opens them it automatically flattens and rasterizes the image. This destroys the vector objects and turns the data into a pixel based image. However Photoshop does give you a set of tools for creating your own vector objects that can be quite handy for certain types of images. Today I'll show you just a few of those tools and how powerful (and fun) they can be. 
 
Vectors in Photoshop are simply groups of points, lines, and curves used to define objects within your image. Same as vectors you might find in any "normal" vector based graphics program (Adobe Illustrator, Macromedia Flash, Corel Draw, CAD programs, etc.). 
 
In this tutorial we will create a very basic two layer image to demonstrate some of the possible uses of vectors in Photoshop. Each layer will contain a simple layer mask that will define what parts of the layer are visible. However, instead of the mask layers being the typical grayscale image, we are going to use vector masks to define what is hidden and what is visible on each layer. Your final output will be completely dependent on the choices you make, but here's an example of something we might end up of with: 
 

 
 
So let's get started… 

Page 2: Making a vector shape

First, let's make a vector shape. I'm going to use the Polygon Tool. 
 

 
 
Then I'll set the Polygon Tool's options to be a "star" and to "indent sides by" 50%. I'll set the number of sides to the polygon to be 75. Note: when you have the Polygon Tool in the "star" mode, the number of sides will actually be the number of points on your star. 
 

 
 
Then we just click and drag to create the star. However, before we do that, let's look over the different vector modes and make sure we are using an appropriate one. We have three modes; Shape Layers, Paths, and Fill Pixels. We can ignore Fill Pixels for now (and honestly I don't know if this mode is very useful at all). Shape Layers will automatically place your vector object on a solid color filled layer as a vector mask. And Paths will allow you to simply create vector shapes all by themselves. You can then use those shapes for whatever you want (to make a vector mask, to define the shape of a selection, etc.) We're going to use Shape Layers in this example. 
 

 

Page 3: Star power.

So, I have my Polygon Tool all set, now I'll create my shape. Simply click and drag. 
 

 
 
And there you have it. A seventy-five pointed star. As is standard in Photoshop, when creating the object you can use the SHIFT, ALT, and CTRL keys to control aspects of the object (for example holding SHIFT will keep the aspect ratio perfectly square). Making this object has created a solid color fill layer using my current foreground color (black) and it's using the vector shape as a layer mask for this layer. 
 
Ok, so, you may be wondering, what is so cool about vectors? What's the big deal? 
 
Well for one thing, working with vector shapes you can do some pretty cool stuff. Watch… 

Page 4: Altering the vector shape

I am fond of my many pointed star here, but it is a little mundane. Let us tinker with the shape and try to give it a little more pizzazz. First thing I am going to do is switch to my Direct/Path Selection Tools. (The Direct Selection Tool allows you to select individual nodes or points of the object, while the Path Selection Tool will select an entire object. Both these tools work by either clicking directly on points or shapes, or by dragging a selection "fence" around multiple points/shapes.) 
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Then, to make the vector shape much easier to work with, I'm gong to turn off this layer's visibility so the color won't obscure our view of the shape. To do this, 1.) click on the layer visibility icon to turn off it's visibility, then 2.) click on the thumbnail of the path for that layer. 
 

 
 
After that the only thing I see is the vector shape I'm working with: 
 

 

Page 5: Inner Selection

Now using the Direct Selection Tool I'm going to highlight/select just the inner points of my star. This particular shape makes it difficult to fence in all the points we want to select in a single move. That's no problem. Similar to the marquee selection tool, just hold down SHIFT to add more points to your existing selection.  
 
Starting from the center of the star I'll select approximately a quarter of the inner points. Then holding SHIFT, I'll select the remaining three quarters, one at a time: 
 

 
 
Here's my star with the inner points selected: 
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Then I'll right-click and do "free transform points". 
  

 
And as you can see here, I can now manipulate the inner points while the outer points remain anchored. Cool huh? 
 

 
 
Now, that gives our basic pattern a little more pizzazz, doesn't it? 
 

 

Page 6: Make text into vector shapes

Ok, on to making our second layer. This next technique can be extremely valuable when you need to produce unique lettering, such as in one of our corporate contests where so often a company is seeking a logo. Our second layer is going to be comprised of a custom text shape that no font can reproduce. 
 
First thing we need to do is make a text layer and choose a font you want to start with (the simpler the font the better). 
 

 
 
Then convert that text layer to a shape layer. This option is in the Layers drop-down menu. Follow along…: 
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Page 7: Customizing the text

Now, what was previously a font with an unchangeable shape has become vector shapes that you can manipulate any way you see fit. Again, cool huh? 
 

 
 

 
With this technique you can take common fonts (that any John Doe can use) and transform them into your own custom, stylized text that nobody will be able to duplicate (except other Photoshop gurus of course). 

 
 
Now I'm going to use my Direct Selection Tool and see if we can't change these letters into something that is a unique shape yet remains readable as text. I'll keep it simple for this demonstration.  
 
After moving a few anchor points around and combining a few shapes, I've ended up with this: 
 

 
 
If I turn on this layer's visibility then we once again have solid text. 
 

 

Page 8: Bringing it all together

And then I'll turn on my first layer's visibility, and … behold… 
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Hmmm. Well that really isn't so great is it? :) Not to worry. Photoshop's Layer Styles will save us. Just start tinkering with adding various layer styles to each of the two layers. You could use any of the pre-defined styles or better yet make your own. Also try using differing blend modes to achieve nice looking effects that not only look good together, but actually work together.. Maybe add a white or black background layer underneath it all, and in just a few mouse clicks… 
 
That black silhouette shape above, can just as easily look like any of these: 
 

 
 

 
 

 
 
Here's an alternate shape of the text: 
 

 

Page 9: Final thoughts (& show-off sig)

And all of those pretty images are being defined by two simple vector shapes like these: 
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NOTE: In order to retain your vector shapes don't merge the layers, and when saving, save your original document in the native Photoshop format (.PSD) To make copies of the image suitable for the web or email, whatever, then use Photoshop's "Save for web…" feature to save a copy of the image as a .JPG, .GIF, or .PNG. But always keep your original document in .PSD format otherwise you'll lose all your vector data and your layers will get flattened to a single image. 

 
 
- Outpatient 
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Shaping Up  
A demonstration of adding shapes to an image.  

By Trinity-of-One  Paginated View 

In this tutorial, I'm going to show you how to edit the shape of an object using Photoshop!

Page 1 : The objective

OK, here goes. In this example, I'm going to take this - 
 

 
 
and finish with this - 
 

 
 
Here's how I did it. Of course, the standard disclaimer: This is not saying it is the definitive method, there are many ways to achieve the same result, this is just my way. 
 
I apologize to any non-Photoshop users out there, this is certainly possible to do in other programs but I don't know them well enough to make this tutorial 'multi-lingual.' 

Page 2: Starting out.

I usually make a copy of the background layer. It’s not essential but can be useful if you make an uncorrectible mistake. 
 

 
You can do this a number of ways, I usually drag the layer onto the New Layer icon at the bottom of the palette. Name this new layer Phone Body and hide the original. 
 
Next, make sure you're working on the newly created layer, select the Custom Shape Tool 
 

 
 
Choose any shape from the top toolbar (we'll use a heart for this tutorial). 
 

 
 
Draw the shape out of the menu. it’s best to find a plain white part of the image so you can see the shape properly. 
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Don’t worry about the size for the moment, we’ll deal with that next. 

Page 3: Bend me, shape me.

Select Free Transform from the Edit menu (CTRL+T on PCs). Move the shape over the top of the phone's screen. 
 

 
 
I’ve stretched the shape using distortion (hold CTRL when dragging the corners), this helps to match the perspective, as you can line the bounding box up with the phone’s own vertices. 
 
It looks a little odd at the moment, so grab the central handles and size it down to roughly match the size of the screen. 
 

 
 
When you have it at the size you want, hit Enter or the Tick in the top toolbar to set it. 
 
I recommend saving the new shape's path at this point, again, it's useful if you need to replicate it later on. 
 

 
 
Select the Paths Tab on the Layer Palette and clicking the arrow in the corner. You can call it anything, but Heart would be descriptive. 

Page 4: Attack of the Clones

We now need to make the shape into a selection. CTRL+Click (for PCs) on the Heart path thumbnail and you’ll get the ‘marching ants’ on your path. 
 

 
 
Now it’s time to blend the shape in. First you’ll need to invert the selection either by pressing Shift+CTRL+I (for PCs) or from the Select Menu. This will allow you to draw over everything that's not in the center of the shape. 
 
Select the Clone Stamp Tool. The size of the brush depends on the size of your image, so pick one that will give you good coverage but not be too cumbersome. Set the hardness to about 95-99%. 
 
Sample from a clear area and start brushing over the original screen image. You can freely go around and up to the edges of the shape as it is protected by the selection border. On this image, there is a slight tonal difference between the top and the bottom, so I selected areas from both ends to get a better match. It can be tricky to avoid ‘patches,’ so you may have to sample an area again to get rid of them. If you have Photoshop 7, you can use the Healing Brush (make sure that you have gone right up to the edges of the selection with the Clone Brush or you’ll find it will pick up the tones from the original 
image). 

Page 5: Cookie Cutting

Make sure you are working on the Phone Base layer and invert the selection again, so it’s only surrounding the shape. 
 

 
 
Hit CTRL+Shift+J (for PCs) or from the Layer Menu > New Layer > Via Cut. This removes the selection from the body of the phone, leaving a heart shaped hole. Name the new layer Screen Base. 
 
Reselect the shape on the new layer by CTRL+Clicking (for PCs) the layer thumbnail. From the Select Menu, go to Modify > Expand. Again, the amount is relative to the size of the image. It should be a few pixels larger than the original so I used 10 in this example. 
 

 
 
Move this layer down so that it’s underneath the Phone Base layer. Select a suitable color for an LCD screen (in this case I used Light Pea Green from the colour swatches). On the Edit Menu, choose Fill, set the Contents to Foreground Color, Mode: Normal, Opacity: 100%. Then click OK and you should have a nice green heart. 
 
With the shape still selected, select the Phone Body layer, click CTRL+J (for PCs) or Layers > New > Via Copy. Name the new layer Bezel. We’ll come back to this later. 
 
We will also need a couple of duplicates of the screen layer, so drag the Screen Base layer onto the New Layer icon a couple of times and rename them Screen Middle and Screen Top. 
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Your layer palette should look something like the picture above. 
 
You’ll notice that the screen looks too plain and flat, we’ll sort that out. 
 

 
 
Hide the Screen Top and Screen Middle layers and select Screen Base. From the Filter Menu, select Noise > Add Noise. Change the settings to match those above, it will give it the grainy LCD look. 

Page 6: Deep Joy

Most screens sit a few millimeters below the body of the phone, so let’s give it a shadow for some depth. 
 

 
 
First, select the Phone Body layer and using the Polygonal Lasso, draw a box around the heart, leaving a fairly wide border. Press CTRL+J (for PCs) to create a new layer from the selection and name it Shadow. 
 

 
 
Move the layer between Screen Top and Screen Middle.  
 
Double-click the layer thumbnail > select Drop Shadow and enter the values as shown. 
 

 
 
Your screen should look something like this. 

Page 7: Hi-Ho Silver!

OK, time to give the phone a bit of a feature. Remember the Bezel Layer we created a couple of screens back? Well, its time has come. Hide the Shadow Layer temporarily, so it doesn't cause a distraction. 
 

 
 
CTRL+Click (for PCs) its thumbnail to select it. Go to the Edit menu, select Fill and set Contents to White, Mode: Normal > 100% Opacity. 
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Go to Select > Deselect (CTRL+D for PCs) to remove the selection, press D to revert to the default palette, then go to Filters > Render > Difference Clouds and you should have something that looks like the picture above. 
 

 
 
Double click on the Bezel Layer icon or select Layer > Layer Style > Blending Options. You will get a dialog box like the one above. Select Bevel and Emboss and set the parameters accordingly. Click in each box to bring up the palette. The shading colors are as follows: 
 
Highlight colors are R=98:G=134:B=159 and the Shadow colors are: R=213:G=213:B=235. 
 
Select Contour and set the Contour Mode to Half Round > Anti-Aliased and Range 50%. 
 

 
 
Now select Gradient Overlay and set the parameters the same as above. 
 

 
 
After following these steps, you should have something that looks like this. 

Page 8: Almost there.

You could, of course, stop here but images like this always look better if they’re a bit more active, so let’s give it something to display. 
 

 
 
Select the Screen Middle layer and then choose the Text Tool. For this image I set the text attributes to regular, 88px and crisp. The colour is black (obvious really). 
 
The envelope is from the standard Windows Wingding set and corresponds to the asterisk (shift 8), the text is Hattenschweiller but any font could be used. 
 
Once you have the text the way you want it, click the layer entry in the palette, this sets it down and will allow you to move, rotate and stretch the text using the Free transform tool we discussed earlier (CTRL+T for PCs). 
 

 
 
You may notice that even though it has been rotated, it still doesn’t look quite right, this is because of the perspective of the phone. You can’t distort text while it’s in this state, so the next thing you need to do is make it a Raster Layer. This is done by choosing Layer > Rasterize > Type. You can now distort it the same as normal image layer using the different transform options listed with the transform tool. 
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Again, lining up can be tricky, especially as the text is quite small and there isn’t much of an edge to go by, I used the same method as I did with the original heart shape of stretching it out to line it up and then sizing it back down again, once I’d created the distortion. 
 

 
 
Set the opacity of the text layer to about 60%, this will take the ‘boldness’ of the text away. You may also want to add a little shadow (which can be seen on some LCD displays) for added realism. To do this, select layer blending and use the default drop shadow settings. 
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Smoking with Photoshop  
Also works for fog and mist effects  

By Jolt  Paginated View 

How to create realistic smoke effects.

Page 1 : Summary

I'll show you how to go from this.... 
 

 
 
...to this..... 
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...all using Photoshop 7's built-in features! 

Page 2: Layers

Open your image in Photoshop. 
 
Create a new layer above the image. 
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Set your foreground color to black and your background color to white. (You can do this by simply hitting the d key on the keyboard.) 
 

 
 
Now, hold down the option/alt key and choose Filter - Render - Clouds from the menu. 
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Holding down the option/alt key forces the clouds filter to have more contrast. 
 
Your image should look like this.... 
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Your clouds may look a little different but they should cover the entire image layer. 

Page 3: Blending

From the layers palette click and hold the styles icon (little script f thing) and choose "Blending Options" from the popup menu. 
 

file:///C|/Worth1000/42.htm (5 van 10)13-6-2006 23:18:16



Worth1000.com | Photoshop Contests | Are you Worthy™ | tutorial

 
 
The Layer Styles dialog will appear. At the bottom of the Layer Styles window there are two sliders. You are going to adjust the top slider to make the black in the clouds layer disappear. 
 
Hold down the option/alt key and click near the left triangle in the top slider. The triangle should split into two parts. Move the right part of the triangle to the right similar to the image below. 
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You should now have an image similar to the one below. 
 

file:///C|/Worth1000/42.htm (7 van 10)13-6-2006 23:18:16



Worth1000.com | Photoshop Contests | Are you Worthy™ | tutorial

 

Page 4: Finishing touches

Now you've got big white blobs of smoke, let's refine them. 
 
First thing at this stage is to lower the cloud layer's opacity just a bit. 
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Now we'll need to get rid of some of the blobs of smoke. 
 
From the layers palette add a mask to your clouds layer by clicking the mask icon at the bottom of the pallete. 
 

 
 
Click the mask, so you are certain you are working on the mask and not the actual clouds. Grab a brush, any brush, make sure your foreground color is black and start painting away parts of the smoke you don't want. 
 
Here you can see how the final mask looked for this image. 
 

 
 
Once you've painted away all the unwanted smoke you should have a pretty natural appearance. 
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The final image.... 
 

 
 
I hope you've enjoyed this tutorial as much as I enjoyed writing it! 
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Making a Web Photo Gallery  
For Photoshop 7 users  

By N-Design  Paginated View 

So you're ready to display your images online? In this tutorial, I'll show you how to make a html photo gallery using Photoshop 7, for display on the web.

Page 1 : Create the folder

Ok first things first, make a folder and put all of the pictures you want in the gallery into it. For my example, I made a folder called "drawings."  
 
Then create a folder for where you want the thumbnails and webpage for your gallery to end up in, such as "web gallery." 
 
Now open up photoshop and go to File > Automate > Web Photo Gallery. 
 

 
 
You will then see this screen come up: 
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Page 2: Pick a gallery style

Pick what kind of style you want your gallery to be, For this example, I chose "table." 
 

 
 
Then if you want you can put your email (it will be displayed at the top of the web page) and pick your file extension to use (I used .html as that's the most common type of page found online). If other pages in your website are different you might prefer to match the gallery extention to 
it.  
 
Now choose the folder that you created in the begining of the tutorial. 
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Then choose your destination folder that you created in the begining. 

Page 3: Gallery options

Next you will see the gallery options wizard. In the drop down menu select "Banner." 
 

 
 
Create a name for your gallery (I used "Samwise Didier Illustrations") and fill out all relevant fields, customized with your information (i.e. Photographer,Contact Info, the date, font face and size). 
 

 
 
For the other options such as Large Images, Thumbnails, Custom Colors and Security we'll leave at the default settings. 
 
Press "OK" and then you will see the process of the images opening and being reduced to thumbnails. 

Page 4: Uploading to the Web

Now upload all of the folders and files that you created in the destination folder to your website. 
 
[EDITOR'S NOTE: We won't explain how to upload to a webhost as this tutorial is really for those of you who already have one. Worth1000 will have web hosting shortly and we'll include a tutorial on uploading to it then. ] 
 
To view your gallery online go to your browser and reference the gallery you just added. 
 
For instance, if your website is: http://n-design.worth1000.com/ 
 
and you uploaded the folder "drawings" to your main (root) directory, you would access it by going to: 
 
http://n-design.worth1000.com/drawings/index.html 
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A webpage with your gallery and images should open up. Here's what mine would look like: 
 

 
 
Obviously more advanced users can manually edit the index.html page more to their liking so it looks more professional, but this automatic generation can really save you a lot of time. 
 
This is my first tutorial and I hope you thinks its helpful. If you have any questions, email me. 
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How I draw anime  
A quick guide to anime facial structure and detail  

By i_heart_anime  Paginated View 

This tutorial will show you how I draw anime-style hair eyes and basic head structure.

Page 1 : Introduction

Hi and welcome! Thanks for coming and taking a peek at this here tutorial. Now get comfortable, grab a pen and paper, a drawing tablet or your mouse and let's draw a head! 
 
Disclaimer: I'm just showing you how I do it. There are certainly other (and possibly better) ways of doing it. Please just accept it as one way of drawing anime. 
 
Also, this is not a tutorial for beginners so you'll probably need basic or better PhotoShop, coloring and imagination skills before attempting this tutorial. 
 
Let's proceed... 

Page 2: Structure

First we'll tackle 'Structure' 
 
We'll start with our working lines. A good start is a circle (diagram.1). So draw a circle. 
 

 
 
Now draw a line where you want the center of the face (i'm going to call it the "noseline") down the middle, I've offset mine to the right and curved it around as if it were a ball, but instead of wrapping around the bottom, I've continued straight down so the noseline drops to around where the chin should be. 
 
Then draw a second line around the center, like the equator, for your eyeline. 
 
Now lines from the eyeline where the ears go, about halfway around the ball (diagram.2) 
 
Okay, draw rough outlines of ears from the earline back. Now add a jaw from just below the ear to the chin point. 
 
Note: You should be able to see the proper shape by now so if you drew your chin point too high or too low you'll probably notice it and can correct it.  
 
Now do the same on the other side of the face: from earline to the chin. 
 
I'm not exactly sure how I put the eyemarks in, I more or less guessed, but take a look at diagram.3 and guess too. 
 
Now you should have something that looks like diagram.3. 

Page 3: Features

Now erase the equator eyeline, noseline and earlines, Don't erase the eyemarks (shown in red) and you could have something that looks like this or better. 
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Now on a new layer draw the features in. I always start with the head outline, then the top of the eye, the lower lid, nose mouth and ear in that order. I'm using the same features I used for Yumi but heres some examples of anime-bits you can test out. 
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Now get rid of the bottom layer or completely erase the original pencil. 
 
Add pupils, eyebrow lines, ear details, lips and now you should have lines ready to be tidied up and detailed. 
 

 
 
Now turn the opacity on this layer down to around 20% 
and on a new layer, or your pen start drawing the facial features one by one. 

Page 4: Eyes

Let's start with the eyes. 
 
Here's a step by step of this type of eye. 

 
1.  Draw the lash line or the eyelid in, Thicken it, with girl eyes I like to do that pointy sticky out bit. 
2.  Pupil and Iris, semi circle iris and quite a big pupil. 
3.  Erase a circle near the left of the pupil, this is a shiny effect. and fill in the sides of the iris. 
4.  Draw in an eyebrow and a small line above the lashes about one third the length of the eye in the centre. 
5.  Add any details you like, I added a second shiny thing, and some random lines inside the iris.
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Now do exactly the same thing, backwards for the other side, except put the pupil in it's proper position, and don't mirror the iris pattern. 

Page 5: Adding nose, mouths and ears

Okay, Get rid of the eye working lines underneath and maybe you'll have this exact image (hopefully): 
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Now add a nose, mouth and ears. They're pretty straightforward - just tidy up the lines you have already have. 
 

 
 
Line the jaw and neck in. Necks can be skinny, fat, muscular or made up of two lines. Just draw lines until you are happy with neck width and length. 
 

 

Page 6: Hairstyle time

Anime means awesome frikkin hairdos! 
 
Go crazy on hairstyles - spikes, shorn, flowing metal, etc... Just make sure you don't cut into the head. Keep your major outline outside of the head, unless you really insist your character look stupid. 
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I chose this sort of Style for mine: 
 

 
 
It's all swirly fringed and spiky sided.  
 

 
 
I chose a lightish skin, blue hair and green eyes. Just color like you used to do when you were 7 but better. I normally use a New Layer set to Multiply when i colour, I have no idea why, but it only works on a white background, also it's easier to just use a new layer underneath the lines. 
 
Now erase all the mistakes you made and slap yourself. 

Page 7: Shading

The next thing I do is shadows and shading. I do a cheap style of cel shading where I make a new layer above everything 'Color, Lines' and turn the opacity down to around 25% then I use a black brush and draw where I think needs a shadow. (BLACK) 
 
Then I make a squiggly line across the hair in white on the same layer, although you may want it brighter. 
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using the same sort of ball/skull shape. I draw another little shiny thing on the bottom lip and maybe half the of the iris. (WHITE) 
 

 
 
Now draw these lines under the eyes. I don't know what they are, but include them anyway. 
 

 
 
Then on a new layer I add a little blush and lip color by putting a bright pink splotch (with a large softened brush) on the cheeks and carefully line the lips. Then I turn the layer into a multiply layer and fade it to around 20%. 
 
Finally, add a pattern in the iris (perhaps a squiggly, perhaps a moon, perhaps a squiggly moon), add a second layer of shadow and whatever accessories you want - Glasses, Goggles, Face Hair, Piercings, etc... and you're all set! 
 

 
 
That's what I got, what did you get? show me!!  
No really! show me!! Email it to me at i_heart_anime@hotmail.com! 
 
I hoped this helped and you got the idea of what i was trying to do. Have fun and practice those eyes and hair - they are the base of all cool anime! 
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Yet Another Colorization Tutorial  
Colorizing Using CMYK Adjustment Layers  

By Elysium  Paginated View 

Variety is the spice of life, and with that in mind, I offer you yet another colorization tutorial. This one uses a different method than either of the previous tutorials (CMYK curves adjustment layers), one that I feel is slightly easier than either of the other two methods while still acheiving good results. This tutorial is for PS7, as I have no working knowledge of PSP (sorry). I also use PC, but it is nearly the same on a Mac.

Page 1 : In the Beginning

After this tutorial, you will be able to turn this: 
 

  
 
Into this: 
 

 
 
As Cyn mentioned in her primary colorizing tutorial, the key to a good result is in a good clean source image. The cleaner and better resolution the original source, the easier it will be to work with and the better it will end up. Take particular care to avoid images with large blown out white sections, as these will never look right in the final image. The original I used above was around 2000 x 2000 pixels. 
 
The nice thing about this method is the nature of adjustment layers themselves, you can always go back and change them, messing around with the colors as much as you want until it finally looks right. It also incorporates the layer mask right into the adjustment layer, so you can clean up your selection edges as you go along. It also doesn't require any pre-selection of colors as in Steveo's tutorial, or blending of colors into one another as in Cyn's (though both are excellent methods). 
 
Don't forget to save early and often. Colorizing is time consuming, so it really hurts when you lose alot of work... 
 
Now let's get cracking... 

Page 2: Cleaning Up

The first thing you should do with any image is clean it up. Dust, scratches, and uneven tones all need to go before you start working on it.  
 
Use the clone brush to get rid of defects, and in some cases the healing brush can be used to add texture to blown out areas. The uneven tones will be taken care of in the levels. It's not required to do any of this, but it will definitely help out your final product. If you're not experienced with levels, this might be slightly confusing, but once you know your way around, this step only takes a couple seconds. 
 
With a colorization, levels are extremely important. Levels can be found under Image -> Adjustments -> Levels. 
 
The levels of my original photograph looked like this: 
 

 
 
See those low areas to the right and the left of the "mountain"? By bringing in the little arrows on the right and left (which represent light and dark values) towards the main mass, you will acheive a much better distributuion of values. It should look like this before you click ok: 
 

 
 
Before and after levels: 
 

  
 
You can also just use auto levels, but that won't always give you the results you desire. By tweaking the levels by hand you can select just how you want your image to end up. You don't have to put the markers exactly where I did, just play around with them until it looks right to you. The middle arrow is the mid tones, which can be adjusted as well. 
 
After you've done all this, go up to image -> mode -> CMYK color. THIS IS IMPORTANT. It won't work if you don't do this, so don't forget. 

Page 3: Selection and Quickmask

Now that you have your cleaned up image, it's time to get to work. What you need to do now is select an area to color. Just pick one (hair, skin, background, etc.), it doesn't really matter what order you do it in, you will get to everything eventually. For the purposes of this tutorial, I'll start with the skin.  
 
Using whatever selection tool you desire (I personally just use the polygonal lasso) select all of the skin in the image, making sure you subtract things like the eyes and mouth. If you have a Tablet this step is probably much quicker. Get it close, but don't worry about getting it exactly exact, we will take care of the rough edges in a second. 
 
Your selection will look something like this (over the whole body of course): 
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Now go into quickmask mode by hitting the circle-in-a-shaded-square icon in your toolbox (or just hit q). This will turn anything that you didn't select pink, and your brush palette will turn to white and black. Now you can edit it just like any regular mask (white brushing reveals, black takes away). The first thing to do is get rid of the rough edges by applying a Gaussian blur to the quickmask (usually around 5 pixels, but play around). You might want to apply some selective gaussian blurring to areas where the skin mixes with another element such as hair, to give it more of a fade instead of a harsh line. Then go around with your brush tool fixing any overlaps (the only thing that should not be pink is the skin). 
 
It should look like this: 
 

 
 
Hit q again and it will become a selection again (but smoother and with some feathering). You can choose to just select the entire thing in quickmask mode, but I find it faster to do it this way. It's a good idea to save this selection as a channel, in case you need it for something later. Leave the selection up. 
 
Now for the coloring... 

Page 4: Adjustment Layers and Curves

Now that you have your skin all selected, and your in CMYK mode (you are in CMYK mode right?), it's time to color. 
 
Make sure your original layer is selected (it should be the only layer right now) and your skin selection (from page 3) is still up, and go up  
 
to Layer -> New Adjustment Layer -> Curves 
 
Name the Adjustment Layer "Skin" and click "group with previous" 
 
This will bring up the curves dialog box, and it will add a layer to your layers palette: 
 

 
 
This is where all the magic happens. As I mentioned before, since this is an adjustment layer, you can always go back and edit it by simply double clicking on the curves icon in your layer palette. The black and white image to the left of the curves icon is your mask layer, which can also be edited (if you need to reveal more or less skin for some reason). 
 
By adjusting each color curve individually, you will add color to your selected area. Now you can memorize exactly which values of curves give you what color, or you can just play around and eyeball it (what I do). Raising the curve up and to the left gives you more of a color, and down and to the right less. You can also add points to the curves, and tweak the highlight and darks to be different hues, but for now I'll just keep it simple, with one point curves. 
 
This is what my curves looked like after messing around and eyeballing the skin tone: 
 

 
 
You can also adjust the Black levels the same way if you want your shadows to be darker, and the combined CMYK curve will adjust the brightness and darkness of the entire range. 
 
Click OK, and your image should look like this: 
 

 

Page 5: Wash, Rinse, Repeat

Now your task is clear, the same technique is used for every other object in the picture (with different curves of course). So I'll just quickly run through the rest. 
 
Next I'll do the background. Same technique, select, quickmask, blur, edit, reselect. 
 
Once again, Layers -> New Adjustment Layer -> Curves 
 
Your curves dialogue will come up again. I wanted a blue color, so I raised the cyan up alot, raised magenta a little and dropped yellow a little. I also wanted it to be lighter, so I dropped the CMYK curve down a little. I actually used multiple point curves, but I'm keeping it simple. 
 
The curves: 
 

 
 
Result: 
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Page 6: More of the Same

Next step is hair. New Adjustment layer, etc. It looked like brown hair would work the best based on the original, so I went with that. Raised magenta and yellow up, some small tweaks to cyan and CMYK, raised the black a little. I have no formula for colors, just keep messing around until it looks good. And remember you can always go back and edit it later. 
 
A key point with hair: When you have whispy hair that partially covers skin or background or whatever, you will want to go to your mask layers and use a the brush tool to work with the layers until you have no overlap. You can also selectively blur, smudge, and use greytones in the mask. You want to avoid color overlap, because it creates an obvious line of color across a section of your image and makes it look bad. 
 
A note about eyebrows: If they have black eyebrows, you can just color skin tone right over it, otherwise, color it the same as the hair and make sure you have no skin tone/hair color overlap. 
 
Getting close: 
 

 

Page 7: Eyes, Lips, Clothing, etc.

Finishing up coloring all the main objects, same technique of course. Always add a new adjustment layer for each item. 
 
Eyes: I lost some points in the last colorizing contest for having too bright and saturated eyes. Look at some reference pictures when deciding on colors. 
 
Lips: You can make them look like they have lipstick or not depending on the amount of colors, overall brightness, etc. If they have teeth, don't just leave them black and white, give it a light cream color. 
 
Clothing: In my particular picture it was a black dress, so I raised the black levels up a little to avoid some grey sections. It's usually a good idea to raise the black levels up when doing clothing, or any black area just become a darker tint of whatever color you make the rest of the clothing. 
 
Jewelry: Instead of just leaving it B&W I gave it a blue tint, and raised the black levels to give it a more 3D look. 
 
Now you are almost done: 
 

 
 
But wait, there's more... 

Page 8: Tweaking the Final Result

For this image, I added two new (regular) layers and put them on top of the original. One I set to overlay mode, and painted in some pink/red highlights on the cheeks, bridge of the nose, chin, and forehead, then lowered the opacity until it looked good. I also added a small white gloss layer to the lips. 
 
Your final layers look like this: 
 

 
 
The original on the bottom, your two tweak layers, and one adjustment layer for every item you colorized. 
 
Your image is now fully colorized. If any colors look off, simply go back into the curves and change them. I would suggest leaving it for a couple hours, and then coming back to it for some more editing. It's amazing how your perception can change once you haven't been staring at it for a while. It's also good to get some outside opinions. 
 
Done at last... 

Page 9: Final Thoughts

Your final work should look something like this: 
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This may seem complicated, but it's really not. All it boils down to is selecting a part of the image, moving some curves around until you get a color you like, and repeating. It's all about trial and error, everything in your .psd can be edited if you don't like how it turned out, tweak a color here, add some yellow there, it all just boils down to your eye for color. 
 
It's actually quite simple stuff. This was my second colorization ever :) 
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Blend Mode, Layers, and you...  
(Thank god I don't write snappy titles for a living)  

By IronKite  Paginated View 

In this tutorial, IronKite reviews the usefulness of 'Blend Mode' for individual layers in an effort to allow a figure blend into its new environment.

Page 1 : The Challenge

Adjusting values and hue: Hoaxing difficult photos 
 
Well, it’s been a painfully long time since I wrote a tutorial, and I’ve been extremely busy as of late, but I figured I would try to come up with a different angle for something which I hold near and dear to my heart: Hoaxing. 
 
One of the best reactions you can get as a chopper are the words “Is that photoshopped, or is that a real picture?” As you are all aware, making something look like it’s part of a picture it’s been inserted into is far from easy. When it all comes together it makes your heart sing, and you go back for a second look. (Ah, who am I kidding? I go back for about 20 looks, after showing all my friends and relatives. They all hate me now, my chops are now receiving the same treatment as vacation slides…everyone runs!) 
 
So, I thought I’d do a step by step for a project I’m currently working on, putting an individual in a suit (full color) into a tinted photograph, and making it look as realistic as possible. (Or, as realistic as time will allow.) 
 
Here are the pictures: 
 

 
 

 

Page 2: Is he insane?

Ok, so the pictures are pretty different, I'll grant you. Still, we'll try our best. 
 
Ok, first step is to cut and paste, and then free transform. Grab your subject with the lasso (rough is fine, don’t try to trace him exactly) and paste into the image. Resize using Free Transform (Control-T) and make sure you have the ‘constrain proportions’ button on when you’re resizing him to the size you want. There’s nothing worse than seeing a pasted element that was reduced 20% in one dimension but 40% in the other. You don’t want that, unless you’re trying to hoax someone into the final credits of an old James Bond movie. You know, the ones where they squish the entire movie screen into television format and everyone looks really really tall? 
 
Errr….never mind. 
 
So, I’ve pasted, and resized, and here’s what I’m left with: 
 

 
 
Errrrr….uhhhhh….yuck. This is a travesty, right? Would get flagged within seconds if I entered it as is. Let’s fix it up, shall we? 

Page 3: I dunno about this...

The first thing I’m considering is whether to put him in the foreground or background as far as the principal is concerned. I’m thinking background, not only because there is a much better visual dynamic that way, but because it conveys an appropriate sense of menace for what I want here. The gangster looking guy standing behind someone while looking scary is just one of those scenes that happens in movies all the time. So, let’s do that. 
 
That decided, we’ve obviously got to get rid of some of this guy. To his credit (and he has my everlasting thanks) arsidubu’s tutorial regarding how to use layer masks is great, and it finally made an impression on me. I now can’t imagine using anything else. So, instead of re-explaining it here, go read it so that you understand how layer masks work and then assume that I used them. We’ll remove the areas of the gangster that should be behind the principal, and we’ll get rid of that nasty cut and paste halo while we’re at it. 
 

 
 
There. Much better! Well….not really, it’s still a travesty. But, we’re not done yet! On to step 3! 

Page 4: M

So we’re attempting to put this really bright and colorful fellow into a tinted photo, monochromatic. I guess we won’t be needing all that color right now, just the tones. A quick desaturation of the layer he’s on, and poof: 
 

 
 
Next, we’re going to try to match the tint of the photograph as closely as possible. Yes, it would be easier to desaturate the entire thing and then tint it using photoshop, but sometimes you won’t have the option. The whole point is you need to find a way to make the pasted element look like it’s part of the existing photo. 
 
So, what we’ll use instead of the cheap quick ‘n dirty method of Flatten – Desat – Run Adobe Sepia Filter, is something which has saved more chops than I can count. ‘Blend Mode’. Specifically, we’re going to start by using the ‘Color’ blend mode on a new layer and see where that takes us. So, we’ll start by simply creating a new layer on top of everything. 
 

 
 
Now what I’ve done to this blank layer is I’ve changed the properties associated with it. It is no longer simply a layer I can put stuff on, but it actually changes and interacts with the characteristics of the layers below it. Changing a layer’s Blend Mode results in layers where you can make specific changes to a portion of your image without actually modifying your original image layers. This is extremely handy, especially when you’ve spent 30 minutes trying to tweak your image, you give it up as a bad job, and you decide you want to start over with how it looked 30 minutes ago. The action history in Photoshop 7 is big, but not so big that it keeps track of every stroke of your stylus for 30 minutes at a time. Some changes you just can’t ‘undo’. 

Page 5: Looking better...

Ok, we’ve got the new layer, and it’s Blend Mode is set to color. What I guess I’ll try to do is sample some of the colors from the original image and paint them onto the new layer. What the ‘color’ layer does then is take whatever color you’re painting with and adjusts the color of everything below what you touch your pen to. So, we’ll use a medium brush, fairly fuzzy, and paint away. 
 

 
 
Wow, that helped tons, didn’t it? He’s only about 1/3rd of the travesty that he was. He still looks out of place, but at least the reason for that isn’t color. 
 
What I ended up doing was grabbing a patch of color on the ceiling and painting over him completely. Then, because the color was too vibrant on the skin tones (the color layer doesn’t compensate for it, all it knows how to do is color) I sampled the skin tone of the principal in an area where he was gray-ish. If you mix gray with the color you’re using, the effect is the same but the overall saturation is lower. This was what I wanted, and it looks like it worked. You can have the sampled color as dark or as light as you want, it doesn’t matter. This layer will not affect the tone of your image whatsoever, only the color associated with it. All tonal values stay the same. 
 
Next, we have to do something about the light/dark contrasting problem, because he’s both a little too dark and a little too light. I don’t want to do anything with Levels or Brightness Contrast though. Why not? Well, I want to show you just how versatile Blend Mode is….plus, I already tried adjusting the blacks to a lighter shade, and they turned pinkish magenta. Reeeeeal ugly. Complete 70’s puke-o-rama, I’m not even kidding here. 
 
So, we’re gonna make another layer and tinker with Blend Mode, and this one’s going on top of the first one. This time we’re going to set it to ‘Lighten’ 

Page 6: Not bad...

So, we’ve got the ‘Lighten’ layer happening. What I think I’ll do is sample the darkest thing I can see in the Principal picture, and that will be ‘black’. When you paint on the ‘Lighten’ layer, it does the same thing as the Color layer, except (gasp!) it lightens things! Yes…not just that, but it lightens those things by changing the tone and color of those things based on the color you’re painting with. If I were to paint with light blue, then everything darker than that shade of blue would be painted blue. Anything that was equal to or lighter than that shade of blue would remain unchanged. This is hugely advantageous, because it means that we don’t have to be extremely precise when applying the paint, we just have to smear it over all those areas we want to lighten. In this case, we want to lighten all of the darks on the gangster guy. I’ll paint over his suit, glasses, hands, and everything…and I’ll use a big brush to make sure I’ve got all those areas covered properly. 
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As you can see, we’ve taken the darkest areas of the gangster and changed their shade/coloring to that of the darkest elements in the photo. So while the tone is lighter than it was before, as far as the picture is concerned he’s still wearing black. Black is always relative within the picture itself…there’s nothing more disheartening than seeing that someone has put a fantastic chop together, but the ‘blacks’ on the inserted image are way darker than anything else in the photo. It usually only takes a few minutes to touch them up, but those few minutes make a huge difference. 
 
Next we’ll do the same for those areas that are too light. I wonder what I could use to fix that… 
 
What? Use a “Darken” layer? Why…that’s brilliant! And it’s just wacky enough, it might even work! 

Page 7: Just a little more

 
 
Ok, so I did a little something you couldn’t see. I grabbed a sample of the white shirt on the Principal and used that as my ‘darken’ color, painting over all of the highest contrast white sections on the ganster I wanted to blend. What I also did was grabbed a slightly darker version of ‘white’ off of the same shirt, and painted it on the left hand side of him. Why? Well, if you look at the light source for Principal’s face, it’s coming from the right. We’re going to have to emulate that kind of shadow, and soon…we may as well start now. 
 
So the darks are light enough, and the lights are dark enough. We’ve got color matched, more or less, the size is ok. We need shadows on the face. Here’s where we get sneaky. 
 
One of the common ways of doing this is using the Burn tool. Don’t. Please…when doing close-ups of faces or other object in the picture, just don’t do it. When using it on large areas of skin or when trying to apply it evenly over a large section, it just can’t help but look like a Burn tool mark trying to look like shadow. That’s not what you want. Small areas, minor fixes, by all means….it’s a wonderful tool for that. But changing the lighting on someone from front/top to front/side? Just say no. 
 
What we’ll do is we’ll take our original gangster guy and duplicate the layer he’s on. We’re gonna turn HIM into a ‘Darken’ layer. (Oh…izzat so now? Howz about, I turn YOU into a ‘darken’ layer? Huh? Would you like that? Do I amuse you?) 
 
Hey hey, calm down Guido. This won’t hurt a bit… 

Page 8: Done.

Ok, layer is duplicated. We’re going to go into Image – Adjust – Layers for this one. We’ve got all the differently blended layers above it taking care of the lights and darks, but what we need to do is take the entire image of this guy and make him darker, mid-tones especially. We’re essentially trying to make him look like he’s entirely covered in shadow, because shadow is what we’re trying to create. Once he’s dark enough, change the layer to ‘Darken’ as well. There should be no change in the tones of what you see when you make this change, but we want to make sure that this layer will only be making things darker, and that we’re free to make any adjustments we want without fear of screwing up the lights or mid-tones that are already there and working. If when tinkering with levels we made part of him brighter by accident, it will not show up. 
 
Once the entire new gangster layer is darkened, use the mask that is already there from the first one (yes, duplicate layer does duplicate the entire layer, masks, properties, and all) to erase the half of him closest to the window, showing the light copy of him underneath. You’re essentially ‘drawing on’ light, but not using any destructive tools like Burn or Dodge. This way, you’re taking all of the subtle nuances of tone and making them all brighter or all darker the same amount. Much more realistic. There are better ways, but this works fine. 
 
So, use your artistic eye and erase the dark in just the right areas. You may notice that erasing in a certain area does nothing. Well, that just means that the different blended layers above the layer you’re working on are doing their job. You can’t see everything that’s darker about the image because you have the ‘lighten’ layer doing its thing up above it, and same with the ‘darken’ layer. So, just erase where you think light should be, and don’t worry about the lack of effect. 
 
As it turns out, we got much of the effect we were looking for with a few quick strokes. 
 

 
 
The only remaining details involve your standard hoaxing stuff. Blur where it looks like you should blur, or if there’s a blur effect over the entire image use the blur filter and balance it with the Edit – Fade Blur command. But aside from a couple of minor corrections, we’re looking at finished product. Nothing terribly wrong with it at first glance, fairly passible. 
 
There are other Blend Modes you can use, and I use them all. I’d show them to you, but it’s getting late, and I’ve got some more chopping to do.  
 
Ah, who am I kidding? I’m going to bed. I’m getting old… ;-) 
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How to model a wineglass in 3D  
This is in Maya, but this technique can be used in other programs  

By KittyLitter  Paginated View 

This tutorial shows how to use Control Vertices to model a flowing wineglass shape.

Page 1 

First off, you need to switch to your side view, because that is where we will be outlining the cross section of the wine glass. I recommend shifting the camera so that the origin (0,0,0) is near the bottom of the screen. 
 

 
 
Now go into curve drawing mode (in this case, CV tool) as shown by the first arrow in the next picture. After that, tell the computer you want to "Snap to Grid," as the second arrow shows. This is so when we rotate this curve later there will be no holes in your glass. 
 

 

Page 2

Simply draw HALF of the outline of a wineglass... Make sure that your line starts *and* stops along the Y-axis!!! You can't really tell in this picture, but I started my line at the origin. 
 

 
 
Once you have drawn your wineglass outline, and are happy with your results, switch to modeling mode in the drop-down box near the upper left corner of the screen. 
 

 
 
Make sure the outline is selected, and from the menu choose "Surfaces -> Revolve []" Make sure you click on the little box, instead of the word "revolve." We want to edit the options for this command! 
 

 

Page 3

The window that pops up should look like what you see below. We are going to rotate the wineglass outline you just made around the Y axis (the up-down axis) in order to create a solid piece of geometry. Make sure the "Y" axis is selected, and increase the number of segments to 72. You need this to be a relatively high number so that the glass is smooth and round. Basically, it will be duplicating your outline 72 times, rotating it just a little bit each time. Then it will connect all the outlines together to form one object. When your little window looks like the one below, click the "Revolve" button! 
 

 
 
Voila! You now have a solid wineglass! If it looks blocky and chunky in your perspective mode, just select the wineglass and press the number "3" to switch to high resolution NURBS mode. 
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Page 4

Here it be, in 3D, G. 
 

 
 
 
 
And here's a final rendering of it, with a glass texture placed on it for good measure... 
 

 
 
Any questions? Message me 
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Primary Colorizing  
Colouring black and white images using red, blue, and yellow  

By CardinalCyn  Paginated View 

Because I have been promising to do it for months, and I finally got around to taking some screenshots while explaining it to someone, here it is. It works in either PaintShopPro or Photoshop, and I can't imagine why you couldn't do it in any image editor that supports layer masks, because that's pretty much all you need. It's very easy, once you get the hang of it, and imo, produces more lifelike, realistic results than colouring each object separately does. 

Page 1 : Find it

We're not going to colour an entire image, instead, I'm going to take you from this: 
 

 
 
to this: 

 
 
(larger, cropped version here) 
 
but you can easily apply everything in this tutorial to the entire image later once you've got got the gist of it- that's the beauty of doing it all in mask mode. Masks. Sigh. I love them. 
 
First step- find great source. I don't always follow this rule myself; I have a thing for very old, fuzzy, damaged images that I can waste a lot of time restoring first, then colouring in dreamy, over-saturated jewel tones, just for fun and prettiness, but I can guarantee you a more believable result and a higher rating when you start with a large, undamaged, high resolution, even-toned source image. Your lo-res labours of love will generally tank in an actual contest, even if they are beautiful. Law of the jungle, baby.  
 
Here's a large copy of the image I used for this tutorial, if you'd like to follow along. It's from a lovely old movie called "Shopworn Angel". 
 

Page 2: Dupe it

Make sure that you increase the colours to 16 million, if the image is not already there, and duplicate your background layer. Rename the new layer "blue". Lower the contrast just a smidge on it. You won't need to do this with every image you colourise, but in this case, to get even coverage, we should. Just trust me. Now, in PSP, under Colors>Colorize, change the hue of the entire image to a nice fairly true blue. In PS, you'll do this under Hue/Sat, by checking the colorize box. 
 

 
 
Add a mask to this layer, in PSP, by going to Masks>New>From Image>Any non-zero value; in PS by clicking the lil circle in the square mask icon in your layer pallette.  
 
Next, you'll set the layer properties for this layer, or blend mode, to "color". If you've never done this before, find the place in your layer pallette that reads "normal", in either program, and change that in the drop down to "color". It should look... well, pretty much the same. Again, just trust me anyway. 
 
 
Now duplicate this layer. Call this one "red". Under Colorize, or Hue/Sat, change it to a rich red. To get the saturation about right, find the features in the image that will be the most red, in this case, her lips, and get them as red as you want them to finish as, even a bit moreso: 
 

 
 
Turn the opacity down to about 90 %, and dupe it. Call the new one "gold". Under Colorize, or Hue/Sat, change it to a golden yellow.  
 

 
 
Make sure the opacity is at 90 %. 
 
You should now have four layers, the top three with masks- Background, Blue, Red, and Gold. 

Page 3: Blush it

Turn off the gold layer, so that you see predomininantly red, and switch to the red layer. It's time to edit our mask, so, in PSP, go to masks>edit; in PS click the mask icon in the layer pallette. Both programs should now be showing you a colour pallette containing only values from black to white. 
 
Fill your entire mask with a medium grey value. You should end up with a purple grey colour, like this: 
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Now, zoom in on the eyes. Using a small airbrush in black, mask all the red colour out of the eyes. They should be very blue. Then, switch to white, and using a very small airbrush, draw around the inner rims of the eyelid with it, to show more red in that area. Do the same to the lips. Now pick a larger, very soft brush, at about 10 % opacity, and brush in more red, as if you were applying blusher, around selected contours of the face. Chin, cheeks, nose, a bit of forehead, keeping edges soft. Use a smudge tool at 50 % strength to blend the edges if you need to. Softening the mask with a point or two of gaussian blur works well, too. 
 

 
 
Looks weird you say? 
 
Yeah, yeah, just trust me. 

Page 4: Gild it

Now, turn your gold layer back on, and switch to it. Make sure you are in mask mode, and fill the mask with a dark grey, which should leave you with just enough gold to turn your purplish image to an over all taupe (greyish brown) colour, with the areas you edited in the red layer showing through it a bit more: 
 

 
 
Now, using a very light touch- a large, soft, 5-10 % opacity brush, softly spritz the face and hair with light grey, to bring up more yellow in a fairly even layer. It will be too yellow in some places, that's ok, you can take it back out by sampling some of the untouched mask and using that shade of grey to take some back out. You can use a small soft brush in black to remove nearly all the yellow in the lips, but don't remove it entirely from most skin areas. The idea is to let the red tone show in some areas more than others, allowing the colours in all the layers to show through at least somewhat in the skin.  
 

 
 
Using a smaller airbrush, in darker grey, brush along the highlight in the center of the nose, just under the eyebrows, and at the top of each cheek bone, where skin is naturally more delicate, bluish and not as robust looking as say, the apples of the cheeks. Using still smaller brush, remove much of the yellow from the rims of the eyelids, as well as the bottom 3/4ths of the iris of the eye. If you find that the white of the eye is too yellow (it should be just about right as is) you can remove a bit more yellow in the white as well, to make it more bluish, but if you remove all the gold tone from the whites, it will look decidedly fake, so do leave some in to tone down the 
blue.  
 

 
 
Now it's clean up time. Sample an untouched area of the mask, and use that shade of grey as your clean up colour. Zoom way in, and remove any yellow over- spray from the face and hair that have gotten into areas that should still be taupe/grey. Since I opted to leave Jimmy grey in this image, that should include his hand, which nearly covers hers.  
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Page 5: Tweak it

Once you've got your mask on the gold layer neat 'n tidy, switch to red, and make sure you are in mask mode. We need to adjust a few areas here, now that we've seen what they look like with the gold layer in place. For instance, the cheeks are a bit much, so we can remove a bit of that intensity by sampling the untouched area of the mask, and using that grey at a low opacity to tone down the red in her cheeks a smidge. I also thought her hair was a bit too green, so I brought up more red in her hair with a lighter grey mask there, and realized there was almost no red at all in her hands and finger tips, so I added some blush there, too. 
 

 
 
 
To give the white of her gown a little sparkle, I used a very dark, but not black, value to remove most of the red from the gown. I left more red showing in the lighter areas, less red in the shadows. You'll want to select this area before you work on it, so you get clean edges. Of course, then you'll need to soften them a bit after. :) 
 

 
 
Now, anyone who knows me knows that there is no way this is finished- I'll need to come back in and nanotweak tiny miniscule things no one but me can see for hours yet, like playing with the opacity on the three colour layers to see if maybe more is better on one, less is better on another, only to decide this was the best version of the thing after all, but you are probably nearing completion. It's Walk-Away time. When you come back with fresh eyes, go back to each layer and clean up any messy masking, and see if it needs any fininshing touches. You should have something about like this: 
 

 
 
But if you don't- hey, that's ok! The best thing about this method is that since everything is done with a mask, everything is infinitely flexible and easily fixable- you aren't going to ruin your image by experimenting, which is, for me, the most appealing aspect of colour anyway. You'll find you can finish one of these in a fairly short period of time, so you'll have plenty of time to play with this technique. 
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Creating Glass  
How to turn an ordinary apple into a transparent gem.  

By DakotaBoy88  Paginated View 

In this tutorial you will learn how to turn an opaque object into glass using Photoshop or Paint Shop Pro.

Page 1 : Getting Started.

In this tutorial you will learn how to turn opaque objects transparent using either Photoshop or Paint Shop Pro. Don't worry; it's not necessary to have both programs, as I will give separate instructions for each. I will be using Photoshop 4.0 and PSP 8, but the techniques should be similar with other versions of these programs. Before we begin, I'd like to thank Worth1000 members Ritchie and SkunkDuster for taking the time to teach me some of the basics used in this tutorial. With all that said, go ahead and fire up your favorite editing program and load up the two images I have supplied. Take the apple image and copy it into the newspaper file as a new layer. For those who are unfamiliar with how to do this, select the apple image then hit "Ctrl+A" then "Ctrl+C", then select the newpaper file and hit "Ctrl+V". (PSP users will get a pop-up box asking how you want to paste the new object. Be sure to select "new raster layer".) We don't need the apple file so close it out. (Note to Photoshop users: Don't delete the apple file, we will be using it later to create a displacement map.) 
 

 
 

 

Page 2: Masking the Apple

Hmmm, looks like we can't see our newspaper now. We will have to get rid of the white around the apple. Use the magic wand tool to select anywhere outside the apple. PSP users will need to set the tolerance to around 80, and Photoshop users will need a tolerance of 120 to make a clean cut without any masking lines. Now that you have all of the white area selected, hit the "Delete" key and your newspaper should show up around the apple. 
 
Note: If you don't like the magic wand tool, use whater masking technique works for you. 
 

 

Page 3: Making it Transparent

Since this thing is supposed to be glass, perhaps we should make it look transparent. Start by making three copies of the apple layer, then hide the original apple for later use. On the lowest apple copy desaturate it and convert to a negative image*. 
 
*In PSP you will hit "Ctrl+H" to open up the Hue/Saturation tool. Set the Lightness to "0" and the Saturation to "-100", and leave the Hue slider alone. Now to convert to a negative, go to the top pull-down menu and select "Adjust/Negative Image." 
 
*In Photoshop you will go to the top pull-down menu and select "Image/Adjust/Desaturate". To convert to a negative image, go back up to the pull-down menu and select "Image/Adjust/Invert." 
 
This step is the same for both PSP and Photoshop. Set the layer blending mode to "lighten" and set the opacity to approximately 50%. (Figure 1 is shown in normal mode at 100% for clarity.) 
 
On to the next layer up. Use the skills you leaned above to desaturate the apple. Now set the layer blending mode to "Overlay" at 100% opacity. (Figure 2 is show in normal mode for clarity.) 
 
On the very top layer set the layer blending mode to "Hard Light" with an opacity of approximately 70%. (See figure 3.) 
 

 
 
This image shows what all three layers plus the background would look like with the proper opacity and blending modes set. 
 

 

Page 4: Making Shadows

This thing should be casting a shadow, so lets make one. Because the apple is made of red glass we will give the shadow a red tint too. Make another copy of the original apple layer and make sure that it is below the three modified layers you made on the last page. Set the layer blending mode to "Hard Light" with an opacity of approximately 20%. Use the Skew function to shift your shadow to look like the one in the figure below*. 
 
*In PSP go to the top pull-down menu and select "Effects/Geometric Effects/Skew." Set the skew direction to horizontal, the edge mode to transparent, and the skew angle to 45 and hit OK. You will notice that the shadow doesn't line up, so use the move tool to make it line up like in the figure below. 
 
*In Photoshop go to the top pull-down menu and select "Layer/Transform/Skew" and slide the top over until you get something resembling the figure below. 
 

 
 
That shadow seems to be a bit on the bright side, so we shall have to darken it up a bit. But first delete the part of the shadow that is hanging out into the white void, it just looks silly out there. Duplicate the shadow layer into a new layer above the current layer. In the new layer set the blend mode to "Color Burn" ("Burn" for PSP users) and the opacity to approximately 50%. This still looks funny, so turn on the "preserve transparency" for this layer and fill the layer with black*. If done correctly the black will have only filled the shadow and not the whole scene. 
 
*To preserve transparency in PSP, right click on the layer in the toolbox, then select properties. With the properties menu open put a check mark in the box for "Lock Transparency." 
 
*To preserve transparency in Photoshop, with the layer slected, put a checkmark in the box next to "Preserve Tansparency" at the top of the layers toolbox. 
 
The completed shadows should now look something like this. 
 

 

Page 5: Shading on the Apple

The apple still looks a bit on the flat side. Lets add some darker area around the outside where the refraction would be the greatest and therefore the least amount of the background would be visible. Start by making a selection of the void around the original apple or any of the other apple layers. Expand the selection by 16 pixels and set the feather to 16*. 
 
*PSP users can expand the selection and modify the feather radius by going to the top pull-down menu and selecting "Selections/Modify/Expand" and "Selections/Modify/Feather." 
 
*Photoshop users can expand the selection by going to the top pull-down menu and selecting "Select/Modify/Expand." To modify the feather radius hit "Ctrl+Shift+D." 
 
Now that you have a nice feathered selection, use the eyedropper tool to select color from a shadowed area of the original apple. If unsure about the color, you can manually set the color with the following values: R55 B3 G3. With that dark red color fill the selection using the flood fill tool in PSP or the paint bucket in Photoshop. You will notice that this action just covered up your background, don't worry, help is on the way. Hit "Ctrl+D" to remove your selection, then make a new selection of the void around the original apple again, but be sure to click back onto this new layer once you are done. Modify the selection by expanding or contracting until you get the selection to match up with the edge of the apple. (Note: you may need to hide the new layer to see where the edge of the apple is.) Now that everything lines up all nice and peachy, hit the "Delete" key to make your background come back It still looks a bit out of place so we had better set out layer blending modes. Set the blend mode to "Multiply" and the opacity to approximately 80%. Your results should now look something like this. 
 

 

Page 6: Refraction Effects in PSP

As neat as all these transparency effects are, don't fall into the common trap of leaving your pic like this. Look at a glass sphere and see if it somehow has something that we don't yet have with our apple. Refractive distortion is what seems to be missing here, so let's go ahead and create it. Creating refraction can often be intimidating, but if you follow along here you will see that it's so easy you'll wonder why you haven't been doing it before. On this page I will focus on how to create refractive distortion in Paint Shop Pro, so Photoshop users please continue on to page 7 for your tutorial. 
 
Refraction in Paint Shop Pro 
 
You don't need a $600 program to create believable refraction, PSP can do it all and I'll show you how. I normally would never recommend merging layers because it makes it difficult to make changes to parts of the layer without having to manually select parts of it, but for the sake of keeping this simple I will break that rule. Merge the two shadow layers and the background together, then duplicate your newly merged background layer. (Note: Do NOT forget to duplicate the new background, or you will be very unhappy later when you realize that you have to start all over on the background and shadows.) PSP has many tools for doing cool distortion effects, but I'll be focusing on the "Mesh Warp" tool because I think it's the easiest and cleanest. Select background copy layer then open up the mesh warp tool. Set the "Mesh Horizontal" and "Mesh Vertical" both to max, "Symmetric" option to off, "Edge Mode" to background, "Draft Quality" to high, and "Best Quality On Apply" to on. You should now have a cool looking grid covering your whole scene, but if you don't then set "Show Grid" to on. Now is where the fun begins. Move around the vertices of the grid until you get something resembling figure 1, and don't worry if you go out of the apple's boundaries, as we'll fix that right quick. (Note: If the programs asks you to promote your selection, hit "cancel" then deselect whatever you have selected.) Once you have your displacement all pretty looking go ahead and apply it using the blue "apply" checkmark. Lets go ahead and clean up the stuff that went out of the boundaries but doing another selection around the original apple and modifying the selection like we did on the second part of page five, then delete the selected area. That original background layer now shows up in all its glory and your pic should now look like figure 2. Your distortion is all done so skip the Photoshop stuff on the next page and go to page 8 to see how you stacked up against the Photoshop users. 
 

 

Page 7: Refraction effects in Photoshop

Refractive distortion is much easier in Photoshop than PSP, so go ahead and do a little jump for joy. On this page we will cover how to create and use displacement maps to create the cool refractive effects on our apple. Remember that original apple image I asked you to save and not delete? Well, guess what, we need it now so go ahead and open it up. Now that you have it open, use the magic wand tool set to a tolerance of 120 and select anywhere in the white void. Hit "Ctrl+Shift+I" to invert the selection then modify the selection by contracting it by four pixels. Set your forground color to pure white and the background color to pure black, then select the gradient fill tool. In the gradient fill toolbox be sure to select "Radial" for the type of fill. Because we want the majority of the distortion at the edges, click on "Edit" in the "Gradient Tool Options" toolbox. Set the fill mode to "Foreground to Background" and move the slider on the top of the gradient shown to the right until about 80% of the gradient is white. Hit "OK" to make your changes take effect. With the gradient tool still open, click in the middle of the apple, hold that click, then release once you have moved the cursor just outside the bottom left portion of the apple to apply the gradient. Your displacement map so far should look like figure 1. 
 
Now hit "Ctrl+Shift+I" to invert your selection, then from the top pull-down menu, select "Edit/Fill" and set the fill to "50% Grey" with 100% opacity. Now we should have something that looks like a grey apple on a grey background like in figure 2. 
 
That gradient we used would be fantastic if an apple were a perfect sphere, but since an apple is a bit odd shaped we had better do a few more mods. Use the airbrush tool and selections when needed to paint on some shape to our apple. Ideally you would come up with something similar to figure 3. 
 
This displacement map so far would give us some really strange looking effects, so lets fix that. Invert the image to a negative like we did with the first apple copy layer on page 3. You might be wondering why we didn't just use a black to white gradient before, well, it's because it's just easier to understand a positive image than a negative. If for some reason you have more than one layer, then go ahead and flatten the image. (Note: Displacement maps must be single layer *.psd files or they will just leave you with an odd square with faint text when you try to apply them, so please keep this in mind.) Your map is all done now, you just need to save it as a psd file. I saved mine as displace.psd, but you can name yours whatever is convenient for you. Go ahead and minimize your displacement map, we don't really need it at the moment. Go back to your original apple psd file and select the background layer with the newspaper. With the background layer selected go to the top pull-down menu and select "Filter/Distort/Displace." A new pop-up menu should now show, so set the vertical and horizontal scales both to 40, and select "Stretch To Fit" and "Repeat Edge Pixels", then hit "OK." A new menu will now appear asking you to select a displacement map file, so go ahead and select the map you created a little while ago and hit "OK." Wow, you can now see what happened to your background, there's some really trippy refraction stuff going on like in figure 4. 
 

 
 
Hmmmm, something still looks odd. Take a look at the shadows that are showing through our shiny glass apple. What's odd about them you ask? They aren't distorted like the rest of the background image. Select the lower shadow layer and apply the same distortion effects that you already did on the newspaper, then repeat on the other shadow layer. You should now have something totally cool that looks like the figure below :-) 
 

 

Page 8: Final Side-by-Side Comparison.

PSP and Photoshop users, you have both done a nice job on your apples, and have gotten the basics of this tutorial down. There's a lot more you can do to improve this if you would like. For example, you could add reflections of the newspaper onto the bottom of the apple, spend more time on the shading and highlights, or make the shadows a bit more diffuse. Take this beyond where you found it and continue to raise the bar for all. Perhaps you can use this technique for the next statue creation contest, or if you happen to just be lost for ideas on a B2B, maybe some wild glass effects are all that you really needed. Thanks much to everyone who took the time to participate. I now leave you with side-by-side comparisons of the PSP and Photoshop final results. I hope you enjoyed learning as much as I did writing this. As always, feel free to e-mail or send me a message if you have any questions. 
 
PSP final image... 
 

 
 
Photoshop final image... 
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The making of Bayou Nights  
 

By DakotaBoy88  Paginated View 

Turning day into night. How I created Bayou Nights.

Page 1 : Getting started

In this tutorial I will be explaining how I used Photoshop 4.0 to turn Cabin 105 into a nighttime bayou scene. Start by opening the high resolution version of the original Cabin 105 theme pic. 
 

 
 
Duplicate the background layer and name the new layer "cabin edited" or whatever else you want to call it. This is the layer in which we will be doing all of the editing for the cabin itself. Since the house will be on stilts over water, the storm windows will look out of place resting against the front of the house. Go ahead and clone them out at this time, but don't worry about removing them below the bottom of the siding because that area will be covered up later. Trees are naturally a part of a swamp so leave the trees intact. Also don't be too concerned if the lines you cloned back into the siding are a little crooked, we will fix that later with heavy shadows. 
 

 

Page 2: Lighting the interior.

Lighting up the interior of the cabin. Use the polygon lasso tool to select each pane of glass in the windows and the screen on the door. Don't forget the parts of the screen showing under the handrail. With all of the glass and screen selected, set the feather to 0.2 pixels. Hit the delete to remove all of the glass and screen. You may have to turn off the background to see that anything happened, as the background will be showing through the cutouts and will look the same. Without deselecting anything, open a new blank layer and name it "interior illumination." Set the layer mode to color dodge and layer opacity to 82%. Fill the selection with white at 100% opacity. In my illustration I painted in a green background so that the white filled areas would show up in the tutorial. 
 

 

Page 3: Exterior lighting.

On the cabin edited layer, draw a selection around the front wall and steps and set the feather to 1. Open up the render lighting effects filter and set to floodlight. Move the floodlight around until the top of the elipse converges on the porchlight. Set the intensity to 26 and the focus to 69. Set all of the other properties to zero, except for ambience, which needs to be set to positive eight. Go ahead and hit ok and your image should now look like this. 
 

 
 
Now invert the selection and open up the lighting effects editor again. Use all of the same settings but just move the light off the page somewhere so that it casts no light on the scene, but rather allows the rest of the scene to turn into nighttime. Your image should now look like the one below. Everything looks a little bright for a nighttime pic, so go ahead and tweek the levels a bit. Move the shadows slider and the midtones slider each a bit to the right until you get something you like. 
 

 

Page 4: Porch light.

The light on the front of the house must be coming from somewhere, so lets make it look like it's coming from the porchlight. Open a new blank layer above the current layer and name it porch light and set the blend mode to luminosity. Use a very soft airbrush about size 75 with a pressure of 6% using a slightly offwhite color with a tint of yellow. Apply a very faint glow with the top of the brush just touching the light fixture, but covering the bulb. Change to the next brush size smaller and again apply a faint glow with the top of the brush just touching the light fixture. Repeat with progressively smaller brushes until you get to a brush that's the same size as the bulb. This will give the appearance that the light is emanating from the bulb rather than being cast on the building from elsewhere. The light is still not perfect though, so set the paint color to pure white, and select a brush that is just smaller than the lightbulb. Now apply a really bright spot directly over the lightbulb. Your results should look similar to the illustration below. 
 

 

Page 5: Shadow for the front of the cabin.

The lighting is still "not right" on the front of the house so we shall add some shadows to make it a bit more realistic. Open a new blank layer just above the cabin edited layer and set the blend mode to luminosity and the opacity to 84%, and name it building shadows. Use the polygon lasso tool to select areas where you want shadows and fill with a dark color borrowed from the front of the house. Be sure to pay attention to where the light is coming from and use forground color to transparent gradient fills where needed, like on the handrail. Also make sure you black out the foundation entirely as this house is supposed to be on stilts above the water (Note: we wont' be adding in the stilts because they would not be visible due to heavy shadow). Use the line tool to create the shadow lines in the siding, making sure to gradually make the lines thicker as you go down the wall. Now that all the shadows have been created, run a gaussian blur of 0.6 pixels over this layer to soften up the shadows. Your building shadows layer should now look something like the illustration below when viewed by itself. 
 
Note: Don't worry about extending the shadows too far into the dark areas, they won't show there anyway. 
 

 

Page 6: Creating a swamp dweller.

This old swamp house needs a swamp dweller to call it home. Lets add an old guy on the porch. I wasn't able to find a complete image that I liked so I manipulated and merged two different images as shown below. I'm not going into detail about how to do that here, IronKite goes into great detail about how to merge images and match colors in his href="http://www.worth1000.com/tutorial.asp?sid=160992"> Archaeological Dig tutorial . I will add a note about  
resizing layers though. Be sure to hold down the shift key to constrain the proportions or your guy will either look squashed or stretched too much. 
 

 

Page 7: Lighting effects on the old man.

This old guy sure looks like he's out in the sun when it's supposed to be night in the bayou. Perhaps we ought to desaturate him a bit and do some funky stuff with his lighting. Start my drawing a selection on the side of the body that will be getting the highlights, paying careful attention to where the light would likely strike his body and clothes if this scene were not faked. Since the light is almost entirely behind him, we will only select a fine sliver of his left side, then set the feather level to 4 pixels. Invert the selection and open the lighting effects filter. Use the same settings we used on the cabin, but move the light completely off the picture so that we can darken the shadowed part of his body. Your image should now look like he first one in the series below. Now invert the selection again so that we can give him some highlights from that bright porch light. Open the lighting effects and using the same settings move the light over the upper left of his body and change the light angle so that it appear the light is coming from above and to the left of him. You should now have something that looks like the second part of the pic below. If you deselect then you will have you final old man, like in the third pic below. Don't worry if his highlights look a little bright, they will look ok when we copy him into the cabin scene. 
 

 

Page 8: Adding the old guy into the scene.

ets copy him into our cabin scene now. Merge his head and body layers now if you haven't already done so. Do not merge the background though or you will no longer have the transparency around his body, and you'll have to cut him out again and waste a bunch of time trying to get rid of masking lines. Copy the layer with the old man, then paste it into a new layer in the cabin file. Be sure that your new layer is above any previous layers or you will have strange shadows over the old guy or just have him completely disappear. Once he's in there, be sure to scale him down to size. Make him a little shorter than the door of the cabin, then place him on one of the lower porch steps like the illustration below. 
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Page 9: Making the old guy cast a shadow.

Oh my, it looks like he is floating. Don't make the mistake of leaving him standing on that step without casting a shadow. Using the same dark color you used for your original shadows, go back to your building shadows layer and use a medium density airbrush of appropriate size to draw in some shadows on the steps. Be sure to pay attention to the angle of the light source and also the fact that his body gets bigger above his feet. Also the light rays will spread with distance so make the shadow even wider as it gets further from him. Your image will probably look like this when you are done. 
 

 

Page 10: Let there be water.

Yippie, we now have enough of the image done to make the water, so lets make some water. Start by saving a copy of the current cabin image with no compression. Now load that image as a new layer of the cabin file and name the layer "water". Flip that layer on the vertical and move it to make it look like the pic below. 
 

 
 
You will notice that the perspective of the reflection doesn't jive with the cabin. Open the layer transform "skew" tool and tweak and move the layer until you get this. The idea is to follow the perspective of the bottom of the building and to make all of the parts of the building line up properly. You will notice that the perspective of the reflection of the porch and railing looks messed up, but don't worry about it as it will be covered up by a boat and it's shadow. 
 

 

Page 11: Adding a boat.

A boat you say? Yes, how else can an old guy living in the middle of a swamp get to where he needs to go. It so happens that the old geezer found a very nice boat on Google. All you have to do for him is cut it out, scale it, rotate it to fit his surroundings, and do some nice lighting for him. The top image in the illustration below shows his boat cut out and ready to get it's shadows, green indicates the part of the hull that was cut off to imply that the boat is partially submerged in the water. The bottom part of the illustration shows how the boat looks with shadows. To make the shadows select all of the areas with the shadows using the polygon lasso tool, then render lighting effects with the same settings as before with the light completely off the boat. 
 

 

Page 12: Inserting the boat and adding shadows.

Now go ahead and make a new layer above the water layer in the cabin file and paste in that boat. Use the layer free transform tool to scale and roate it to your liking. Your end result should look something like this. 
 

 
 
That boat looks a bit like it's just hovering over the water. Lets add some shadows to make it feel right at home (Note: we won't be adding a reflection of the boat because nothing that is highlighted on the boat would even be visible at this angle in a reflection). Create a new blank layer just under the boat layer and name it "boat shadow", leaving the blending mode in normal and opacity at 100%. Use the polygon lasso tool to draw the outline of the shadow, set the feather level to 3, then fill the selection with the same dark color that you have been using for the rest of the shadows. 
 

 

Page 13: Adding realism to the water.

That water looks way too calm. Perhaps there's some critters moving around out there stirring up the water a little bit. Deselect the shadow of the boat merge the shadow layer down to the water layer. With the water layer selected, open up filter/distort/ocean ripple, use a ripple size of 15 and a magnatude of 8, then apply to the water layer. Now run the gaussian blur filter over the water layer at a level of 1.6 pixels to soften everything up. Tweak the levels a little to make the water slightly darker. Your image should now look something like this. 
 

 

Page 14: The final touches, a night sky.

We are almost done now. We just need to add some interest to the sky, just don't go overboard with a moon or anything crazy like that, you don't want to detract from the lighting effects you worked so hard on. All we need are a few faint stars. Create a new blank layer and name it stars, leaving the blending mode to normal and the opacity set at 100%. Use a small soft airbrush set to pure white, with a very low opacity setting. Now paint in a few faint stars, leaving some brighter than the others. Stars are never pure white so using a slightly smaller airbrush with random vibrant colors, paint a color highlight onto just a few of the brighter stars. Your final image will look something like this. 
 

 
 
I hope you enjoyed this tutorial as much as I did making it. Please feel free to e-mail or message me if you have any questions about this tutorial. 
 
Additional information on the following pages describes how to deal with free-standing and multiple light sources. 

Page 15: Day to Night Part 2

How to deal with free-standing and multiple light sources. 
 
This addition to the tutorial will be simplified a bit since you already learned most of what you need to know in part 1. To begin, copy the image shown below into Photoshop or other graphic editing program. 
 

 
 
Make a copy of that layer and place it directly above your original layer. With the duplicate layer selected, open the lighting effects filter and select the default light settings. Move the light source so that no part of it intersects your image, then hit enter. You should now have something resembling the image below. 
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Page 16: Lighting the first lamp

With your darkened layer selected, create a layer mask for that layer (bottom of the layer palette, box with a dashed circle in it. May be different in other programs). Draw in your mask using soft black brushes, using selections where needed on hard edges, to create a mask similar to the one below. Note: in this image I am using red to show where the white areas of the mask would be, and transparency to show the black parts of the mask. In your image the mask will not show, just the results. 
 

 
 
The next image shows what you would see on your screen. 
 

 

Page 17: Lighting the second lamp

With the same layer mask you used to light the first lamp, select an appropriately sized soft black brush and draw in the lit areas on the ground around the light and the light itself. Note: you may need to drop brush opacity since this light is quite far from the viewer. To put light on the nearby trees we will need to use a different brush. Select an appropriate sized splatter brush and touch and release around all of the areas of the trees that should be hit by the light. Be sure not to light the whole trees, only areas that would not be in shadow. You will now have a mask looking something like this. 
 

 
 
...with results looking like this. 
 

 

Page 18: Final tweaks and color correction

You will notice that with this project, the sky is too bright, and the building comes out a funny color. I corrected the sky by selecting it and painting a dark midnight blue onto it. The cast of the buildings was corrected by selecting the dark layer itself (not the mask), then opening up the selective color adjustment. I selected black as the color to adjust, then increased the cyan and magenta values to give the buildings a faint bluish purple cast to simulate moonlight. The final image would look something like this. 
 

 
 
There are other things that should be done to complete this image that I won't be showing here. The original daylight shadows need to be cloned out, some of the building and skyway windows should be lit, and the sky should be a little more detailed. You are also free to add people and other objects that will make your image come to life. 
 
As always, feel free to send my an e-mail if you have any questions. 
 
--Dakotaboy88 
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The Making of the Springfield Frog  
 

By fRedline  Paginated View 

A handy exercise in masking, cloning and adjustment layers.

Page 1 : Getting Started

How to make this cute little frog… 
 

Mutate into this poor creature. 
 

The making of the Springfield Frog is a handy 
exercise in masking, cloning and adjustment 
layers. 

This image was created using Photoshop 7; 
PS 6 offers adjustment layers but users of 
previous versions, and some other apps, will 
have to work around the use of adjustment 
layers, I’ll offer an alternative solution at the 
conclusion. 

It’s actually a relatively simple image to 
construct, a lot of sleight of hand using 
subtleties to fool the eye. 

Take a look at our finished layers palate to get 
a feel for the depth of the image. 

And… let’s jump right in.
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Page 2: Creating a Clean Background

First off, let’s double click on the 
Background layer and rename it 
“Original.”

 
Drag that layer onto the page icon at the 
bottom of the Layers Palate to duplicate 
it, double click on the new layer and 
name it “Cloned.”

 
Then Click on the folder icon to create a 
new layers folder, double click on it and 
name it “Background.” Drag both of our 
layers into the “Background” folder. Do 
this by dragging each layer icon onto the 
folder icon.

 
They should stack in their original order, 
if not; you can reorder them as usual. 
Now save your working document. 

Make the “Cloned” layer active, select 
the clone tool with a 20 to 35 pixel soft 
brush (according to taste) and clone over 
the frog’s right eye.

Don’t worry about getting some of his 
head too, just make sure the shadows 
and the wood look smooth and natural.

Duplicate the “Original” layer, name it 
“No Eyes” and put it above the “Cloned” 
layer.

With the “No Eyes” layer selected, click 
on the layer mask icon (gray box with a 
white circle) to apply an empty mask to 
that layer. 
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Click on the layer mask to activate it and 
paint with a hard edged black brush to 
mask out the right eye.

Get in there with the zoom and use small 
brushes (around 2 to 3 pixels) to get a 
nice clean forehead.

Just press “x” on your keyboard to switch 
to a white brush if you want to undo any 
masking.

Save File. 

Now click on the “No Eyes” layer (so 
you’re no longer working on the mask) 
and select the clone tool with a 20 to 35 
pixel soft brush.

Clone over his left eye, set your clone 
source to a part of his body that has 
similar texture and color. You don’t want 
to clone directly from his nose; you’ll get 
an obvious pattern.

You might even lower the clone tool’s 
opacity and use smaller brushes at the 
end to gently cover any “seams” around 
the edges.

Goal: smooth, realistic transition. 

Save File.

Alright, we’ve got a nice eyeless frog now. That’s even a pretty good mutation, but we’re going big!

Page 3: Isolating the Eyes

OK, let’s hide the “Cloned” and “No 
Eyes” layers momentarily. Now make 
“Original” the active layer and activate 
the rectangular Section tool.

Make a selection around the right eye 
with plenty of extra room around its 
edges; copy and paste. This will paste a 
copy of the right eye and its surrounding 
skin onto a new layer.

Click on the “Original” layer and make a 
similar selection around the left eye. 
Copy and paste. Name each new layer 
“Left Eye” and “Right Eye” respectively.
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*** Note on eye layer names: I named 
the eyes according to the frog’s 
perspective. ***

Make a new layer Folder and name it 
“Eyes.” Drag the two eyes layers into the 
“eyes” folder.

Position the eyes roughly where they’ll sit 
at the end of the “eye stalks.” Then link 
the layers and makes the eyes smaller 
with the free transform tool (Ctrl+T); hold 
Shift when scaling to retain proportions. 
Unlink the layers and reposition the eyes 
again.

Slap an empty mask on each layer and 
mask out the pixels you don’t need.

*** The illustration has an intentionally 
dark background to highlight the masking 
that is being done. *** 

Save File. Next, Eye Stalks!  

Page 4: The Right Eye Stalk

Make a copy of the “No Eyes” layer and rename it 
“Right Stalk.”

Drag this layer into the “Eyes” folder beneath the eyes 
layers.

Apply the mask on the layer (right click on the layer 
mask and click on Apply Layer Mask.) 
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Leave both eye layers visible for reference. 

Use a soft clone tool to create a rough approximation 
of the eye stalk.

This is the ‘artistic’ part, set your clone source to a 
texture around the legs so you can get curves and 
textures you might envision on the stalk. 

Try to get some nice patterns and, again, strive for 
realism, no seams. This may seem a little tough 
because you’re really just making a big blotch up there 
but you can come back and fix it up after you get a 
mask on it.

Save File.  

Now slap a mask on the “Right Stalk” layer and fill it 
with black (Alt E, L) so all that hard work is covered up.

Now use a hard edged white brush on the mask to 
reveal a stalk.

Again, lots of room for artistic interpretation here. You 
can use varying size brushes and edges to get a nice 
fleshy & wrinkly feel.
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Save File. 

OK, we’ve got a decent stalk ‘area’ but it’s rather flat 
looking. Make sure the “Right Stalk” layer is selected 
and click on the ‘adjustment layers’ (yin/yang) icon at 
the bottom of the layers palate.

Select Levels and set the levels roughly as shown.  
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Click OK and select the new adjustment layer. Key in 
“Ctrl G” to group the adjustment layer with the “Right 
Stalk” layer. Rename the adjustment layer "Right Stalk 
Levels." 

Now just the stalk is very dark. Save File.
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Activate (click on) the “Right Stalk Levels” layer. 

Now paint on the mask with a soft black brush to 
expose the areas you want to brighten. Get in there 
with some small brushes to heighten the wrinkle and 
fold effects.

At this point, now that you’ve got some 3D perspective 
to work with, you might even resample parts of the 
stalk with the clone brush.

Remember, you’ve got the entire frog body under the 
mask on the “Right Stalk” layer to sample from. Just 
temporarily disable the mask (right click on layer mask, 
Disable Mask) to find exactly the texture or pattern you 
want on the stalk.

Save File.

 

Page 5: The Left Eye Stalk

 We now follow roughly the same process as the Right Eye Stalk. Here are the layers and image steps for 
reference.
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You may have to play around with the opacity of the 
“Left Stalk” layer as you make the initial clone so it is 
realistically proportional to the right stalk. 

By that, I mean it helps to see at least a vague outline 
of the right stalk as you create the left stalk.

Once you put the mask on the “Left Stalk” it is easier to 
outline because you see the right stalk plainly.

Again, this is the real fun part, so enjoy. 

Well, in hindsight, just make a copy of "Right Stalk," 
apply the mask, merge with a copy of "No Eyes" and 
use that as "Left Stalk." You'll have the clean right stalk 
to reference as you clone the rough left stalk.

Save File. 
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One you’ve completed the “Left Stalk” and “Left Stalk 
Levels” layers, you might see the need for some 
shadow behind the left stalk. Well, I did anyways.

Make a new layer, drag it below the “Left Stalk” layer 
and rename it “Left Eye Shadow.” Grab a 35 pixel 
fuzzy black brush and approximate a shadow from the 
stalk and eye. 

Set the “Left Eye Shadow” layer’s opacity to about 
45%. 

file:///C|/Worth1000/51.htm (10 van 14)13-6-2006 23:18:37



Worth1000.com | Photoshop Contests | Are you Worthy™ | tutorial

 
Slap a mask on it and use a soft black brush at about 
50% opacity to define the edges of the shadow.

If you look closely, I used a firm brush around the 
orange wart for perspective. 
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Save File.

And now, the finishing touches.

Page 6: The Finishing Touches

So, now you’ve got a crazy looking 
mutant frog. Now, here come some of 
those extra five minutes you always hear 
about…

Collapse the two folders, “Eyes” and 
"Background.” Hide the eyes folder by 
clicking on the little eye icon on the layer.

Activate the “Background” folder and 
select the entire canvas (Ctrl+A), and 
‘copy merged’ (Ctrl+Shift+C) all that is 
visible. Paste, it will automatically create 
a new layer, drag the layer above the 
“Eyes” folder and name it “BG Done.”

Hide the “Background” folder; make 
visible and activate the “Eyes” folder. 
Select the entire canvas, and ‘copy 
merged’ all that is visible. Paste, it will 
automatically create a new layer, drag 
the layer above “BG Done” and name it 
“Eyes Done.”

The contents of the “Eyes Done” layer 
will be in the middle of the canvas.

Keep the “Eyes” folder visible and drag 
the “Eyes Done” layer directly over it.

You can hide and show the layer 
contents until they are positioned 
perfectly over the folder contents.
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Now, hide the “Eyes” folder and make the “BG Done” layer visible.

Save File.

Well, that was a lot of busy work, eh? The reason I want to isolate the entire eyes structure is to add 
some selective blur in strategic places. If you look around the frog’s body you’ll see how it blends in 
with the background.

Our ‘eyes’ have some sharp edges that smack of ‘cut and paste.’ We want to get a 3 to 5 pixel-wide 
blur tool at about 30% strength and blur up some of the sharper pixels around the edges of the “Eyes 
Done” layer.

Save File.

Let’s do a final adjustment and upload this beauty.

Select all and copy merged, and paste. The new layer should be at the top and active. I just threw on 
an Auto-Contrast (Image>Adjustments>Auto Contrast) to touch it up and it’s good to go.

Auto Levels changed the color too much for my tastes, but at this point you can experiment away to 
apply effects to the entire image on one layer.

Save for web and go gloat. 

And don’t forget to thank Jax at all possible opportunities!

I’ve tried to include a lot of little tidbits and shortcuts; I know that’s what makes the W1000 tutorials 
invaluable to me. So, hopefully you picked up something new here and bring it to the contests! 
Cheers, fRedline
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Non Adjustment Layers Users’ tips on Page Seven

Page 7: But, I don’t have Adjustment Layers!!!

You can achieve a similar effect in a variety of ways. Here is a thought I had and experimented with 
a little. 
 
Duplicate the “Right Stalk” layer, fill it with black and apply the layer mask. Bring the opacity down to 
about 50% and slap a new mask on it. Paint with varying size and opacity black brushes to bring out 
the 3D effect. A little less elegant but, with a little sweat and innovation, definitely serviceable. 
 
Hope that helps, see you at the polls :) 
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Building a better Zeta-Jones  
 

By furitsu  Paginated View 

Well, this is my first tutorial, so I hope it works out alright. :) The Zeta-Cyborg image was created in Adobe Photoshop 7. I am assuming that the basics are understood.

Page 1 : Source images, setup and paths.

When I read the Cybergenics 2 contest requirements, an idea of what I wanted to do had already formed. Then the search for some good source images began. This is something I usually find to be trickier than the actual Photoshopping. After finding this gorgeous image of Catherine Zeta Jones (image 1), I still had to find some compatible hardware for the head (image 2) and arm (image 3). 
 

   
 
Setting up the layer-sets (image 4)early is a good idea. It keeps everything neat and tidy. Of course I did this after I finished the head part. :) 
First I did the paths (image 5). They gave me a good sense of how I could achieve the image I had in my head. 
 

  

Page 2: Face works.

I decided to start with the head, because that would the most difficult part of the image. 
Using the path I created to make a selection, with a feather radius of 0 and anti-aliased selected (this goes for any selection I make with a path), I copied her face into a new layer and moved it around 30 pixels to the left (image 6). Now you can see why I decided to do the head first. The lock of hair had to go! 
 

 
 
Of course, some careful cloning, using a variety of opacities, and healing, got rid of those pesky hairs and shadows (image 7). Still, it took quite some effort to do it right. Next step was an extra layer of flesh colored airbrush, some layer masking on the left and highlighting/darkening parts of the edges with the dodge and burn tools (image 8). 
 

 
 
Next step was an extra layer of flesh colored airbrush, some layer masking on the left and highlighting/darkening parts of the edges with the dodge and burn tools (image 8). 
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Page 3: A head.

With the "face" about done, it was time to reveal the inside of the cyborg head. Using the same path with which I made a selection for the face, I made a layer and filled the selection with a color. Any color is fine, because you won't see it later on. Above this layer I copied the "head hardware" image into a new layer. Holding the alt-button with my cursor between these layer I connected them and made the bottom-layer into a mask (image 9). This way I could easily move, rotate and resize the image within the mask. However, if the image in the layer above it becomes smaller than the mask, you will see the mask itself. 
 

 
 
After resizing, rotating and moving the image of the head hardware, I added some shadows with the burn tool for depth, with the "face" as a guide (image 10). 
 

 
 
To reveal the thickness of the rubbery "cyborg-flesh", I made a few paths (image 11).  
 

 
 
After making a selection with the face path, I intersected them from that selection. I filled this with a dark red-brown and used the dodge and burn tools to add depth (image 12). 
 

 
 
In image 12 you can see the lock of hair had to be placed over the mechanical inside. I copied that part of the hair into a new layer and masked it clear (image 13).  
 

 
 
Then I duplicated the original image of Catherine and highlighted and darkened the edges of the head here and there, as well as added some shadows (image 14). 
 

 

Page 4: Well armed.

Next up: the upper arm. Using the paths I had created earlier, I made selections for the upper and lower plate and copied each into a seperate layer, rotated them clockwise and counter-clockwise respectively. Then I highlighted some of the edges for depth and moved them apart (image 15).  
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Now to show the inside of the arm. Like I did with the head, I made a selection where the arm would reveal the hardware and then alt-connected it to the hardware image in the layer above it (image 16).  
 

 
 
After resizing, rotating and positioning the image of the hardware to the form of the arm, I added some shadows with the burn tool for depth, with the armplates as guides (image 17). 
 

 
 
Making shadows is quite a delicate task. When not done right, shadows can be a dead-giveaway that an image was altered. For me, using the burn-tool with different brush sizes, exposures and ranges (highlights, midtones and shadows) gets the best results. And sometimes, when the image allowes it, using the images own shadows can work as well. Or even better. 
 
Back to the arm. Revealing the thickness of the "cyborg-flesh" (of the arm and the arm plates, in different layers) is done in the same way as with the head (image 18).  
 

 
 
Then I worked on the duplicate image of Catherine to highlight and darken the edges of the outer arm here and there, as well as some shadows (image 19). 
 

 

Page 5: Not seamless.

To have the illusion of cyberflesh being prefabricated before being applied to the cyborg, I wanted to have some seams showing. Subtly, but visible nonetheless. To do this, I decided to use a layer style on a stroke created by the paths for the seams. After I created a new layer, in the "seam lines" layer set of course, I selected the seam paths. For the stroke I needed a size 2 hard brush. Then I chose "stroke path, tool: brush" twice, to thicken the stroke (image 20). The color used for this is not important, it will not be used.  
 

 
 
While having my cursor over this new layer, I control-clicked on it to get a selection of the seam strokes. With this selection I copied a part of the original Catherine image into a new layer (control-c/control-v) and moved this layer into the seam lines layer set. Having the layer active, I selected Layer Style: bevel and emboss. With preview activated I tweaked and tweaked (image 21),  
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set the contour range to 70% (image 22),  
 

 
 
until the seams were how I wanted them (image 23). 
 

 

Page 6: Hot wired, part 1.

On to the cables, or wires, in her back. I created a new layer in the "back" layer set, activated a size 4 hard brush with a greenish color and then selected one of the cable-paths (image 24).  
 

 
 
I chose "stroke path, tool: brush" once. In this case the color IS important, because it WILL be used (image 25). 
 

file:///C|/Worth1000/52.htm (4 van 7)13-6-2006 23:18:41



Worth1000.com | Photoshop Contests | Are you Worthy™ | tutorial

 
 
With the "cable1" layer active I selected Layer Style: bevel and emboss for some tweaking (image 26). Keep in mind though, that if you change the Shading angle or altitude, it changes those for ALL layers using the layer style bevel and emboss.  
 

 
 
For the shadow mode I chose a very dark red, so it would look like the cable reflected a bit of the color from Catherine's back (image 27). 
 

 

Page 7: Hot wired, part 2.

I repeated those last steps for cables 2 to 7 and chose different colors for each of them. After that I arranged the order of the layers to my liking and placed some shadows here and there for depth (image 28).  
 

 
 
Then I selected the spine and some of the hair that would cover one of the cables from the original Catherine image and copied that into a new layer above the layer to be covered by the hair. I did some masking to reveal the cable and then set work on making bulges (clone-tool) and holes (burn-tool) on the spine, were the cable would enter the flesh (image 29). The bulges could also have been achieved with the Liquid-filter or some airbrushing of course. 
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Now to cover the lower end of the cables. I selected part of the dress from the original image, copied that into a new layer and placed it above the cable layers. Then masked away the flesh to have the cables appear going into the dress (image 30).  
 

 
 
Finally I duplicated the image (image > duplicate > activate Duplicate Merged Layers Only) and did some more blurring, highlighting, shadowing, cloning, a bit of noise and gaussian blur etc. 

Page 8: It

And there she is! 
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Making this tutorial took quite a bit longer than making the image itself. English isn't my native language, so maybe it sometimes takes a second reading. But it was fun to do and I hope you'll like it. 
If you have questions or suggestions, please message me here. 
 
And hey, isn't Worth1000 just the greatest? :) 
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Let It Snow, Let It Snow, Let It Snow!  
 

By Philbert  Paginated View 

I'm going to attempt to explain how to create a realistic snowstorm effect like in my entry (Heading for Shelter) for the TG B2B:Movie Scene.

Page 1 : Background

This tutorial will show you how to turn the image on the left into the image on the right:  
 

 
 
Since there are tutorials here at W2K that cover masking and such, I'll assume you already know the basics of Photoshopping, such as finding source images, masking, cloning, and everything else that will allow you to get to our starting point: 
 

 

Page 2: Making Snow

The first thing we need to do is lay the foundation for the snow. Nothing Mother Nature does is orderly and snowfall is about as random as it gets. The quickest and easiest way to make something look random is to use a noise filter, so... 

 
1.  Create a layer set above our starting point and name it "Snow". 
2.  Activate the Snow layer set and add a new layer in it. Fill the new layer with 50% Gray. 
3.  Now let’s generate the noise: Filter -> Noise -> Add Noise... 50%, Gaussian Distribution, Monochromatic 
4.  Blur it a bit to give it nice, soft edges. Filter -> Blur -> Gaussian Blur... Radius 4.0 pixels 

 
You should have something like this:  
  

 
Doesn't look like much like snow, does it? 

Page 3: Making it Snow, part 2

Next we'll use the magic of a Curves adjustment layer to increase the contrast and create our snowflakes. 

 
1.  Add a Curves adjustment layer above the noise layer. Layer -> New Adjustment Layer -> Curves... Group With Previous Layer 
2.  You'll see the Curves Adjustment Window. Make the "curve" look something like this:  

 
  

 
so your noise will look like this:  
  

 
Note: You can play around with the Curves Adjustment to increase or decrease the number and size of the flakes. 

Page 4: Snow!

White specks on a black background don't look like much at first. That's where blending comes in handy. 
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Activate the Snow layer set and change the blending mode to Screen and the opacity to 90%. You should now have something similar to this:  
 

 

Page 5: Adding Depth Away From the Viewer

In real life, a snowstorm has depth. It engulfs things. We can simulate this by adding several layers, increasing or decreasing the scale of each to make it look closer or farther away. I used five layers of snow. You can have more or less, but five was fine for this image. There may be (probably is) a better/quicker/easier way to do this, but I'm going to stick with what worked for me: 

 
1.  Duplicate the Snow Layer Set. The default name of “Snow Copy” is fine for our use. Activate the new layer set.  
2.  Open the set, ungroup the Curves Adjustment Layer from the layer of "snow", and select the layer of "snow". 
3.  Edit -> Transform -> Scale and set the scale to 50% using the boxes at the top of the screen. Make sure you click on the little link icon between the width and height boxes.  

 

 
 

4.  Align the shrunken layer with top-left of the image: 
a) Select -> All 
b) Layer -> Align to Selection -> Top Edges 
c) Layer -> Align to Selection -> Left Edges 
 

 
 

5.  Duplicate the shrunken layer and use Layer -> Align to Selection -> Right Edges to align it with the right side of the image. 
 

 
 

6.  Merge the two shrunken snow layers: Layer -> Merge Down 
7.  Duplicate the merged layer and align it with the bottom of the screen: Layer -> Align to Selection -> Bottom Edges 

 

 
 

8.  Layer -> Merge Down. Group the Curves adjustment layer with this newly filled layer to complete the filling. 
 

 
 

9.  Next Look for vertical and horizontal lines caused by replication. Use a large soft eraser brush with an opacity of 50% or so to clean it up. 
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You should now have something similar to this: 
 

 
 
Repeat this set of steps using this newly created layer set as the basis. It’ll add another level of depth in the distance. You can do this as many times as you want, but a total of twice should be sufficient, producing something like this: 
 

 

Page 6: Adding Depth Closer to the Viewer

Now let's add flakes closer to us. We'll do something similar to the previous step, but it'll be quicker and easier. 

 
1.  Activate the layer set named “Snow” and make a duplicate of it. Again, the default name of “Snow Copy 3” is fine. Change the order, moving the “Snow Copy 3” layer set below the “Snow” layer set. 

 

 
 

2.  Open the new layer set and ungroup the curve adjustment layer. Activate the layer with the snowflakes. 
3.  Make the flakes look closer to us by doubling the scale: Edit -> Transform -> Scale and set the scale to 200% using the boxes at the top of the screen. Again, make sure you click on the little link icon between the width and height boxes.  
4.  Regroup the Curves adjustment layer with this layer and you’ve something like this: 

 

 
 
Repeat this set of steps using this newly created layer set as the basis. It’ll add another level of depth closer to the viewer. You can do this as many times as you want, but a total of twice should be sufficient, producing something similar to this: 
 

 

Page 7: As the Snow Blows

If you followed this tutorial to the letter, you'll have five snow layer sets named (in order of “farthest” to “closest”): 
- Snow copy 2 
- Snow copy 
- Snow 
- Snow copy 3 
- Snow copy 4 
 
Use Filter -> Blur -> Motion Blur… on the “snow” content layers within each layer set to increase the suggestion of movement and to better integrate the snow into the image. Using larger distance values for motion blur makes a layer more transparent. Since the flakes in the far layers are smaller, you’ll want to blur them less so they won’t disappear. You’ll also want to use different Motion Blur angles for each layer to add to the random appearance. These are the only rules of thumb for using Motion Blur on the snow. Below are the values I used. Play around with them until you find something you like. 
- Snow copy 2, Angle: -70 degrees, Distance: 1 pixels  
- Snow copy, Angle: 70 degrees, Distance: 5 pixels 
- Snow, Angle: 90 degrees, Distance: 10 pixels 
- Snow copy 3, Angle: 80 degrees, Distance: 30 pixels 
- Snow copy 4, Angle: -80 degrees, Distance: 60 pixels 
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Using these values produce an image that looks like this: 
 

 

Page 8: Final Touches

The picture’s still too bright and cheerful. Snowfall usually sucks the colors right out of the day. We can do the same here in two steps. 
 
First use a Curves adjustment layer to flatten the highlights: 

 
1.  Activate the layer immediately below the “Snow copy 4” layer set. 
2.  Layer -> New Adjustment Layer -> Curves….  

 

 
 
Adjust the curve so it looks kind of like this: 
 

 
 
The picture should look like this: 
 

 
 
Finally, desaturate the picture a bit with a Hue/Saturation adjustment layer. 

1.  Activate the topmost layer or layer let. It should be the “Snow copy 2” layer set if you’ve followed this tutorial exactly. 
2.  Layer -> New Adjustment Layer -> Hue/Saturation…. 

 

 
 
Change the saturation level to –20: 
 

 
 
The (final) picture should look similar to this: 
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I hope this tutorial was helpful. If you have trouble following it, send me an e-mail and I’ll try to help you out. 
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How to spiff up yours avatars  
Animated gifs for beginners  

By Phantazmo  Paginated View 

This tutorial, my first one, is how to animate an avatar. I use PSP(3.1) and GIF Construction Set Pro, by Alchemy Mindworks. I can't help with other programs. 

Page 1 : Image selection and prep.

I try to choose an image that would be funny if it moved. For this tutorial, I am choosing a Bobblehead. Then I clear away the excess image and put it in a square frame.  
 

 
 

 

Page 2: Starting the motion

Next step, choose the part you want to move around, and select it in a new window. Then, for the sake of the tutorial I made an extra copy, rotate the head slightly. I used 15 degree rotation. Repeat the same process for the right side tilt. 
 
 

 

Page 3: Off with his head!

Then, we need to have a "blank" canvas. Making sure you have your files backed up, remove the head from the orginial pic. I just used a big ol' white circle, use whatever you want, just make sure the head is gone. 
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Page 4: Making them move. 

Now we make three different images, each with the head at a different angle. The reason I removed the head is to facilitate adding the two tilted heads.  
 
 

 

Page 5: Size is everything.

Now, we need to have everything sized 125x125, preferably as GIF format.  
 

 
 

 
 

 

Page 6: Making magic

I like GIF Construction set because it is very easy to use. I haven't tried any other programs, so you're on your own there. You should get the basic idea though.  
 
Step 1: start the animation wizard, make the images loop indefinately, and choose your interval speed.  
 
Step 2: I named the images a1,a2, and a3. A1 being the center head image. When choosing the images, start with the center, then the left, back to the center, and then the right. ** Don't put the center image last, because it loops, and there would be two center images in a row, and that would look choppy. 
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Page 7: Almost done!!

Finally, start the animation, and see how it runs. If it moves too slowly, start it over and fine tune the speed. The more frames you have for movement, the smoother it will look, but the larger the file gets. Luckily there is a nifty feature in GIFCS that supercomresses the files, which could shrink your file BIG TIME. I've had compressions as high as 94% smaller. 
 
 

 
 
 
Page 8: Voila!

There you have it. My first tutorial. Hope it was usefull, and if you have any questions, just ask me. 
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Airbrushing an Image in Photoshop or PaintShopPro  
Easier than it looks. Honest!  

By CardinalCyn  Paginated View 

Ok, you asked, you got it, but I have to warn you, this is my first tutorial, so it could very well suck. The purpose of this tutorial is to give you the basics of airbrushing a drawing from start to finish in Photoshop or PaintShopPro. 

Page 1 : Getting Started

This tutorial will basically show you how to start with this : 
 

 
 
(click for full size image) 
 
and end up with something like this: 
 

 
 
(click for full size image) 
 
although, for purposes of this tutorial, I recreated the image in Photoshop LE to get useful screenshots, rather than try to pick the original .psd apart to show what I did, so the final image will be slightly different than this one. The tutorial is done in Photoshop only because that is the more commonly used program used here; the original was created in PaintshopPro v6, and can just as easily be done with it- most everything used works the same in both programs.  
 
You need to know very few techniques for this tutorial-- airbrush, smudge, layer masking, and layer blend modes. Thats pretty much it. You already know how to do all that stuff, but I'm going to overexplain it all anyway, so let's get started. 
 

Page 2: Setting up your layers

Your first layer is blank. Its best to start with white for contrast; you'll change it later, and you could make it green, or blue, or whatever, but don't start with a dark colour, or you wont be able to see your line drawing clearly on top of it. The second layer is the line drawing. You'll set the blend mode to Multiply.  
 

 
 
Duplicate this layer, and set it to Color Burn. Now go back to the first linedrawing layer, and add a new layer, Normal mode, so that it is sandwiched between the two line drawing layers, like so:  
 

 
 
On one of the line drawing layers, select the contour of the line drawing, (Yes, you can do this very quickly by tapping an outer line with the (gag) magic wand. Shutup, there's no shame in it, it's a line drawing for pete's sake, it doesnt have to be subtle. Fine, just spend a half an hour going around it with your polygonal lasso, see if I care.) go to Select> Inverse, then switch to the colour layer. Add a mask to this layer. In PSP, you'd hit it with the wand, Select>Invert, switch to colour layer, then go to Masks>New>Show Selection. 
 

  
 
Now copy this layer, five times. Name the copies "skin", " hair", "clothes" and "gun" if you are writing a tutorial for other people, otherwise, just leave them as "copy" because, heck, you can remember which layers got what on it without switching back and forth 500 times can't you? Yeah, me neither, but I do it anyway.  
 

 
(in Photoshop) 
 

 
(in PaintShopPro) 
 
Ok, ready? Cause now we're to the fun part. 

Page 3: Skin layer

Click on the skin layer, and make sure you are editing the image, and not the mask. Pick a big brush, a light skin tone, and start colouring. The whole thing. You dont have to worry about getting good coverage in areas that will be covered by clothing or hair, but do try to overlap a little. When you've got a light tone pretty evenly down, switch to a smaller brush, and lower the opacity to around 10 percent. Pick a peachy tone, and hit the contours of all the shapes with it . Then switch to a darker tone, a darkish brown, and hit the darkest shadow ares with it, just outside where you want the shadow to go. Be sparing, and dont worry too much about shadows at this point. You should end up with something like this:  
 

 
 
Now, you'll get out your smudge tool, and using a light touch, (and yes, thats important, don't get wacky with it) gently drag the shadow colour up along the contours of the shadowed areas, and the lightest colour along the highlight areas.  
 

file:///C|/Worth1000/55.htm (1 van 4)13-6-2006 23:18:50

http://www.worth1000.com/stories/stats.asp?uid=2039
http://www.worth1000.com/tutorial.asp?sid=161007


Worth1000.com | Photoshop Contests | Are you Worthy™ | tutorial

 
 
It should end up looking something like this: 
 

 
 
Gaussian blur it, as much or as little as you need to to smooth it out.  

Page 4: Clothes and hair layers

Now you are ready for the clothes layer. Yes, you should put clothes on her. Otherwise, you can't post it at Worth for us all to enjoy. Since clothing is more likely to be all one colour than skin, you really only need two colours for this layer, a medium tone, and a dark. Work it the same way you did with the skin tone, keeping lighter shades to the inside, darker at the contours, smudging the darks into to dark areas, and subtly drawing out paths for your highlights to hit later. You'll end up with something like this: 
 

 
 
which is really sloppy, so you'll want to mask out the overspray before you move on to hair.  
 
You'll start the same way for the hair that you did for the skin, choosing three basic colours to work with; a light, medium, and a dark, defining the basic shape of the hair with light and shadow, like this:  
 

 
 
You may need to edit the mask for this layer before you start- I masked out a bit too much of the hair area in mine, and had to put some of the visible space back. 
 
At this point, turn down the opacity on the uppermost line drawing layer, so you can see the hair more clearly. Then, go back to the hair, and pick a tiny, rather strong, smudge brush. Start sketching the hair texture, pulling the dark into the light areas, and back again to follow the curves of the shapes in the line drawing, and the lights and darks you've already defined. If you have a tablet, this is an excellent use for it- it really does go much quicker, but it can be achieved with a mouse too. You'll just need more practice to get smooth, flowing lines. You should end up with something like this  
 

 
 
With the uppermost line drawing layer off, it should look something like this  
 

 
 
Now you can clean it back up by masking out your over spray, using your mask to draw in a few wispy ends here and there. Again, you'll love your tablet for this, and wish you had one if you don't. 
 

Page 5: Gun layer

For the gun layer, you'll lay out your lights and darks as you did in the clothing layer, but we want a strong contrast here, to make it appear to be shiny. Basically, you want to sweep your lighter colour down the middle, and your darker colour along the edges, at a lower opacity, making sure to add shadows near the back of the gun, where is it partially obscured by her hair and her... er... bodice. For the reflections, select out each plane of the gun seperately, and smudge a brighter highlight down the center of each light area, then invert your selection, and shadow beneath it, sorta like this:  
 

 
 
Make sure to cast a bit of a reflection on the back side of the gun, as well, because a reflective object picks up ambiant light as well as from the light source direction. If that's a blatantly obvious thing to say, I apologize for insulting your intelligence; I'm not particularly good with weapons, straight lines and angles, so for me, this is mostly just trial and error; I just attempt to shade it like I think it would look, and once I get it sorta looking right, I save it, and move on. Yes, I know, that's ever so useful. Sorry. Another useful technique for getting smooth, straight reflections is to use motion blur, set to an angle that parallels the plane you are attempting to make look reflective. I skipped that step with this one (because I was rushing, and it shows), but I did use it in the original image. 
 
Move the gun layer down now, beneath the skin layer. If you've been following this tutorial carefully, according to my instructions, you've left a huge mess on the skin layer, and now you'll have to go mask that out. Then you can clean up the mask on the gun layer, and with the top most line drawing layer turned off, it should look something like this:  
 

 
 
Pretty rough, but we're getting there. 

Page 6: Highlights and shadows

Now go back to your forgotten colour layer, the one that is empty except for your mask. Dupe it twice, and name the new layers "shadow", and "highlight". Bring them both to the top of your sandwich, right under your topmost line drawing layer, shadow below highlight. Start with your shadow layer, select the area you want to shade, and spritz a dark brown shade in, at a low opacity, where ever it needs to be darker, or you need a sharp line.  
 

 
 
Smudge your shadows into place, and add a gaussian blur of about 2 to soften them, and set the layer to multiply (about 60 percent opacity, ymmv).  
 
On the highlight layer, pick a light shade with a bit of yellow, low opacity, and bring out her curves. Add a glow where ever the light would hit, and keep it brighter on the harder objects, such as boots, and gun, than it would be on say, her face or arms. Go nuts with it, really make her shine. People like shiny stuff. Gaussian blurr it to soften all your edges, then go back with your mask, and give your highlights definition where they should be sharper, such as on her nose, her boots, along the edges of limbsand on the gun. Set the layer to Screen, at about 50 percent. Now duplicate this layer, and set the new one to Dodge, at about 20 percent opacity (again, give or take). 
 
This is what you've got so far:  
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Page 7: Facial Details

Now we'll get into some little details, her eyes, lips and nose. Create a new layer, and select a shape that will define the white of her eyes. Fill it with a light grey shade, and hit the edges with a darker grey for shading.  
 

 
 
On a new layer, create the iris. I usually paint them larger than they need to be, and then use free transform to squish them into her eye when Im done. Keep the darkest part of the iris toward the top, where it would be shadowed by the lid, a lighter area near the bottom edge where they would catch and reflect more light.  
 

 
 
Add a black pupil, and a gleam or two to finish it.  
 

 
 
Then use free transform to move it into her eye, and mask off the top edge where it comes over the lid a bit.  
 
New layer, this one for lids and lashes. Black would be too harsh, so go with a dark grey or taupe colour to define the shape of the eyes. Soften at the top outer edge.  
 

 
 
New layer, lips. Select the shape defined by the line drawing, and fill with your main lip colour, a medium tone. Hit the corners of her mouth with a darker version of this shade, then select just the lower lip, and highlight the upper edge with a lighter version.  
 

 
 

Page 8: Almost done...

Turn your burn layer, the topmost line drawing layer, up to about 45 percent. Gaussian blur it to 1.5, to soften the lines, so you can use them for shadows.  
 

 
 
Now you're going to use a mask to vary the visibility of the lines. Some you'll want to keep fairly dark, others you'll want to hide completely, so set your brush to a low opacity, and start blending. It may take some time to get the balance right, just mess with it till you end up with something about like this : 
 

 
 
OK! You're nearly done! Now you will want to save it, and walk away for a while, to let your eyes uncross. And yeah, this is important, because as we've been going through, we've left a lot of little snaggly edges and oversprays here and there, and they are most likely invisible to you by now. So leave it alone, and don't look at it for a while. Then, you've reached what I call the tweaking stage; when you come back to fix it up a little, you'll see much more clearly what you've missed, and its mostly just a matter of cleaning up the masks, but you'll see all kinds of little things to change. You'll want to go back into your shadow and highlight layers, and refine the shapes you've blocked in there, and add a few choice "pops" to the dodge layer, too. Add a background colour, just below the first line drawing layer, and a drop shadow on top of that. I duped the line drawing layer, filled it with black, gaussian blurred it to 2, and set it to multiply at 50 percent, but you could just hit drop shadow if you already know what you are planning to do with it. (I usually don't know til I've messed with it a bit.) This is not really a shadow, its just to make her pop a 
little.  
 

 
 
You could, however, add a more realistic shadow, as I did in the original, by blurring a copy of this layer even more, lowering the opacity, and scrunching it with transform>distort. In PSP, if you hit shift while clicking on a corner anchor to drag, it acts the same way distort does in Photoshop, allowing you to stretch each side of the image independantly of the others, to manipulate the perspective. 

Page 9: Finishing touches
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Ok, now you get to all the little unnecessary stuff I like to do just because I'm squirrelly that way. For instance, I duped the gun layer and set it to Burn at about 15 percent because I didnt like the way it turned out the first time (and still don't, but whatever), and then saved the original 18 layer .psd, without merging anything. I then copied the whole thing into a new image, as a merged image, to pick out all the details with a little smudge brush. 
 

 
 
I then copied that layer, set it to overlay at 20 percent, fiddled with the contrast, and here's what I ended up with. 
 

 
 
All done, honest. That's it. Ok, I'm lying, but it's good enough for the moment :). The best advice I can give you is to take your time, and try not to rush. I sort of rushed this image, and the difference in quality from the original contest image, WorthGirl, is very noticible, at least to me, and I'll likely have to go back in to mess with her a bit more before I'm happy with it. God is in the details-- don't hurry them, but then again... I don't always know when to leave well enough alone:).  
 
Hopefully, this was at least somewhat useful, and took some of the mystery out of airbrushing art in Photoshop for you. As always, there are lots of ways to do anything that can be done, and this is just mine, until I find a better way to do it (and there is *always* a better way). Experiment, have fun, and post your results in the Critic's Corner so we can all ooh and ahh over it. 
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Let's Rock  
 

By jonboy  Paginated View 

How I turned Kate Moss into a statue.

Page 1 : Getting Started...

Let's Rock. 
 
Sorry, bad pun. In order to make my statue, you need two things: a good source pic and a good pic of marble (or any other stone). I thought the pic of Kate Moss was a good one, and I was able to find the marble I needed. 
 
This is the way I do things. The amazing thing about Photoshop is that there are many different ways to achieve the same results. Let's get started . 
 
(The keyboard shortcuts I use are for the Mac. Substitute control for command and alt for option if you use a pc) 
 

 

Page 2: Layers

Ideally, you should create new sets to place the layers in, but since everyone doesn't have that capability, I'm doing this without the use of sets. 
 
Working on the Moss pic as the background layer, duplicate it. This way you still have your original pic in case something goes wrong (which it does). After duplicating it, desaturate the layer which will remove all color tones and it will look like this. 
 

 
 
In order to add the marble, you first must make a selection of the Moss pic. I like to use the pen tool to make certain selections (if you have a Wacom tablet, it makes this much easier).  
 

 
 
Once the path is closed, I save it in the path palette by double clicking it and renaming it. Once it's saved, and the path still selected in the palette, i continue to add to the path by drawing a path around the areas above the shoulders and inside the thumbs, so i have a complete path outlined of Kate and it should look like this with the path visible. 
 

 

Page 3: Masks

Once the path is done, import the marble pic (or just drag the background layer of the marble pic onto the Kate Moss pic) and place the layer above the desaturated layer. Create a layer mask on the marble, command click the saved path in the palette which makes a selection, inverse it, and fill with black and you get this: 
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Change the layer mode of the marble to Multiply. Adjust the opacity of the layer till it looks right to you. In this case I set it to 87% and it now looks like this: 
 

 

Page 4: Kate

It's getting there. It looks good now, but statues don't have real eyes. First, draw another path around her left eye excluding the eyelashes, and save the path (we'll use this path later). Next, create a new layer, use the clone tool and select an area of the marble as your source and clone it around the eye. You'll want to pick an area similar to one already around the eye. 
 

 
 
To do the eye, command click the saved eye path which will make a selection. Next use the clone tool to clone an area of marble inside the selection. 
 

 
 
Next, with the area still selected, create an adjustment layer with the Hue, Saturation, Lightness. In this case, I selected colorized, set the hue to 27, saturation to 12 and Lightness to -21. 
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To make the eye more three dimensional: With the eye still selected, create a new layer. Set the layer opacity to 65%. Using the gradient tool, set to black to transparent, drag the gradient tool from the top down about a third of the way. You do not want to drag it the entire length of the selection. 
 

 
 
With eye still selected keep using the gradient tool around the eye adding more shadow to it. 
 

 
 
To make the right eye, just duplicate the layers for the right eye, link them together, and flip them horizontally and place them over her right eye. There is some fine tuning which needs to be done to complete the eyes totally. I painted in black around parts of the eye, lowered the layer opacity and applied a gaussian blur; used the burn tool on parts of the eyes to make them different along with cloning out a small part of the left eye. You'll want to try different things to get the eye the way you want 
it. 

Page 5: Concluding

To finish the piece, create a new level adjustment and move it to the top of the other layers. Load the selection of the desaturated Kate Moss layer mask. This will kept the levels adjustment from affecting the background pic (which isn't in yet). Working on the new levels adjustment layer, adjust the levels to add more depth to the pic 
 

 
 
I found a pic of the Parthenon, dragged it onto the Kate Moss pic and placed it behind the desaturated layer of Kate. I then used the Hue, Saturation, and Lightness, click colorize, and changed it to green. 

file:///C|/Worth1000/56.htm (3 van 4)13-6-2006 23:18:52



Worth1000.com | Photoshop Contests | Are you Worthy™ | tutorial

 
Working again on the layer mask of the desaturated layer, i used a feathered brush, using black, and just so slightly went out the very outside edges of the statue to soften the appearance and remove any sharp, well defined areas. 
 
That's it. I hope this has helped more than it has confused. :) 
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Short Statue Tutorial - How I made the Arsi Statue Image  
a way of making statues from pictures of people  

By jfiscus  Paginated View 

Hopefully it helps more of you than it confuses. Tutorial for PS7.0; some steps included in this tutorial cannot be reproduced exacly with previous versions.

Page 1 : Source Images

Get yourself a good picture of a person that you want to make into a statue. 
sometimes this can be hard, digital cameras always make this easier, as do news websites. 
 
I started with this man; he was using a pc and his whole body was visible in the image. 

 
I didn't want to do just this man, so I had to find a head to transpose and found a good match with:  

 
 
Another source image you will need to search for will be the pattern you would like your statue to display. I did a seach for 'marble' and came up with this image: 
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Page 2: Layer Sets and Layers

Creating a new layer set for each stage of my work helps me organize large files and steps to complete the project, it also helps if you might need to go back to a certain step in the future to make a correction.  
 
Create a new layer set by clicking on the layer set icon in the layers pallette.  
 
Put all of the source images into this this layer set and call it "layer set 1".  
 
Hide the marble image. 
 
(we'll come back to this later) 

Page 3: Preliminary Masking Work

Masking - I first masked the guy out of the background using varying sizes of brushes. 
I then duplicated the layer (hiding the original) and masked off his head as well. 
That leaves you with this: 

 
 
*** Masking tip I use: Create 1 layer completely filled with white and another completely filled with black. Put these layers below the one you are working on masking out. Make then visible depending on what color you are masking out. This will also help you catch pixels you may have missed while masking if they show up against the harsh background. 
 
Now, you need to mask the head out of the image you selected for your individual. 
 
I rotated the head to match the angle of the neck, then resized with the free transform tool to make the head looks like it is real.  
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Make sure your proportions line up. Transparencies help a lot when lining up layers. 

 
When you are finished with lining it up, your image should resemble this: 

 

Page 4: Duplication and Alteration

Now that all of your layers are still in a layer set, this step will make the rest of the image work a lot easier. 
 
Duplicate the layer set, this will save a version of your work if you notice mistakes here in a moment. 
 
Hide the original layer set, and rename the new layer set to 'Layer Set 2'. 
 
Now, in the layers pallette, view the layer with the head and the layer with the body. 
Control+click on the head layer's mask, now with that still selected; Control+Shift+Click on the body layer's mask.you should now have a selection that encompasses both of their masks. 
 
Now that you have that area selected, select the new layer set. Now, click on the mask icon at the bottom of the layers pallette. Viola - instant mask for all layers in the set! 
 
Now, you will "apply the layer masks" that are on the individual layers. Do this by selecting the layer mask and right-click and the option "Apply the layer mask" will appear. 

Page 5: "Statuifying" - bet that aint in the dictionary

Now, we are going to make this cut out person look like a statue. 
 
Desaturate the head layer and the body layer. 
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Combine these two layers at this time to make editing things easier. 
 
Adjust the brightness/contrast a little to make it look brighter. 
 
Now, duplicate this statue layer. Name this new Layer 'statue overlay' (cause that's what it'll be) 
 
Change the layer's 'mode' to 'overlay'. 
 
Select the "Statue Overlay" layer and go to filters > Stylize > emboss. 
Adjust it to a low number to start out with, it may take a few tries to get this right. 

 
This gives it a few better-defined highlights. 

Page 6: Statuifying Continued

Make the marble (texture) layer visible, move it to the top of the layers in this layer set. 
 
You may have to 'transform' this layer to make it cover the entire statue mask shape. 
Hold down the shift key and select the corner and drag to keep this image from getting too distorted while resizing. 
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Page 7: More Overlays

Select the texture layer and change the mode to 'overlay'. (This mode works great for lots of things!) 

 
Your image should look a little dusty. 
 
Now, duplicate the texture layer. It should look a lot more like a statue and be colorized slightly like the textures. 
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Another step, that is optional is to select the lower texture layer, duplicate it, and go to Edit > Transform > Flip Horizontal. This will vary the texture appearing more sometimes. 

 
You may want to play with the transparency of these texture layers, I set my top layer to 70%, middle to 60%, and bottom to 50%. 
 
Now you have a statue! (hopefully) 
 

Page 8: Further Statuification (optional)

Duplicate 'layer set 2' and rename the new set to 'layer set 3'. 
Hide layer set 2. 
 
Create a new layer on top of all these layers in the set. 
Fill it with white. 
Change your selected colors back to the default black/white. 
Go to Filter > Noise > add noise 
Add a lot of noise. 
Go to Filter > Blur > Gaussion Blur.  
Change the layer's blending mode to 'Soft Light'. 
Adjust the layer's opacity to 50%. (repeat gaussion blur if necessary) 
 
This will give your image the appearance of oxidation or something like that. 
It will also blur some sharp features. 
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Page 9: This Guy Needs a Pedestal

Create a new layer set called 'pedestal' below 'layer set 3'. 
Hide 'layer set 3'  
Find a good source image for the pedestal. 
 
Mask it off of it's background. 
 
Desaturate the layer. 

 
Now, control+click on the layer mask, this will create a new selection. 
Click on the layer set 'pedestal', now click on the mask icon at the bottom of the layers pallette. (this will create a mask for the entire set as before) 
 
Copy the texture layers from 'layer set 3' into the new set. 
 
Move them above the pedestal image. 
 
You should have something resembling this: 

 

Page 10: More Optional Effects

I wanted to add a plaque to the image to reveal the identity of the subject to unknowing viewers. 
 
I made a selection in the shape of the plaque I was wanting. (made by two circular selections joined in the middle with a rectangular selection) 

file:///C|/Worth1000/57.htm (7 van 10)13-6-2006 23:18:55



Worth1000.com | Photoshop Contests | Are you Worthy™ | tutorial

 
Fill this selection with an RGB of 71,71,71. 
 
Create it below the textures as well and it will automatically pick them up/apply them. 
 
I added a drop-shadow (distance of 2, spread of 0, size of 10), a bevel/emboss(depth of 100, size/soften of 0), and satin (mode = multiply, opacity=50, distance+size=11) 
This made it look a little more metallic on top of the bricks and added depth. 

 
 
I then selected a typeface that suited the image and typed the name of my subject. 
 
After that i added the following layer styles to make it look engraved: 
Bevel/emboss - depth=100, size/soften=0, others no change 
satin - mode = multiply, opacity=50, distance+size=11 
color overlay - rgb=71,71,71, opacity=100 

 

Page 11: Adding a BG

Make layer set 3 visible again, and your final image should resemble this: 

 
The layer masks being on the sets will make it easier for you to mask out objects in from of the staute in your image. 
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to: 

 
And the subject: 

 
to: 
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After this, a few touches of the burn tool around the statue's lower edges will help add realism via shadows. 

 
 
You may also want to use the dodge tool around the highlight edges. 
 
I hope this was helpful! 
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Water Reflections  
How I make reflections for boats in water...  

By jfiscus  Paginated View 

This tutorial goes over a 'simple' way to make good reflections. I hope it is explanatory enough - it's my first tutorial.

Page 1 : Source

The first step in any good PS image is finding good source images. I always try to use images that are NOT copyrighted by other people, as it can result in trouble down the line. 
 
For this image I used a photo of my boat that I took while I was restoring it. 

 
 
I found the lake image in a google image search though... 
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Page 2: Masking

Masking is difficult to explain, please refer to another tutorial if you don't have the hang of it yet; but please try to use it instead of erasing - it allows you to add back pieces later if you want them to show up again. 
 
I masked out all the background and stuff around the boat, hopefully your source will be a little better. I also cloned over a few pieces of the trailer that was on top of the boat's hull. 
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Page 3: Transparency

The rest of the process has a lot to do with the transparency of different layers appearing in the water. 
 
Duplicate the (masked) boat layer. 
Hide the lower boat layer. 
Now, select the top boat layer and mask off the hull area which will be under water. 
Unhide the rear boat layer. 
Adjust the rear boat layer's transparency to 25% 
Your image should resemble this: 
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Page 4: Transparency Continued 

Now that you have those two layers of boat, allow the water layer to be viewed. (just to see how it looks) 
If the top layer needs hidden/revealed more to fit the angle of the water, do so now with your layer mask. 
It should look something like this: 
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Page 5: Duplication

Now that you are happy with how your boat looks out of the water, and it's hull is partially visible; it's time to create the reflection. 
 
Select the boat layer that is 100% visible. 
Duplicate it. 
Go to: Edit > Transform > Flip Vertical 
You should have an upside down copy of your boat now. 
Adjust the opacity of the layer to 20-25% 
Now select the move tool. 
Holding down shift, drag the image vertically until it reaches an appropriate position in relation to the boat. 
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Page 6: Depth

We need to remove a little bit of the boat's reflection to account for depth. 
Add a mask to the reflection layer. 
Select the paint brush, and select a large "fuzzy edged" brush. (around 300+ pixels diameter) 
Go over the bottom area in a straight across motion, so that the bottom of the reflection fades out. 
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Also, tweaking the skew of the reflection helps adjust for different camera angles. 
Edit > Transform > skew/distort will help in making the reflection more realistic.  
(i did not do this step in my image, but it will be very helpful in positioning your reflection) 

Page 7: Tweaking

Allow the water layer to be viewed. 
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Now, its time for a little tweaking... 
 
Duplicate the Boat reflection layer and hide the copy in case you are not happy with this next effect. 
Select the boat reflection layer and click: Filter > Blur > Motion Blur 
Blur the layer slightly in the same direction that the waves are flowing, this will help create the effect of it being a reflection. 
 
Other than that tweak it until your heart's content, maybe adjust the transparency to make it more/less visible to fit your image. 
 
Hopefully this tutorial helps! 
 
I used this same method to turn this: 
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Into this: 
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(with a few more steps of course) 

file:///C|/Worth1000/58.htm (10 van 10)13-6-2006 23:18:56



Worth1000.com | Photoshop Contests | Are you Worthy™ | tutorial

How I Made ''Ghostly Sight''  
 

By Jopsa  Paginated View 

How I created a smokey ghost effect in a candle.

Page 1 : Getting all your stuff

First of all, you need this stuff: 

●     Photoshop 
●     Source Pics (I usually get mine from Google Image Search, but there are quite a few others that are quite good. Ditto, for example.)

 
 

For this picture you will need these source pics: 
●     A candle 
●     Some smoke (Invite your friends around and START SMOKING :-D) 
●     Some sort of background, a dark room preferably. 
●     Someone’s photograph (I used myself)

 
 
Now you’ve got all that stuff, start photoshopping! :-) 

Page 2: Starting off

Put all your source images on different layers, and lower the opacity of the face and of the smoke source pic down to about 30%. 
 

 
 
As you can see, the first layer is called “smoke.” That’s actually where you will be working on, so create a new layer and put it on at the top. 
 
You will basically use the rubber stamp, getting some smoke from your source pic and putting it on your “smoke” layer. 

Page 3: Doing your ghost

Keep the smoke source pic invisible until you need it to get some more smoke. The face should be kept visible at all times, so you can place use the smoke as a template, placing the smoke where you think smoke should go, if by some chance you happened to meet a ghost with a tendency to go under burnt-out candles. 
 

 
 
I had some problems with the nose and the mouth, but here are some tips: 

 
●     Start off with a big brush, just putting smoke basically where it should go. Bother with details later. 
●     Remember smoke doesn’t just *finish*, make it fade slowly away. 
●     Even if normal smoke didn’t do this, it’s important that you make the nose and mouth somehow whiter than the rest, so it looks like a nose and mouth. 
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Page 4: Final Touches

Wherever you think you might need it, make your brush smaller and add some touches, like making the smoke “dissolve” into the air, etc... 
 
It’s also important that, from time to time you un-zoom a bit and take a good look from a distance. If it doesn’t look real, keep on cloning!  
 

 
 
If you don’t want your background to get in the way, you can always insert a completely-black background, which is shown on the picture above. Actually, I was going to leave a black background before I found the dark-room one... 
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The Making of JemimaPhobia  
Using mostly basic tools.  
By DerAlt  Paginated View 

How I turned a stack of pancakes into something you probably wouldn't want to find on your plate. ;)

Page 1 : The Originals

I have read several of the tutorials in this help section and find they offer excellent advice on the use of PhotoShop tools, filters and actions. This tutorial will be a little different. To create the Jemimaphobia image I used only one PhotoShop filter, Liquefy, the rest of the work was accomplished using only the basic tools, select, resize, eraser, smudge and paintbrush. In fact, the image was not created in PhotoShop except for the liquefy filter. I used another Adobe program, PhotoDeluxe. This program could be referred to as PhotoShop Lite. It has all the basic tools, some effect filters but none of the special effects and actions that advanced programs like PhotoShop 7 contain. 
 
I think this tutorial will show you that there are alternate ways to accomplish results that may seem to require advanced programs but can be done with a very basic approach using the simplest tools. 
 
To begin: 
I used two images for the post. One for the main shot showing the pancakes and background and one for the gaping mouth. Finding the proper images may be the most important step in creating a compelling final. I spent considerable time searching for images that would not only work well together but also have enough resolution to remain crisp when enlarged. 
 

 

Page 2: STEP ONE

The first step was to distort the upper and lower edges of the top pancake into the relative shape of the jaws of the mouth.  
 
To do this I used the LIQUIFY tool in the PhotoShop filter menu. With the brush size set to 64, I “pushed” the edges of the upper pancake into the approximate shape of the jaws. The exact shape was not crucial since I had some leeway in how much of the jaws I used. Using the existing jaw edge faithfully was not important. 

 

Page 3: STEP TWO

At this point I was finished using PhotoShop. I opened the manipulated pancake image in PhotoDeluxe for the rest of the work. I find this program simpler, and quicker to use. All the tools are easily accessed without going into menus. Just a personal preference. 
I then, using the eraser tool, silhouetted the mouth, resized it and placed it into position on the “opening” in the pancake on a separate layer.  

 

Page 4: STEP THREE

The jaw size was OK horizontally but a bit too large vertically so I selected the lower half of the mouth and moved it up about ¼ inch. 

 

Page 5: STEP FOUR

Using the smudge tool I blended the sharp edges created at the jaw “hinge” when moving the lower portion of the jaw upwards. 

 

Page 6: STEP FIVE

I reduced the opacity of the jaw layer to 50% in order to see through it. Then removed the jaw portion covering the foreground pat of butter with the eraser tool using a sharp edged “brush.”  
 
Restoring the opacity to 100%, I lightened and color corrected the jaw, using Hue/Saturation and Color Balance, to be more compatible with the color and density of the adjacent pancake areas. 
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Page 7: STEP SIX

Creating a new layer at 100% opacity, I airbrushed a dark tone over the top area of the jaw to blend it into the pancake top. The color was selected from a dark area of the pancake “crust” and applied with a very soft large brush. I removed the excess color from the background with a sharp edged eraser “brush.” I find this method quicker and more controllable than using masking. However, obviously you must be on a separate layer. 
I also brushed on, with a smaller soft edge brush, some local pancake color to the left and right sides of the jaw to blend them into the pancake as well. Again I erased any excess color with a soft edge eraser tool. 

 

Page 8: STEP SEVEN

The left and right sides of the pancakes became distorted when the Liquify tool was used in Step one. I selected, from the original pancake photo, and on separate layers for easier control, replacement sections. [Indicated by red dotted lines] I placed them in register over the distorted areas and erased any unwanted image with a soft edged eraser. 

 

Page 9: STEP EIGHT

The fruit on the pancake top also got distorted on the left side and the fruit on the right did not appear to be in the best position. I wanted to create the effect that they had slid down a bit when the jaw opened. Using the same technique as in step seven, I selected two areas of fruit from the original, placed them on separate layers, and erased any unwanted image using a sharp edged and soft edged eraser tool.  

 

Page 10: STEP NINE

We were now left with a piece of existing berry on the top left, flattened fruit in the center and some existing fruit on the right that gave it a cluttered look. On a separate layer, I removed those unwanted areas using a soft paintbrush and local background colors. I then reduced the opacity of that layer to 50% in order to see through it and erased with a sharper brush, all color that covered any area of pancake. Then restored the layer to 100% opacity. 
 
On this same layer, I painted on a better pancake transition on the left side of the jaw. 

 

Page 11: STEP TEN

No monster mouth image is complete without some drooley looking thing dripping from somewhere. I picked up some colors from the right side syrup drips and drew in the compulsory hanging drooley. 
 
I believe this is a simple straightforward approach to solving the “problems” of the original idea. 
Some of you experienced PhotoShop users will undoubtedly see alternative and possibly even more effective ways to accomplish the same thing. However, I’m too old a dog to learn new tricks and I use this very basic approach whenever I can. 
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Laser and Shiny Thing  
A tutorial on how to make shiny stuff look cool  

By Sh3kel  Paginated View 

Lasers, Lightsabres, Neon signs, anything goes with this technique! 

Page 1 : Starting out

First of all, what does this thing do? 
Well, it's quite simple. 
We're going to take something like this: 

 
And have it end up like a real lightsabre - like this: 

 

Page 2: First Thing

You've seen the Picture with the green stick in the last page. Now you're going to see how I got it to shine in a pretty green glow, only to emphasize the fact this thing works for every color out there, I'll make it a BLUE lightsabre. 
 
Well, the first thing you've gotta do is a straight, white line that covers the Lightsabre as accurately as possible. If you cant cover it, make it smaller than the sabre. In this picture, the sabre is 6 pixels thick.  
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Notice I made four copies. This is important for the lighting effects that follow. Now that we've got out line, we can move forward to making it look like it's made out of light. 

Page 3: The shape of things to come

By now your sabre looks pretty lame. It's all, erm, white.  
So, why do you need four layers of white? For blurring, of course! The top Layer will be blurred using the "Blur More" filter. 
The Blade Blur Layer will be blurred using Gaussian Blur 6.0 pixels thick - the same width as the line. 
The 2nd blade blur will be twice as thick, and the third Three times as thick as the line. If you want, you can go on and on and on, until you hit a reasonable limit. 
Eventually, this is what you come up with: 

 
 
This is still ghostly white, but at least it looks like a light beam instead of a white line. 

Page 4: Have you saved yet?!

What do you mean no? 
The following step is where things might go wrong, so you gotta save. The .psd file will keep the layers as they are, and then you proceed ahead and merge all the layers which you previously blurred. It should now look like this: 
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At this point, you may add a "lense flare" effect to the hilt of the Lightsabre to make it look nicer. Note this will work best if added directly onto the hilt, meaning not on the Merged layer but on the background. 

Page 5: It comes to life...

Now starts the real magic. Anyone will tell you the trick with lightsabres is the glow - it has to be strong enough to be noticed, subtle enough to look natural and allow the objects behind it to be seen. How does one accomplish this? Regular techniques call for you to use Neon Glow. We, however, will not. We'll play with the Blend type and the Outer Glow color. 
Select your merged layer and change it to "Screen". Now, right click it and select Blending Options.  
Click Outer glow - it should look like this: 

 
 
By now you can see the lightsabres LOOKS like a sabre. Now comes the cool part - colors. 

Page 6: Crossroads

Here you have two options.  
A) Play with the Color Balance. 
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Move the color balance tabs up - you want Blue, move the midtones and highlights all the way up to Blue.  

 
 
Color Balance, however, has a problem. It will occasionally have little visible effects.  
 
So, we use the second option. 

Page 7: The Outer Glow

If you're here, it means Color Balance dissapointed you, or you wanna try out another method.  
This is the method I personally use.  
 
You probably noticed when you did the outer glow effect that it has a yellowish-color to it. That's what we want to change.  
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By clicking on that yellow square on Outer Glow, a color menu pops up. I selected a pretty Blue shade, and you see the blade immediately takes a Blue glow to it. For purely cosmetic reasons, I'm going to change the Contour to the "Half Round" option. 

 

Page 8: Final Product

By now, this 

 
has become this: 
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And all done in Eight simple pages. But this isn't limited to lightsabres, no sir! 
You can apply it to Logos, People or even Shiny, Shiny Shoes, like this simple version of a Worth 1000 Alternate logo. 

 
 
Hope this tutorial helped you as much as Don Salieri helped me. 
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Using Photoshop to Make Jack-O'Lantern Patterns  
(What to do while the wife has her hands full of pumpkin guts)  

By Jonderson  Paginated View 

So Halloween is coming and you don't have any idea what to put on your pumpkin. Triangle eyes and square teeth? I don't think so. How about putting Aunt Martha's frightful face on it instead? You can, using Photoshop! Here's how!

Page 1 : Introduction

USING PHOTOSHOP TO CREATE JACK_O'LANTERN PATTERNS 
 
This tutorial assumes that you know something about carving complex jack-o'lanterns using patterns. If you don't, then this project will likely be a bit more advanced than you can handle. If this is the case, I suggest going out and getting a simple kit from someplace like Pumpkin Masters, or visiting their website to learn more about it first. You should definitely do something simpler first, in order to get used to working with pumpkins this thin. They break very easily, and usually the only thing you can do when this happens is start over...a very disheartening thing when you have spent a couple hours on the project. For the rest of you gourd slicers, let's begin. 

Page 2: Step One

Step One, is to pick an image to use. Crop out the section you want to use and blow it up to about 300-600 pixels in width, maintaining aspect ratio. As long as it is not extremely fuzzy, and as long as the details are visible, it should be good. The example here is our fealess leader, JaxomLOTUS.  
 
 

 

Page 3: Step Two

The next step is to trace around the the head with a lighter color (almost always white) to outline the hair and other features. Then color in the rest of the background with black. 
 
 

 

Page 4: Step Three

Next, grayscale (or just go b/w) the image. It may also be necessary to adjust the brightness and contrast of the image to make the subject's features stand out.  
 

 

Page 5: Step Four

Next, use "Posterize" at a fairly low bits per channel setting (I used 3 for this one). If you aren't using a program with this feature, simply reduce the number of colors used in the picture to 4. It should start to look a bit more like a regular pumpkin pattern at this point! 
 
 

 

Page 6: Step Five

Now you need to reduce the number of colors in the picture to three (if it isn't already): black, light gray, and white. Use the color replace tool, or just draw over the dark gray parts with light gray. It is sometimes necessary to use the black color in dark gray areas to retain some of the face's features (usually the lips, eyes, and eyebrows). This image didn't really require much of that though...I got lucky. The idea is that when you are done, the white areas are holes in the pumpkin, the gray areas are areas where you will just remove the skin off of the pumpkin (allowing only limited light through), and the black areas are where the pumpkin will remain intact. 
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Page 7: Step Six

Once you have reduced the colors you will need to clean up the image. Remove the speckles from the different areas by coloring over them with the main color for that area, and clean up all the edges. Be careful to not alter the edges so much that you alter the features. 
 
 

 

Page 8: Step Seven

Very important step!  
 
**Make sure their are no unconnected black or gray areas in the middle of a white area! (You don't want to have to suspend a piece of pumpkin in midair!)  
 
**Also, make sure that any thin gray or black areas are thick enough not to break off during carving. You may have to add some sections in order to accomplish this, but do so in such a way as to compliment the image without detracting from its integrity. This is where the artistic ability comes in.  
 
**Finally, make sure that if there is a black area for hair, as in this image, that you outline it in gray as well, in order to keep it distinct from the background when the carving is finished. 
 
 

 

Page 9: Step Eight

Last Step! Your pattern should now look like a black & white version of what the final pumpkin will look like. The only thing left to do is to make a negative image for the pattern. Once the negative image is done, you should remove as much of the black outline as you can, but be careful that you don't also remove a critical section of the image in the process. Clean up the image and make any final adjustments. You are done! Print it off using "Full page" and "Maintain aspect ratio". 
 
 

 
 
 
Page 10: Tips and the Finished Work

Tips For Using These Types of Patterns: 
 
Hollow out the pumpkin and scrape the inside to about 1/2 inch thickness. This is quite thin, so be gentle! When you are done you can alter this thickness to allow for more light to get through certain areas if you so desire, creating a shading effect.  
 
When transferring the design onto the pumpkin, I find it helpful to outline it as I go using different colored markers to differentiate between the different areas.  
 
Remember that the finished pattern is a negative image! You will be completely cutting out the black sections, and gently peeling the skin off of the gray sections. The white sections remain intact. 
 
Peeling the skin for the gray sections is best done with a razor blade and a lot of patience. Remember, pumpkin juice is slippery so be very careful. (Knives+Lubricant=Blood and Stitches!) 
 
Start early and be patient...transferring the image onto the pumpkin and then carving one of these beasts can take a couple hours. 
 
When you are done, the pumpkin should look like this: 
 
Hey look...it's a Jax-o'lantern!! 
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Here is the Mona Lisa, which I did last night (Oct.29, 2002). 
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How to do Spider-Doo  
 

By Binder  Paginated View 

Some masking, some coloring, some copy-and-paste, and a little luck.

Page 1 : Intro

Before we start, I'd like to issue the standard disclaimer that this tutorial is just going to show you the steps that I took to make this image. You might not agree with my decisions, but they worked for me. The great thing about photoshop is that you can reach the same end result a number of different ways. 
 
The tools and techniques we're going to cover are all very basic. With that in mind, I'm trying to write this for the beginner PSer. There will be lots of images showing the step-by-step progression, and I'll include particularly helpful keyboard shortcuts in parentheses where I can. 
 
Please read the other tutorials. They are all excellent. For masking help, see arsi's "Merging" and Ironkite's "Dig" tutorials, and for coloring tips, refer to steveo's "Colorization" tutorial. 
 
Here's what we are going to make: 
 

 
 
We're going to rebuild it from scratch, and then compare our end result to the original to see how well they match up. I'm writing this thinking that you can recreate this image step by step, just as I am doing to write this tutorial, so feel free to play along. I used PS6 on a PC, so all commands will be PC. If you have a Mac, just substitute the command key where I say "ctrl". Let's get to work. 

Page 2: Getting Started

We're going to use three source images: 
 

 
 
 

 
 
 

 
 
 
I got the first two through google adv. image searches (very large, jpg, full color). The Scooby-Doo image is from www.movieweb.com, which is a great site for finding hi-res images from movies. At this time their search tool isn't working and dumps you to an ad page, but you can scroll through their alphabetical index to find the title you need. You might want to bookmark it to use in future contests. 

Page 3: Creating the Title

Originally, this was one of the last steps I did. We're going to do it here because it's quick and easy, and we'll have it out of the way. 
 

 
First, use the cropping tool (key c) and draw a box around the part of the title we want to use, then hit return. Try to get in pretty close. 

 

 
 

By chopping away all those unwanted pixels, we now have the title sitting in a field of fairly uniform black. At this point we could create a layer mask revealing only the letters, or we could use the lasso tool and try to select around each layer. But there's an easier way. 
 

Select the wand tool (key w), and set your tolerance to about 32. Click in the black area outside the letters. Shift-click on any black areas that you want to add, making sure to click inside the letters where there is black, like the loops in the "P" and "D". 
 

I zoomed in to 300% while doing this. You might have to shift-click with the wand to clean up around the letters. If you're zoomed in, the easiest way to maneuver is to hold down spacebar. The hand cursor will appear, and you can move around easily. This works no matter what tool you're using, except for the text tool. When you release the spacebar, you will revert back to whatever tool is active. 
 

When you are happy with your selection, hit delete to erase all the black. Now hit ctrl-shift-i to invert your selection. The letters are now selected, and should look like this: 
 

 
 

Now we're ready to drag it into the spider-man image. 
 

Page 4: Finishing the Title

Use the move tool (key v) and drag the title onto the spider-man pic. Once it is in place, create a horizontal guide because we're going to be moving some letters around. Do this by going to View>New Guide. This menu will appear: 
 

 
 

Select horizontal, and the guide appears at the top of the image. Use the move tool to drag it to the bottom of the letters. 
 

Next move is to get rid of "MAN". Draw a marquee around it and hit delete. 
 

Just so you know, at this point my work space looks like this: 
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With "MAN" deleted, now draw a marquee around the "D". Use the move tool to slide the "D" to where the "M" used to be, holding the alt and option keys as you go. Holding alt and option makes a copy but keeps it on the same layer. Using the same technique, drag two more copies of the "D" over, so that it now says "SPIDER-DDD" 
 

We'll use the eraser to round off the last two "D"s, and that's done.  
 

 
 

If you think this layer is going to be a distraction, you can turn it off by clicking the eyeball to the left of it in the layers window. 
 

Now, let's bring in Scooby. 
 
 
 

Page 5: Scooby meets Spidey

 
 

This source image is huge. I've already cropped it down so that only Scooby is shown, but since we're only using his head, let's again use the crop tool to draw a box around his head. 
 

 
 

Select all by hitting ctrl-a. Now use the move tool and drag and drop Scooby onto the Spider-man image. Because the Scooby source is higher-res than the Spider-man source, Scooby's head is way too big. Hit ctrl-t to activate the free transform tool. Grab a corner and hold down shift to constrain proportions as you bring the corner in. Don't worry about making it *exactly* the same size as Spider-man's head at this point. 
 

 
 

Take a second to look at the two heads side by side. 
 

 
 

We lucked out. They are turned at very similar angles, which is going to make this a lot easier to pull off. There will be some minor angle tweeking and resizing later to make it more convincing. But first... 
 

Page 6: Layer Mask

We need to get rid of all those pixels around Scooby's head. We could use the eraser here, but instead we're going to create a layer mask. Why a mask? 
 

Because it looks better. The eraser can be imprecise and if you remove a few pixels you later want to get back, you can't, at least not without undoing all the work you've done. The layer mask is going to produce better results, so if you haven't tried using layer masks yet, you should start. Don't worry, it's easy. 
 

First, let's add a new layer and place it behind the scooby layer. Hitting shift-delete will allow us to fill this new layer with a color. I chose 50% gray. This whole step is optional, but it might make things easier for you to mask over a single color field than a busy background. We'll trash this layer later. 
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With your Scooby layer active in the layers window, click the "add layer mask" button at the bottom left, second one in: 
 

 
 

Select your paintbrush tool (key b). Limit your colors to black and white, which they should be set to by default since you are in layer mask mode. Paint with black, and you can see the layer below. Paint with white over a masked area, and you bring back the pixels you had masked out. It's that easy. You could mess with using shades of gray, but let's keep it simple. So paint with black around the outside of Scooby's face. Make sure in the layers window that the mask layer is active, and that your brush mode is set to normal and at 100% opacity. Use (key x) to toggle between black and white. 
 

Page 7: Fun With Layers

 
 

Once the mask is done, throw away the gray layer, or move it to the bottom of the layers window. Click the scooby layer (not the mask layer) and switch your brush mode to color. Use the eyedropper (key i) to select one of the darker shades of red from Spider-man's uniform. I used a color with the following RGB values: 
 

R 202 
G 4 
B 5 

 
Paint over Scooby's face, avoiding the eyes, nose and mouth. Since you have a layer mask, you don't even have to worry about painting outside the lines. The end result is not going to be a perfect match color-wise, but that's okay. We're just roughing things out at this point. 

 
 

 
 

Now we're getting somewhere. Use the move tool to place Scooby's face over Spider-man's face. If we reduce the opacity of the scooby layer to 50%, we can see just how the two faces match up. 
 

 
 

Notice that the curve at the top of Scooby's head matches quite nicely with the curve of Spider-man's head. Also the outline of the inside of Scooby's left (our right) eye is along the same angle as the one line of the webbing on Spider-man's face. These are going to be the two points where we will focus when we determine the final placement of the scooby layer.  
 

First, we need to get the size and angle right. Use the transform tool (ctrl-t) to shrink Scooby's head a little more if necessary. With the transform tool still active, rotate Scooby's head a little bit counter-clockwise, paying close attention to the alignment of the eye and the top of the head. 
 

Page 8: Back to the Mask

Now it's time to get some of that web pattern from Spider-man onto Scooby's face. In the layers window, click on the mask on the scooby layer. Select the paintbrush and make sure it is in normal mode and at 100% opacity. If you paint with black, you will reveal the Spider-man layer below, and the webbing appears to be on Scooby's face now. Play with the layer opacity settings in the layers window as you do this, bringing it up to 100% to see the full effect, and working at a lower opacity to paint the mask. I found an opacity setting of 70% about right for the painting part. 
 

Don't paint all the way up to the mouth and nose, but go ahead and get right up to the eyes. At this point, you might realize that Scooby's right (our left) eye also comes close to matching up with a line of the webbing. So let's mask that part out as well. Right now, the face should look something like this: 
 

 
 

Now switch the brush opacity to 35% and mask out the rest of the area beneath the nose and around the mouth. The webbing is very white here, but by retaining some of the red in the scooby layer, we manage to tone it down. 
 

 
 

Now take a moment to appreciate how lucky we are. Scooby's right eye and his nose cover Spidey's one big white eye almost completely. Unfortunately, that other, even larger, big white eye needs to be taken care of. Let's take care of it then. 
 
 

Page 9: Eye Repair

This is going to be a bit of a chore, but stick with me. We're almost done. 
 

Turn up the opacity on the scooby layer to 100% and then click the eyeball icon to the left in the layers window to make it disappear. Activate the spider-man layer by clicking on it. 
 

Use the polygonal lasso tool (key l, shift-l to scroll through the different lassos) to select portions from other parts of Spider-man's face that can be used to cover the eye. This isn't going to work for the entire eye, but for now we can cover part of it this way. When you have selected an area, use the move tool and alt-option drag the selection where you want it. Use the transform tool to rotate it into place. 
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I could only get this to work convincingly along the edges of the eye. We're going to have to take the middle and fill it with some red, and then add the webbing later. 
 

The method is the same, but this time use the lasso to select an entirely red area with no webbing. Use the alt-option move technique to copy the selected area over the white of the eye. If the area you selected is smaller than the white area, then drop and alt-option move the selection a few times to fill the space. You'll probably have to use the transform tool to manipulate your selection to the right size to fit the white space. 
 

If you click the eyeball next to the scooby layer, what you have should look like this: 
 

 
 
 
 
 

Page 10: The Finished Eye

Same method on recreating the webbing. If you haven't been zooming in yet, at this point you will have to. I went in as far as 900% to finish the webbing. (remember the spacebar tip for maneuvering). 
 

Keep the scooby layer visible but click back to the spider-man layer. Select parts of the webbing that aren't too white and match up well with the surrounding webbing. Use the transform tool to rotate your selection and skew/stretch/etc to fit the area. Don't stretch too much, or it will look blurry. Use the same alt-option move method from before. 
 

 
 

Once you have all the web-lines where you want them, there's just one small hurdle to leap and a few finishing touches, and then the finish line! 

Page 11: Cheek and Jowl

That one area of his face needs some web. We can't mask it there, because the layer beneath his jowl is a city street. 
 

Time for that polygonal lasso again. But first we need to make a copy of the spider-man layer. In the layers window, drag the spider-man layer to the "create new layer" button. It's the same one we used to make the gray layer earlier. 
 

 
 

Rename this layer "cheek" or "jowl", and select a region of his cheek larger than the area where we want to place it. Don't worry about shaping it to fit the jowl, we'll do that later. Just try to find a curve in the webbing that might match up on the other side of his face. Use the lines of his barely discernable whiskers as your target. 
 

Once you have your selection done, invert it by hitting ctrl-shift-i. Hit the delete key and all you have left is this little bit of cheek area. Hit ctrl-d to deselect since the cheek is the only part of the layer now. Move this layer in the layer window to the top, and reduce it to 80%. I flipped it horizontally by going to Edit>Transform>Flip horizontal, but you might not have to do that. 
 

Move this layer over Scooby's jowl, and create a layer mask like we did earlier to remove the unneeded parts. Make sure your paintbrush is at 100% opacity, normal blend setting. Paint with black over the area you want to hide. It might help to toy with the layer opacity setting to get it right. Your layers window should look like this: 
 

 
 
 
 

Page 12: Finishing Touches

Let's put this baby to bed. 
 

If you are a little compulsive like I am, you're going to want to fix some of those web lines. I did it by zooming in way too far and copy-pasting single pixels on the spider-man layer to define the lines a little better and make them less blurry. More than a bit tiresome. 
 

There are easier fixes. That little smidge of Spidey's right eye (our left) has to go. With the spider-man layer active, use the clone stamp (key s) to replace that offensive bit of white that is showing. Select pixels from the street to cover it. 
 

I used a filter to get the highlight on the nose, but this is such an afterthought you might not want to bother. However, it helps in making the ears match up color-wise if you put a little shadow on them. I'll show you how I used it on the cheek layer, and the settings were similar on the rest of the layers, but I only got there through experimentation. Go to Filter>Render>Lighting Effects and the following menu will appear. As you see it, it is set to the settings I used on the cheek layer: 
 

 
 

Alright. I also added some more color to the ears. That red wasn't quite right, so if you are playing along, switch your brush opacity to 40% change the setting to overlay, and find a red that matches a little too well, and paint those ears. 
 

Looks like we're done. Let's make the title layer visible by clicking the eyeball icon next to it and ask the question: How did we do? 
 

Original: 
 

 
 

And here's the one I just made for the tutorial: 
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They look awfully close if you ask me. Yeehaw. 
 

That's it. Done. I tried to keep the words to a minimum, but I wanted to explain everything as thoroughly as I could, so excuse me for rambling on a bit. 
 

Huge thanks to Kulstad, Ironkite, and Arsi for offering their help when I couldn't figure out how to put this together. I hope this tutorial was helpful, or at least a decent insight into how I used simple tools to make a complicated image. 
 

Keep chopping away and have fun! 
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Organization  
A quick tutorial  

By JaxomLOTUS  Paginated View 

This guide shows you how to organize your photoshop file and environment. It's quick and dirty, but well worth reading.

Page 1 : Preface

Just a note: I don't have a Macintosh to work with, so some commands may be different. I'll trust if you already have a Mac you know enough about what you're doing in Photoshop to figure things out. 
 
A few years back my college newspaper sent me on a conference for newspaper editors. Besides for the non-existant all-night partying for which I did not take part of or get drunk because that is against school policy, there were a few learning sessions, in which the top journalists and editors in the field would come speak to us and teach us. 
 
One of the lectures was the photography editor for National Geographic, who took us through some advanced tricks in photoshop. His whole lecture took an hour, but I ended up walking out of that session with more knowledge of photoshop than I ever learned from one of those self-help books. I'd like to impart that knowledge to you today. 

Page 2: Background Organization

This may sound rather dumb, but organization is vital to making a great photoshop. For starters there is the default setting that Photoshop opens up to: 
 

 
 
As you can see, most of the tool pallettes open up on the side...and I bet you won't even use more than 2 of them. Remove any you don't need (the navigator) and shrink the rest down (double click the blue area on pcs) and lay them across the bottom of the screen like so: 
 

 
 
As you can see, you now have ALOT more room to work with, and your pallettes are still available if you need them. 
 
Also, this tip courtesy of [steveo], pressing the TAB key in PCs will give you the entire desktop to work with. 

Page 3: Layer Organization

Organizing your psd files are even more important that having a clean background space. 
 
For starters you should name your layers. Simply rightclick on your layer in the layers pallette and choose layer properties. Then you can change the name. This is very useful (and vital) when working with many layers. 
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Another important thing to do is to organize your layers in folders. This will allow you to affect changes to all of the layers in any one folder at once. For instance, you can move all of the contents of a folder at once, simply by dragging a folder around. You can also hide all of the contents of a folder at once, by clicking the eye. 
 
To create a folder, click on the folder button on the layers pallette menu. Then right click (PCs) on the folder to rename it it (Choose LAYER SET PROPERTIES). When your folder is ready, drag and drop the desired layers onto your new folder. The folder should highlight blue and then the layer will appear indented beneath it. 
 

 
 
You should organize all of your layers, no matter how small, in this manner. This is especially useful for going back and making easy changes later. 

Page 4: Final Notes

Duplicate your images in stages and save them. It's useful to organize your computer like so: 
 
Set a general folder for all your editing jobs > 
Beneath it, make new folders for the different sites / jobs you make them for > 
beneath it, make a new folder for each entry you make 
beneath that, make 2 folders: 1 for the final product and 1 for the stages. 
 
Inside that stages folder your images should be saved like so: 
 
#######-1a.psd 
#######-1b.psd 
#######-1c.psd 
....... 
#######-2a.psd 
 
and so on. Obviously the idea here is to save your work in case of a computer crash - but also so that you can go back to another starting point easily should you mess up badly somehow. (And of course, it's much easier to write tutorials when you have stages to get back to ;) 
 
Like I said - this was quick and dirty, but take these ideas to heart and you'll see just how much more efficient your photoshopping will become. 
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Creating 'Spin Cycle'  
A Step-By-Step Tutorial  

By Isam  Paginated View 

Step-by-step guide to turning a picture of a run-down shack into a raging storm about to obliterate a prairie home.

Page 1 : Introduction

As I go through the steps to edit the image, I will also explain some fairly basic techniques. I hope that doesn’t make things drag too slowly for experienced users, but I don’t want to assume too much either. You’ve heard this from other tutorials, but I’ll say it again: I discuss the steps from the standpoint of “I did this or that” rather than “you should do blah blah blah,” because many of the techniques are very subjective and reflect personal taste. You would very likely do things differently to suit your taste and comfort level.  
 
I use Adobe Photoshop 6 on a Macintosh, so some of the tool & menu details may be different if you have another version or computer platform. Refer to the last page of the document for any footnote references. 
 

 

Page 2: Masking the house and landscape

I double-clicked the background layer & clicked “OK” to turn it into a regular layer. Then I created a new layer mask (See Footnote 1) and made the sky and tree branches transparent. When isolating an object from its background, I usually prefer to paint directly on the mask rather than use the lasso tool. I feel this give me more control over the hardness or softness of the edges and the shape of the mask. 
 

 

Page 3: Cloning out the tree

There were still tree branches overlapping the house that I didn’t want. So I zoomed in very close and used the clone tool (See Footnote 2) to remove the branches. In an area that has lots of noisy, contrasty detail like the shingles on the roof, I use a hard-edged paintbrush for the clone tool. I find that a soft-edge brush unrealistically softens the detail along the edges of the cloned area. The only other key is sampling the clone tool in areas that have the same luminosity and color as the destination...and choosing those sample areas as randomly as possible to prevent any patterns from becoming obvious. 
 

 

Page 4: Painting the house

Next, I wanted to paint the undamaged parts of the house so it looked lived-in. To do this, I made three new ‘Color Balance’ adjustment layers (See Footnote 3) above the house layer: one for the siding, one for the trim and one for the shingles (See Figure 1). For each adjustment layer, I made a preliminary color shift which affected the whole house and yard. I then selected the layer mask and filled it with black to hide the color effect. I then painted in the layer mask with white to bring the color back into the desired areas. To make things realistic, I made sure to paint up into the shadows under the eaves even though there was no color to be seen there...but this did darken up the shadow enough to match the color changes that were happening in adjacent areas. After painting the layer mask, I fine-tuned the Color Balance layer to make it look realistic and appealing. 
 

 
 
Color Balance can glaze things over if you have to make a big shift to get the color you want. If that happens, you can try adding a complimentary (See Footnote 4) color or another primary (See Footnote 5) color in the shadows to neutralize it a bit. Since I really pumped up red in the midtones for the siding, I added a little green in the shadows so that the grain of the wood darkened back up, thus adding some depth and desaturating the color enough to look realistic. 
 

 

Page 5: Adding the stormy sky

I had a digital picture of some storm clouds that I was able to use thereby saving myself the aggravation of a lengthy Google search. (I’ve found that good, hi-res storm pictures on the web are aggressively copyrighted.) Although, after the alterations in this image, it would be next to impossible to say whose image it originally was anyway. So, whatever. 
 

 
 
I pasted the clouds into a layer behind the house, and scaled it down to fit. The clouds were too light (See Progressive 4), so I added a new ‘Curves’ (See Footnote 6) Adjustment Layer to darken them up. It has been my experience that many people prefer to use Levels rather than Curves, and this works fine for many basic lightness/darkness, or hilight/shadow adjustments. I’m more comfortable with curves because they can fine tune things to a degree that levels can’t.  
 

 
 
By holding down the option/alt key and moving the cursor across the clouds, a circle appears on the curve, showing where the clouds sit on the curve (See Figure 3). I wanted to darken and increase the contrast in that portion of the curve. So I added two points that bounded the area where the circle indicated the clouds existed. (Note that I orient my curves dialog box so that the hilights are to the lower left and shadows to the upper right. By default, RGB curves are oriented the opposite. To change the orientation back and forth, click the shaded bar with the arrows below the curves graph. See Figure 4.) To darken the clouds, I dragged the upper right point sharply upward to strongly darken the clouds. I dragged the lower right point down just a bit (See Figure 3). The end result is a curve that is very steep in the area where the clouds sit. The steep portion of the curve adds contrast, and that helped make them really punchy, in addition to darkening them. 
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Page 6: Adding wind & rain

To add the illusion of rain, I made a new layer above the house and sky and ran the Render>Clouds filter (Making sure my foreground and background colors were black and white so that I would get a contrasty gray pattern). To this layer, I ran the Noise>Add Noise... filter set to 30%, Gaussian, Monochromatic.  
 

 
 
Then I selected a small portion of the noise layer and enlarged that to fill the whole layer to get some large noise blobs. Next I applied the Blur>Motion Blur filter. I don’t recall the settings, but I angled it so the rain was nearly horizontal, and so the streaks were fairly long (See Figure 5). Finally, I set the layer to ‘Overlay’ (See Footnote 7) mode at 64% opacity. 
 

 

Page 7: Darkening the foreground

The house and landscape were too light by this point, so I added a Curves adjustment layer above the house to darken it and remove contrast. I made sure to group the adjustment layer with the house layer so it didn’t affect the sky. Moving the left curve endpoint strongly upward both darkens the hilights of the image, and removes contrast. I added another point in the middle to put a little contrast back into the house, and darken it’s shadows up some more (See Figure 6). Since I only added one middle point, this adjustment could have easily been done with Levels too, but I default to curves, so there you go. 
 

 
 

 

Page 8: Darkening the horizon

At this point, the horizon was too light, and too distinct, and so it didn’t look stormy enough. So I added a new layer between the stormy sky layer and its adjustment layer. I set the new layer to Multiply (See Footnote 8) at 100% opacity. Then using the eyedropper, I took a sample from one of the darker clouds. Setting the paintbrush to a large blurry brush, and a low opacity of around 10%, I started painting the sky increasingly darker as it approached the horizon (See Progressive 8).  
 

 
 
I added another layer between the house layer and its own adjustment layer, set it to Multiply at 100% opacity, took a color sample from the grassland and painted the prairie darker as it approached the horizon (See Progressive 9). 
 

 
 
When using a layer in Multiply mode to darken part of an image, be sure your paint color is a darker, more neutral version of whatever you’re painting on top of or it may not look natural. If necessary, use the eyedropper to sample what you’ll paint over, then click on the foreground color square in the tool palette and drag the circle to a darker more neutral portion of the color map (See figure 7). 
 

 

Page 9: Adding shredded shingles & torn up roof

Now for the carnage. To make it look like the wind was ripping the shingles off, I added a new layer (Normal mode at 100% opacity) between the painted house and the rain and gave it a layer mask. I went to the layer mask, filled it with black, and used the lasso tool to draw the shapes of shredding shingles. (I use the lasso here because I wanted hard edges and sharp corners.) Then I filled the selection with white. Finally, I exited the mask, and used the clone tool to clone shingles into the new mask I just drew (See Figure 8). (Be sure the ‘Use All Layers’ checkbox is checked for the clone tool so that it samples from the original roof which is several layers below. See Figure 9.) 
 

 
 
To make the shingles look curved, I made a new layer above the shingles, filled it with 50% gray, and set it to Overlay mode at 100% opacity. I option(alt)-clicked between the layers to make a Clipping Group (See Figure 10). This causes the bottom layer to act as a mask for the layer grouped above it. That way only the shredded shingles will be affected by what I do on the Overlay layer. Then, using the Dodge and Burn tools set to 7% opacity with fuzzy brushes, I started painting shading and hilights to the shredding shingles so they looked curled over.  
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Using Dodge & Burn on a 50%-Gray Overlay layer is something that is very useful for making subtle tone changes to an image. If you use Dodge and Burn on the image itself, you have fewer options to correct your dodging and burning later. By using the separate layer, it is easier make fixes since your underlying image isn’t actually modified. 

Page 10: Adding flying tree

I went to Google and searched for a tree that I added on a new layer beneath the rain. Since the original tree image was silhouetted against a bright sky, I opened up curves and lightened the sky until it turned white. Then I painted white on anything that wasn’t part of the tree (See Figure 11), painted jaggies into the bottom of the trunk and turned the layer mode to Multiply at 100% opacity. Since Multiply sees white as transparent, the tree is the only part that shows up, and blends into the cloudy sky. This was much faster than trying to mask the tree from its background with the magic wand tool or whatever, and it looks more natural. Although, this trick wouldn’t work if the tree wasn’t so dark. 
 

 
 
To make the tree look like it’s moving, I duplicated (See Footnote 9) the layer, and used the Blur>Motion Blur filter, set to the same angle as the rain but a little shorter in length. Then set the layer to Multiply at 57% and moved the blur so that the trail only came from behind the tree. 

Page 11: Adding flying boards & wagon wheel

To add the flying boards, I used the lasso tool to select portions of the side of the house, and copied them onto a new layer set to Normal mode at 100% and put it between the house and the wind. Since the copy & paste didn’t pick up the Color Balance adjustments I’d given the house, I had to reapply the same Color Balance settings to the wood to make it look like it came from the house. I didn’t use an adjustment layer for this. I just went straight into Color Balance and did it. Then I applied Blur>Motion Blur to the wood in the same direction as the wind, but a very short distance. Since a couple of the boards overlapped the house, the two-layer (sharp & blurry) approach I took with the tree wouldn’t work, so I left them as-is and it seemed to work. 
 

 
 
I did the same thing with a wagon wheel that I found on Google and masked out from its background. 

Page 12: Adding flying object shadows

To complete the illusion that the boards and wagon wheel were flying in front of the house, I added a new layer set to Multiply at 64%. Then, sampling colors from the house or yard where the shadow would hit, I painted shadows in with a soft brush.  
 
Painting shadows takes some thinking to figure out how the shadow will lay down depending on whether it’s on a wall, or on the ground, or wrapping around some object. There is a science to it, but who has time for shadow science when you’ve got to spend all your time searching for good resource images? The best thing is to just pay attention to shadows when you’re away from your computer and walking around in meat-space to get a feel for how they fall. 
 
I also took the opportunity to paint some very narrow shadows along the edges of the flying shingles. 
 

 

Page 13: Adding debris

I added a debris layer (Normal mode at 100% opacity) below the rain layer, and using a 2 pixel-wide paintbrush, I drew in bits and pieces of dark green-gray crumbs in the sky. I used Blur>Gaussian Blur set to about 0.3 pixels so they didn’t look so penciled-in. I duplicated the layer, and used Blur>Motion Blur in the same direction as the wind and about the same blur distance as the boards. The sharper of the two layers was too dominant, so I went back to it and set the layer opacity to 76% to tone it down. 
 

 

Page 14: Adding humanity

The clencher for the image was that I wanted somebody running or diving through the door. I lucked out on Google to find a guy jumping in the air with his arms spread out. It looked perfect for him to be holding onto the door frame. So after masking him out from his background, I duplicated his layer. On the top layer I chopped off his legs. On the bottom layer I chopped off his upper body. Then I repositioned the two layers so that his torso was a lot shorter so it looked like he was being pulled outward rather than floating vertically. Then I merged the two layers together and masked off his hands (See Figure 12). 
 

 
 
To look like he was positioned partially inside the door, I added another Curve adjustment layer and grouped it with him. I raised the hilight side of the curve to darken him up to mimic a shadow. Then I painted the mask so the shadow was concentrated mainly on his upper body and his legs (See Figure 13). I learned at this point that this seems to be a better way to do shadows than the Multiply-layer method I had been using. 
 

 

Page 15: Adding broken glass & glints

The windows needed some broken glass, so I added a new layer set to Normal mode at 15%, filled it with white, and added a layer mask and filled that with black. I went to the layer mask, used the straight-line lasso tool to draw in jagged glass, and filled the selection with white to allow the white-filled layer to lighten the background behind the glass. To make it look like the glass was reflecting the clouds in the sky, I took a large soft brush, set the opacity to 7% and brushed in black randomly on the layer mask to vary the shading in the glass (See Figure 14). 
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I added one more layer set to Normal mode at 100% and used a 1-pixel wide paintbrush to draw glints of light on some of the edges of the glass. Here, it was helpful to use a Wacom tablet so that the narrow lines could vary in opacity and make the reflections look more realistic. This works without the tablet, you just have to take more time to build up the fainter streaks of white and mix them with the brighter spots. 

Page 16: Adding more rain

It seemed like the rain wasn’t showing up very well across the face of the house and the yard. So I duplicated the rain layer and sharpened it. This made it harsher so it showed up better, but it still wasn’t enough, so I changed the layer mode to ‘Hard Light’. Now it showed up great, but it covered up too many important details, like the guy in the door, and the shattered windows. So I added a layer mask, and used a very large soft brush set to an opacity of 15% and started painting black into it to hide the hard rain from the critical house areas (See Figure 15), as well as hiding the sharper rain in the sky where the first wind & rain layer already looked good enough. 
 

 

Page 17: Final touch-up

Some portions of the house and yard still looked too bright, so I added a final layer filled with 50% gray to the top of the layer pallet and set it to Overlay mode at 100%. I used the Burn tool at 7% opacity with a large soft brush to darken those portions up (See Figure 16). 
 

 

Page 18: Footnotes

1. At the bottom of the layer pallet, click on the button, to add the mask to the currently selected layer (See Figure 17). The mask thumbnail will appear to the right of the layer thumbnail. Click on the mask thumbnail to modify it. Painting black on the mask makes that portion of the image transparent. Painting white shows the image. Shades in between produce varying degrees of transparency. 
 

 
 
2. The clone tool (rubber stamp) is used to copy portions of an image to another area. To determine which area you will copy from, move the cursor there, hold down the option/alt key, and click. Then when you clone in a new area, it will begin referring to the area where you option/alt-clicked. A small cross will show what portion of the image you are sampling (See Figure 18). 
 

 
 
The clone tool has two modes: ‘aligned’ and ‘non-aligned’. (In Photoshop 6, the ‘aligned’ checkbox appears in the tool menu when you have the clone tool selected. See Figure 19.) ‘Aligned’ means that the sampled area moves in the same direction and distance as your clone brush as you continue clicking and painting. ‘Non-aligned’ means that each time you release the mouse button and click again, the sample area returns to the point you first sampled. Aligned cloning tends to produce more natural results because it paints a continuous image no matter how many clicks you make. But non-aligned cloning can be useful when you don’t have a very large sample area to use. You just have to be very careful because it’s easy to produce a pattern and scalloping in the cloned area. 
 

 
 
3. Adjustment layers allow you to apply curves, levels, hue & saturation, color balance & other adjustments to the image without actually changing the values in the original image. To make an adjustment layer, go to the layers menu, to ‘New Adjustment Layer’, and select the adjustment mode you want to use. When the ‘New layer’ menu comes up, you have an option to ‘Group With Previous Layer’. If you group it, it will only modify the layer you had selected. Otherwise, it modifies everything below it (See Figure 20). 
 
Each new Adjustment layer automatically comes with a layer mask already created. You can paint varying shades on the layer mask to determine which portions of the image are affected by the adjustment. (Black hides the effect, white shows the effect.) 
 

 
 
4. Complimentary colors are colors that are opposite each other on the color wheel (Red - Cyan, Green - Magenta, Blue - Yellow). Complimentary colors that are placed next to each other in an image produce strong contrast. When these colors are overlapped or mixed together, they tend to produce neutral colors. 
 
5. There are two sets of Primary Colors that Photoshop is concerned about. Additive Primaries are Red, Green, and Blue. Subtractive Primaries are Cyan, Magenta, and Yellow. 
 
6. Curves chart the lightness and darkness of an image along an adjustable line. You can lighten or darken the values of an image by clicking points along the line and dragging them up or down. 
 
7. A layer set to Overlay mode affects underlying layers as follows: Anything lighter than 50% lightens the underlying image. Anything darker than 50% darkens the underlying image. The closer the shades are to 50%, the less they effect the underlying image. 
 
8. A layer set to Multiply mode darkens underlying layers by adding the values of the two layers together. Wherever the top layer is white, nothing is done to the underlying layer. The white portion simply acts as though it’s transparent. 
 
9. To duplicate a layer, drag the layer onto the new layer icon at the bottom of the layer pallet (See Figure 21). 
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Archaeological Dig  
 

By IronKite  Paginated View 

That Famous Ferrous Flying Object, IronKite, revisits how to make a centaur skeleton.

Page 1 : First...

For this tutorial, I will re-iterate what Arsi has said. There is no one correct way to do something, only means to an end. All of us have completely different backgrounds, and most of our Photoshop training has consisted of hours spent alone doing weird things to an image and saying to ourselves “Why doesn’t his nose look right?” 
 
I will say that I consider one of my strengths to lie in the fact that I’m a looker. I look. I was trained to look at things for hours in Art College, and told what to look for. Always keep in mind, especially when working on a person, that your brain is trained to recognize things that are different, or don’t quite look right. This is how we recognize individuals, by how each of the different characteristics of their visible features affect their face or body. So, if you’re working on an image and something about it doesn’t quite come off correctly, spend some time looking, not adjusting. Let go, trust your feelings. Use the force, Luke… There’s a problem with every image that “doesn’t quite look right” and sometimes we’re unable to see what’s wrong with it, we just know there’s a problem. 
 
What I plan on covering are the different ways that inserted elements can stand out or look ‘funny’ and some of the ways of correcting them, using some examples of things I’ve encountered. I’m not sure if I’m going to be able to cover more than just 1 here and now, but that’s only because I’ve never written a tutorial before. I guess that’s why Jax has made it so you can make more than just one. 
 
So, that having been said, we’re gonna pick apart this little image right here:  

 

Page 2: Hmmm...

Ok, so the first thing you do is you spend hours looking for images that you can use. Obviously the idea that I had was to create a picture of an archaeologist unearthing a centaur skeleton, which was done for the original Cryptozoo contest. For this, I would need an unearthed skeleton in the ground, and a horse skeleton in the same condition. My rule of thumb is to find 3 of each and open them all in Photoshop at the same time, so you can see how well suited each of them are to the other pictures. Discard your 2 least favorite, and you are left with what is workable. 
 
Of course, sometimes you’ll encounter an image that just MUST be used, and the plan of attack is ‘gather as many second images as possible and compare’. Because of the lamentable lack of horse skeleton pictures on the Internet (geez…who do you write to about that?), I was forced to make my human skeleton selection based on the only workable photo I could find. The two photos I chose were: 
 

 
 
Oh dear. They’re not even close. Some people would just automatically reject it, and look for a skeleton that had tones that matched more closely. I decided that the level of detail on the human skeleton and the positioning of everything was sufficient, and I would just have to do something about matching the tones. 
 
First things first, let’s cut and paste a lassoed section of the horse skeleton onto the human picture, since that’s the one we want to use. (I can’t see trying to go the other way, the horse picture isn’t really high quality, and there’s no room for the human portion.) 
 

 
 
Already it looks bleak. The size looks more or less ok, just need to reposition it to make a nice healthy curve along the spine. But the color…dear lord, the color. What was I to do? Is this the end of IronKite? Will he join a monastery? 
 
Find out on page 3! 

Page 3: Hue/Sat

Ok, so we’ve steeled our jaw and decided that we’re going to do this after all. We must get it done and looking good, and we must do it in under 30 minutes, because there’s something on TV you need to see. (A common mistake I used to make early in my Worth1000 career when I was young and foolish…now I no longer have time for TV) So what to do? First, I’ll align the spines and position the horse where I want it to go, more or less. I’m going to forget about erasing (some of us have been drawing on paper for too long to learn something new like Layer Masks) and anything else for the time being. I’m going to try to match the colors, so that the bones, and the ground, all look like they belong in the picture. If your inserted item is more or less monochromatic, always match color before removing large sections of it. Those large sections sometimes give you a larger area of color to look at, and help you make up your mind as to whether or not you’ve matched the color precisely. 
 
And the tool you use to match color? HUE/SAT!!!! This tool gets used by me every single time I’ve cut and pasted anything. It’s the greatest thing in the world… 
 
You should always have it in preview mode so you can look at the changes as you make them.  
 

 
 
When the selection is set to ‘Master’ then all of the changes affect the entire selection of the layer you’re on.  
 
‘Hue’ adjusts the actual colors, you can go from one end of the spectrum to the other. So for instance, if you had an image that was yellow/blue, you could slide the bar a little bit in one direction and turn it to a orange/green image, or the other direction to produce a green/purple image instead.  
 
‘Saturation’ is the amount of color within the image itself, its intensity. Sometimes you want a hint of color, sometimes you want the color to burn your retinas…increased saturation intensifies and further defines any instances of color that occur within the selection, decreased removes color definition and makes the selection appear more and more grey. If you desaturate an image, of course, it becomes a greyscale image because you’ve removed all of the color but kept the tonal values. 
 
‘Lightness’ I haven’t been able to figure out. You’re on your own there. (duh.. :P ) 

Page 4: Looking

 
 
Ok, what you DIDN’T see me do was change the channel to “Red” (available in the pull-down bar beside 'Master')and make an adjustment to hue and saturation in there. You can select any color channel and any hue/sat adjustments will only affect that color. What I basically wanted to do was make it so that all the reds were more yellow, which was also present in the horse selection. (IE: instead of having a yellow and red colored image, change it to mostly just yellow…seeing as how the color we want to match is a dark uniform purple) This way, things stay more or less monochrome and it should be easier to match later. 
 
You can see above what changing the hue does, and the colors stood out wayyyy too much, so I reduced the saturation in an effort to achieve the same kind of purple-grey the ground and skeleton are. I appear to be partially successful. 
 
At this point, you stare at it. Just stare. Look at everything that doesn’t look right in the horse selection and the picture itself. Make a checklist. 
 
-cut and paste edge. (we’ll deal with that later, not important right now) 
-Too much color in some areas of the horse. Too much purple/magenta 
-Bones too light, darks not dark enough. 
 
For each of these problems there is a solution. But first, I must ask myself, is there a problem with the color itself? Have we matched the color of the ground and skeleton like we wanted to? Well, yes, we appear to have more or less matched it…and we can tweak later on if necessary. So, time to move on to a few of the other things we can fix. 
 

Page 5: Sponge

Let’s address the tiny areas in the horse section that are too saturated and look funny. Too much color…but I can’t desaturate the image any more or I’ll run the risk of turning the ground and some of the other bone sections too grey. 
 
So, a tool that is used seldom becomes quite important. The Sponge tool, located in the toolbar section with ‘burn’ and ‘dodge’. 
 
So what does sponge do? Well, it’s like the saturation bar in Hue/Sat but in a paintbrush. You set the flow of the sponge effect, much like you would set opacity for a brush, and then at the top of the page you have the option of ‘saturate’ and ‘desaturate’. Since the image has too much of a certain color, we’ll use ‘desaturate’ and very lightly brush over the areas that have too much color. 
 

 
 
There, you can see what a difference that made. We’ve still got our overall color, but the tiny annoying supersaturated parts of the horse have been toned down and now resembles the rest of the selection. 
 
Well, that problem is now crossed off of my checklist. What should I handle next? How about the dark/light problem? I could go to brightness/contrast to increase the contrast and reduce brightness, but I’ve found that using ‘Levels’ offers the same features that are available in Brightness/Contrast but with more precise control. 

Page 6: Levels

So, we open up Levels, and surprisingly enough, the image makes a lot more visual sense after 2 small changes. 
 

 
 
First we look at what everything represents. The graph is a representation of the tonal characteristics of every pixel you currently have selected. As you can see, most of the pixels that make up the horse selection are a dark grey. Still, they weren’t quite dark enough for the picture they were being put into. So, what I did was I slid the black marker at the bottom of the graph to the right. Where that marker is defines “Black”.  
 
Imagine the most unearthly dark midnight absolute black possible. That black is where the marker is, and you can put the marker wherever you want. If you slide it to the right, all of the pixels become darker, because their darkness is dependant on how close they are to ‘Black’. As soon as pixels listed on the graph are to the LEFT of the marker, they are as black as it is possible to get. Any more black and they would suck the light out of the room. 
 
So, after doing that, I also took the ‘middle grey marker’ and moved it to the right. It does exactly the same thing as the black marker, except for the fact that it represents all of the mid-tones within the image, and can very accurately define how the mid-range values look. If things are too dark overall, sliding the grey marker to the left is a good first thing to try. I slid it to the right in this case because despite the darks matching up, the entire pasted section was still just a little bit too light.  
 
Now, the only thing I left out were the parts of the horse that were too bright. Specifically, the ‘white’ on the bones are brighter than the lightest value on the skeleton. 
 
To fix this, keep levels open. We know how black works, and white works the same way. But sliding the white marker to the left won’t solve the actual problem, it’ll just make the light parts lighter. 
 
If you look below, there is a greyscale map with 2 markers on it, one black one white. The values directly above each marker become the values for black and white within the graph respectively. So since we want to make just the light parts a little darker, let’s change that marker’s location. I want to make the lightest value in that image a dull grey. 
 

 
 
Dear lord! Look at that! It’s starting to resemble what we want…in fact, if we get rid of the cut-and-paste portion of the horse that we don’t want, we’ll probably be very close. 

Page 7: Voila!

Here’s a sample of what I erased and what I left behind. It’s very important when blending to similar things together to change the opacity of your eraser (or in Arsi’s case, change the opacity of your brush when using layer masks) so that the edges of your image are semi-transparent. Semi-transparency means a slow gradual visual shift from one item to another, and you want that to happen, it hides where your cut and paste lines are. 
 

 
 
The entire time was spent looking at the skeleton, the ground, and the darn boot that the skeleton just happened to be on top of.  
 
And Voila! A hoaxed centaur skeleton. 
 

 
 
I know there are still some tiny little problems with it, but I’m still looking. And tweaking, of course. After 5 months, I think I’ve almost got it perfect…but it’s more for my own satisfaction than for any upcoming contest. 
 
But that’s the down side of being a good looker…. 
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How to write a tutorial  
 

By JaxomLOTUS  Paginated View 

This is a must-read if you plan on submitting a tutorial here.

Page 1 : Preface

Before I begin this, I'd just like to point out a few things to all submitters: 
 
- It definitely takes learning to get it right. But if you screw up you can retrieve the file and fix it. 
- No HTML is needed at all. At least not on your part. When you upload an image it will generate the HTML for you (which you should then copy into the form). 
- Split up the tutorial into as many pages as you think it needs. There will be a printer-friendly option for users who want to view it all at once and splitting it up into steps makes the learning process simpler. 
 
That being said, we're ready to begin... 

Page 2: Starting the Tutorial

Before you write a tutorial I'd recommend you go through our tutorial page to make sure something similar hasn't been done yet already. It possibly has and if so, that can be alot of work down the drain. 
 
There are two kinds of tutorials: General subject overviews and "How I made this image" tutorials. 
 
The latter is what we are looking for. While a general tutorial on how to use an image editing program is nice, it's going to be too much for this site. Think of these tutorials as brief lessons, not drwan-out volumes. 
 
If you have an image that did very well in our contests, that might be a fun one to recreate in steps. 
 
Once you have your idea, take screenshots of your progress (click the "print screen" button and then paste the image of your screen into your image editing program. Crop and save these images for use with your tutorial. Try to keep them under 50k in size as 60k and above will not upload to the tutorial uploader. 
 
Also write out your text beforehand so you can copy and paste it right into the form. This way there is no loss if your tutorial is accidentally deleted or an error occurs. 
 
Got all your images and text? Let's move on... 

Page 3: Creating the form

Before you do anything else, figure out how many pages your tutorial will be! Then select the number from the drop down menu at the top: 
 

 
 
ALL of the separate page forms will then appear on this one page as if by magic (javascript) and you can then add the page information to each one. Don't worry if you select too few or too many. Just submit your story and the system will remove extra pages. Then you can go back in and add more pages if you like. 
 
If you hit the SUBMIT CHANGES button at the bottom before completing your tutorial or adding more pages, all is not lost. You can retrieve it from the left hand side and continue editing it. 

Page 4: Filling out the form & uploading images

Fill out all of the relevant information on your form.  
 
The summary field is displayed at the top of page 1 and on the main tutorials listing page. It should be clear and brief and it should flesh out exactly what your tutorial will teach. 
 
You can give each page a title (sort of a chapter heading). You can leave it blank if you like. 
 
Don't worry about the ACCESS drop down menus. Those are really for the moderators to limit who can see what pages.  
 
To add an image to your tutorial simply click the UPLOAD IMAGE button. A popup window with an upload form will result. (You may need to turn off pop-up killers to use it). Choose Browse and find the image from your harddrive (this is a similar process to entering the contests here). You can preview the image before you upload it to make sure it is the right one. 
 
Then upload it and copy the generated HTML into the tutorial form with your writing. Close the upload window. 
 
Just a note: Although you can link-display to other images on the web, please store all used images here to prevent the tutorial from getting red x's. 
 
Whereever you paste your image HTML is where your image will appear. You can preview how your page will look by clicking the PREVIEW button. 
 
Repeat the above process until all pages in your tutorial are filled in. 

Page 5: Submission and Editing

Finally, when you are done filling in the form, click SAVE CHANGES. 
 
To make any edits to your article you can acess it via your stats page or via the listing on the left side of the tutorials page. You can edit it and add more pages until it's approved. To delete a page, simply remove all the text from inside the main text box of that page. Even if it has a title, it will be deleted if this box is empty. 
 
Please note that once it's been approved by a moderator for public display you will no longer be able to edit it without a moderator's help. 

Page 6: Managing your tutorials and articles

You can access all of your articles via your stats page. 
 
In the coming weeks when I give website hosting to all users this will be a very cool feature to have on your custom site as this article-writing form can be used for just about anything on your own site area. 
 
If you have any questions message me here. Good luck! 
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Down and Dirty Colorization  
Using Gradient Maps to achieve natural colorizations  

By steveo  Paginated View 

Gradient Maps give a broader scope of colors, making your images sharper and more life-like than the "painted" look of Fill Layers. 

Page 1 : Choosing your image

Choosing a base image is important. Don't choose an image that's too pixelated or blurred. Your image should also have a good range of contrasts in it, and a number of objects that should be different colors.  
 
Copy your image into Photoshop and change the Image Mode to RGB.  
 

 

Page 2: Your first color sample

Duplicate the base layer. This is going to be your first color. Start with the color with the most area. In this case, it would be the skin of the model.  
 
To get a good sampling of color, we need to locate an image that has similar content and darkness levels. Here I've chosen a picture of a woman in a similar dark setting.  
 

 
 
Using the eyedropper, pick up a mid-tone. That means we're looking for the tone between the brightest and darkest points. Here, it would be on the apples of her cheeks. After picking up that color with the eyedropper, open the palette and copy the hex number for that color, you'll need it later.  
 

 
 
Now we want our edge tones. Pick up a dark tone from the image (not black, you want color), then rotate your color palette and pick up a highlight color.  
 

 

Page 3: Applying your first color

Ok, now we've got our range of colors, all we need to do is apply it. Make the layer of the image you sampled from invisible, we might need it for another color later, but for now it's in the way.  
 
Go back to your duplicate layer of the black and white image. To apply the tones, we need a Gradient Map. This changes the tones of an image to match a gradient (hopefully you know what a gradient is).  
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The Gradient Map will automatically adjust the image to the colors in your palette. If the image looks like a negative, check "Reverse" to swap them.  
 

 
 
We could stop here and have a nice tone, but it's only duotone. What's going to really make our image stand out is adding that third middle tone. Click on the gradient bar and an edit window opens. At the bottom of that window is our gradient. We're going to click in the middle of that gradient to add a point, then change the color of that point to the hex of the mid-tone we captured earlier.  
 

 
 
Apply that gradient to our image and we've got a good range of tones. But they're not matched to the contrast of our original image. What we need to do now is change the mode of our colored layer to "Overlay" to paste it onto our black and white below. And viola! Our image is colored to our tones. From here, you can Adjust the Hue/Saturation of the toned layer to get a better color (you never pick up just the right colors the first time :) 
 
But wait, the whole image is toned! 

Page 4: Masking out the colored area

This is the easiest masking you will ever do. First we need to apply a mask to our colored layer. We do that by clicking the mask icon at the bottom of the layers palette.  
 

 
 
Click on the mask that appears on that layer. Your color palettes will turn to black and white, that's because masks work by levels of transparency; the white is 100% opacity, black is totally transparent, shades represent levels between. The first thing we're going to do is take the Paint Bucket and fill our mask with black.  
 
Poof! All the color is gone. To get it back, we switch to the color white, grab our paint brush, and draw in the mask window wherever we want color. It's that easy.  
 
And viola! We have color exactly where we want it and nowhere else:  
 

 
 
Doesn't look like much now, but we're getting there. 

Page 5: Applying the second color

Applying the second color is just as easy as applying the first. We're going to start by duplicating our original black and white image layer and then dragging it over our colorized layer; this lets us keep a better eye on what we're doing now.  
 
This next layer is going to be the blue in the flowers. The first thing I'm going to do is look for a picture of blue flowers to sample from (sound familiar?). 
 
After sampling the middle tone, then the highlights and dark spots, we'll apply a gradient map, then we'll change the blend mode to overlay and mask only the areas we want colored. 
 

 
 
You're probably seeing the pattern here. We're going to colorize each object in the picture and colorize it with a Gradient Map using color samples from color photographs. 

Page 6: The finishing touches

So now we've got all of our major pieces put together by colorizing everything.  
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Well, first thing I notice is that we did a really lousy job with the green in the tiara :) 
 
But, we also forgot our small points. The small points are the areas of highlight that are too small or sharp to paint over. These areas are usually the fingernails, the lips, the eyes, the teeth, and the hair.  
 
We can adjust the eyes, teeth, and fingernails by creating a new layer and blopping some white over the small points, then setting our layer to "Overlay." We might also have to adjust the opacity of the layer if the white stands out too much.  
 
The lips can be done the same way by creating a layer with some red paint. 
 

 

 
 
Hair is really a trouble area when it's black. However, there is an answer. Most photographs have a blue tone layered over them, although you rarely, if ever, notice it (and it's not as prevalent in dimly lit photographs). By creating another Gradient Map of white to light blue to purple, we can simulate this tone. It might require a trip back to our skin layer to adjust the hue, but it gives the overall image a more balanced look. Make sure to drop the opacity of your blue level to around 30% or 40%, otherwise you'll end up with a very smurfy 
model.  
 
(If the hair is not black, you can easily create a gradient map just for the hair, but I do recommend throwing a blue layer on). 

Page 7: Taking a look

So now we've got our blue tint, we've got all of our areas masked and colored, and we're ready to submit, right?  
 
Wrong.  
 
Here's where we are now: 
 

 
 
The first thing to notice is that all this colorizing has thrown our dark levels off. The image is much brighter than it was when we started. To fix that, we're going to add an Adjustment Layer for Levels. Like Masks, Adjustment Layers affect the appearance of layers, but don't change the content. That means that anything you do can be immediately undone without any loss to your original source material.  
 
By raising the dark levels, we get a much sharper and cleaner image, almost as clean as our original source:  
 

 
 
It's good, but there's still one more thing we can do to it go make it better. 

file:///C|/Worth1000/68.htm (3 van 4)13-6-2006 23:19:16



Worth1000.com | Photoshop Contests | Are you Worthy™ | tutorial

Page 8: Matching your hues

If you're sharp, you've noticed that the saturation on all of our layers is still pretty high. There's a reason for that: it's almost impossible to match saturations on different levels, especially when the sources you're sampling from don't always have the same levels of color in them.  
 
To combat this, were going to keep our saturations fairly high, but we'll add an Adjustment Layer for Hue/Saturation. There, we'll take down the saturation on our whole image. 
 
Remember that going down in saturation equalizes levels while going up only expands the difference in color grade.  
 
Let's take a look at our finished product: 
 

 
 
Not bad for a half hour :) 
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Chiseled Images & Crop Circles  
 

By steveo  Paginated View 

This is a good tutorial to teach you how to create a chiseled look rock and a general depth in objects.

Page 1 

Find a background to use. Flat surfaces that aren't facing directly toward the camera work best. A crack or two in the surface is even better. 
 

 

Page 2

Duplicate the image layer, and desaturate it. Now applay a Guasian Blur of 1 pixel. Save this as "shadow.psd"  
 

 
 

 

Page 3

Remove visibility of the grey layer and add a new layer. Draw or cut-and-paste the image you want to carve. Make it black and simple. Colors won't show up well later, and the more complex the design the harder it will be for people to tell what it is. 
 

 
 

Page 4

Use Free Transform to fit your design into the perspective of the background. 
 

 

Page 5

Set the layer visibility to "Overlay" 
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Page 6

Apply the Displacement filter to your design layer at 5% Horizontal and 5% Vertical. Select "Shadow.psd" as your displacement map. This will distort the design to the contours of the background (incidentally, this is also how I got my reflection to match the water in the UFO over Toronto picture). If your design is farther away, decrease the percentages (although less than 3% is barely noticeable). Or, if your image is up closer or you want a more "rugged" look to the edges, increase the percentages. Also, if the image is tilted horizontally more than vertically, you can raise the Horizontal percentage and lower the Vertical to get more of a 
perspective.  
 

 

 
 

 

Page 7

Raise the Brightness by 100% and lower the Contrast by 100%. The design should all but disappear into the background. (alternatively, you can raise the Luminence until the design vanishes). 
 

 

Page 8

Now hit your design with an Outer Bevel with these settings: Chisel Soft, Depth 100%, Down, Highlight Mode: Overlay (75%), Shadow Mode: Overlay (75%). Then add an Inner Shadow with "Blend Mode" set to "Multiply." The other settings, such as Opacity and Distance are variable depending on your picture. You can change them to add more depth to the carving, match the surrounding shadows, etc. Also, if your image is close-up, or you want a "hard edge" feel to it, use Chisel Hard instead of Soft. 
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Page 9

And that's it! Make sure that if you have something in the foreground, like a climber, that you move them to an additional layer so they show up. You can also use them to make the carvings more "interactive," like I have here with the guy's hand in Kokopelli's butt. 
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Merging Drew and Bouguereau  
Combining Images  

By arsidubu  Paginated View 

A start to finish guide to merging 2 images.

Page 1 : Preface

 
 
 
Before I begin, it is important to note that this is how *I* do it. It is not the only way, and probably not the best way, but it works for me. As with any graphics software, there are at least 5 different ways to arrive at the same end result. If there is something in this lesson that is different from how you may do it, that's fine, perhaps you can find some other valuable advice in this. Nothing is etched in stone. Use what you are comfortable 
with. 

Page 2: Finding images

I am going to assume that you already have an idea of what you wanna 
do. To me, there is nothing more frustrating than searching for an  
image in the hopes it will spark an idea. It doesn't work for me. 
 
So you have an idea...first stop, google images. Now it is very  
important to start with a high resolution image. To do this, go  
straight to Google Advanced Image Search and search out an image that is not copyrighted, or get the owner's permission. Remember that just because an image doesn't have the copyright symbol on it, doesn't mean that it's not copyrighted. Most famous classic art works are in the public domain. 
 
http://images.google.com/advanced_image_search?hl=en 
 
Where it says "Size" set the "Return images that are..." to VERY LARGE.  
 
Key in your search, in this case "Drew Barrymore" and go! Now, an  
important tidbit...when Googling for images, don't settle for the first  
half-decent image you find! Typically, I like to collect at least 3 and  
as many as 10 images I could possibly use for my image. Different  
angles, different lighting, etc. 
 
Here is the image I used... 
 

 
 
Next stop...Bouguereau. 
 
Ok, now we need some fine art images. 2 excellent sources... 
 
http://sunsite.dk/cgfa/index.html 
 
http://www.artrenewal.org/ 
 
 
Here is a trick...keep an image of your celebrity (your best  
candidate) open in one window while you browse thru the fine art. Look  
for matching head angles first and foremost. Color can be adjusted,  
angles are a bit tougher to adjust. Don't sweat it if the angle is in  
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the opposite direction, you can mirror the image later. Find a few fine  
art images and save them. 
 
The image I used... 
 

 

Page 3: Combining the 2 images

Open your fine art image in Photoshop. Also, open up the preferred 
face image that will match your fine art image. Using the rectangular  
marquee tool, Place a rectangle around the celebrity's face. Don't  
worry about being precise at this point, just make sure you have more  
than you need in the rectangle. 
 
Now, using the move command, drag the image over onto the fine art  
image. Just get the image close to it's final destination. 
 
Examine your layers window. You should have 2 - Background (the fine  
art image) and Layer 1 (the face)  
 
At this point, save your image in the .psd format. This will preserve  
the layer structure. It is a good habit to save your work on a regular basis. 
Machine lockup, Power failure or any other disturbance could cause  
you to lose a bunch of work. Some people like to save the image under 
different filenames each time so they can revert back to a specific period  
in the development of the final image. 

Page 4: Aligning the layers

Look at the layers window. To manipulate a layer, you must first  
hilite that layer by tagging it with your cursor. Now hilite Layer 1. 
 
At the top of the layer window is the opacity control. It should read  
100%. Hit the arrow to the right and move the slider that appears.  
Watch the image as you do this. You should begin to see the image fade  
away into the background. Choose a percentage that allows you to see  
both the face and the background together. 
 
Now we will align the images. With Layer 1 still hilited, select  
EDIT>FREE TRANSFORM. A rectangle with circles in the corners and one in  
the center will appear. You can move the layer by hitting inside the  
rectangle and dragging it into place. You can rotate the layer by  
hitting outside the rectangle, and spinning it. Notice it spins  
about the circle in the middle of the rectangle. You can move the point  
of rotation with your cursor. The next one is important... You can  
scale the layer by hitting one of the corner circles and dragging it in  
or out. NOTE: It is important to hold the shift key when you do this,  
in order to keep the image proportionally correct. 
 
Using the EDIT>FREE TRANSFORM command, align the face with the  
background. I usually use the jawline and eyes as a guide. 
 

 
 
After you have the images aligned as best as possible, slide the layer 
opacity level back to 100%. 
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Page 5: Masking

Next to the Layers feature, masking is the most wonderful feature in  
Photoshop. It separates the men from the boys, and the veterans from  
the newbies. We currently have a celebrity face aligned with a 
fine art background. But there are a lot of extra pixels that must be  
removed from the face image. Use the eraser, right? 
 
NO! 
 
Erasing is permanent. Masking is not. Suppose you are cleaning up the  
edges of the face, and you remove a little too much cheek. But you do  
not notice it right away. This happens. With erasing, it's quite  
possible that you may not be able to get that cheek back easily, but  
with masking, it's never gone, just hidden. Pixels can be hidden and  
exposed easily, at any time. 
 

 
 
Hilite Layer 1 on the layers window. Notice at the bottom of the  
window, there is a button containing a rectangle with a circle in it.  
This is the Add Layer Mask button. Hit it and watch what happens. Did  
you see it? 3 things happened... 
 
1) A white rectangle appeared to the right of the thumbnail for Layer  
1 in the Layers window. 
2) The little brush was replaced with a rectangle and circle to the  
left of the thumbnail for Layer 1 in the Layers window. 
3) The colors at the bottom of the main Tools palette changed to  
black and white. 
 

 
 
Select the brush command. With your foreground color set to black,  
begin brushing the edges of the face image. Notice how the pixels  
disappear. They are not being deleted, just hidden.  
 
Now select the eraser command. Take the eraser over the area you just  
edited. Notice how the pixels reappear. 
 
Now, switch the foreground and background colors using the little  
semicircle with the arrowheads on it.  
 

 
 
With the foreground color now set to white, use the eraser on the 
face image. Notice how the pixels disappear. Switch to the brush. Brush  
the same area. The pixels reappear.  
 
NOTE: When masking, a black brush hides pixels, a white brush  
restores pixels. A black eraser restores pixels and a white eraser  
hides them. 
 
Now, using as large a brush as possible, clean up the area around the  
face.  
 
Some tips... 
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A feathered brush makes for a softer blend. 
 
Brush opacity (not layer opacity) also helps to create a softer  
blend, and prevents the dreaded appearance of a bad "cut and paste" job. 
 
It may be easier at first to turn off the background so you can see  
all of the pixels you want to remove. Do this by hitting the little eye  
on the left side of the Background layer on the Layers window. 
 
Also...avoid brushing the pixels with one long continuous brush stroke, 
instead, use several small strokes, that way, an undo will not destroy too 
much of the brushing that still may be good. 
 
Here is how my Layer 1 looks when i am done...  
 

 

Page 6: Color Matching

This is the most difficult step for me to describe. Why? Because for  
me it's all trial and error. The trick is to know what commands are  
available, and what they do. It takes a lot of patience to get this  
step right, and some people just don't have an eye for it. Unfortunately, 
the color will make or break an image real quick. 
 
The commands I use most (located under IMAGE>ADJUST): 
 
Levels - Adjusts hilites and shadows. 
Color Balance - Adjusts the mixture of colors in a color image. 
Brightness/Contrast - Adjusts the tonal range of the image. 
Hue/Saturation - Adjusts the hue, saturation, and lightness of  
individual color components in an image. 
 
What I recommend is to try each command and get a feel for how it  
works, and what it does, and just wing it.  
 
I highly recommend saving your image before you do this, in the event  
you really mess up the color. 
 
NOTE: Make sure you are not in mask mode when you do color matching.  
To do this, hit the little thumbnail of the image in the Layers window. 
This is how you switch from mask mode. Hit the mask thumbnail to return  
to mask mode. 

Page 7: Finishing

After you have finished masking and color matching, and are happy  
with the results. Save the .psd file. DO NOT FLATTEN THE IMAGE OR MERGE  
THE LAYERS! Also, save a copy in the .jpg format. This is the format  
used to upload to the website. 
 
But before you do that, a word of advice. Walk away from the image  
for a while. Come back later and look it over. Sometimes a long session  
of photoshopping can cause you to overlook obvious mistakes. Better  
yet, have someone else review the image for you. There are plenty 
of people around here that are happy to critique an image in a  
constructive way. The chat room is full of them. 
 
Then you can upload your image and watch it rocket to the top of the standings. 
 
...unless I have an entry. 
 
 
arsidubu@worth1000.com 
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